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Important precautions

Translation policy
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Damage in transportation

All packages should be closely examined at time of delivery. If 
damage is apparent, write “Damage In Shipment” on ALL copies 
of the freight or express bill BEFORE delivery is accepted or 
“signed for” by a GE representative or hospital receiving agent. 
Whether noted or concealed, damage MUST be reported to the 
carrier immediately upon discovery, or in any event, within 14 
days after receipt, and the contents and containers held for 
inspection by the carrier. A transportation company will not pay a 
claim for damage if an inspection is not requested within this 14 
day period.

Certified electrical contractor statement - For USA Only

All electrical Installations that are preliminary to positioning of 
the equipment at the site prepared for the equipment shall be 
performed by licensed electrical contractors. Other connections 
between pieces of electrical equipment, calibrations and testing 
shall be performed by qualified GE personnel. In performing all 
electrical work on these products, GE will use its own specially 
trained field engineers. All of GE’s electrical work on these 
products will comply with the requirements of the applicable 
electrical codes.

The purchaser of GE equipment shall only utilize qualified 
personnel (i.e., GE’s field engineers, personnel of third-party 
service companies with equivalent training, or licensed 
electricians) to perform electrical servicing on the equipment.
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Omission and errors

If there are any omissions, errors or suggestions for improving 
this documentation, contact the GE Global Documentation 
Group with specific information listing the system type, manual 
title, part number, revision number, page number and 
suggestion details.

Mail the information to: 

GE Medical Systems (China) Co., Ltd. 
No.19, Changjiang Road
Wuxi National Hi-Tech Dev.Zone
214028 Jiangsu China 
TEL: +86 510 85225888; FAX: +86 510 85226688

GE employees should use TrackWise to report service 
documentation issues. 

These issues will then be in the internal problem reporting tool 
and communicated to the writer.

Service Safety Considerations

For a complete review of all safety requirements, refer to 
Chapter 1 in the Service Manual.

DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, 
ARE PRESENT IN THIS EQUIPMENT. USE EXTREME 
CAUTION WHEN HANDLING, TESTING AND ADJUSTING.

WARNING Use all Personal Protection Equipment (PPE) such as gloves, 
safety shoes, safety glasses, and kneeling pad, to reduce the 
risk of injury. 
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Legal notes

The contents of this publication may not be copied or duplicated 
in any form, in whole or in part, without prior written permission 
of GE. 

GE may revise this publication from time to time without written 
notice.

Proprietary to GE

Permission to use this Advanced Service Software and related 
documentation (herein called the material) by persons other 
than GE employees is provided only under an Advanced 
Service Package License relating specifically to this Proprietary 
Material. This is a different agreement from the one under which 
operating and basic service software is licensed. A license to 
use operating or basic service software does not extend to or 
cover this software or related documentation.

If you are a GE employee or a customer who has entered into 
such a license agreement with GE to use this proprietary 
software, you are authorized to use this Material according to 
the conditions stated in your license agreement.

However, you do not have the permission of GE to alter, 
decompose or reverse-assemble the software, and unless you 
are a GE employee, you may not copy the Material. The 
Material is protected by Copyright and Trade Secret laws; the 
violation of which can result in civil damages and criminal 
prosecution.

If you are not party to such a license agreement or a GE 
Employee, you must exit this Material now.

Trademarks

All products and their name brands are trademarks of their 
respective holders.

Copyrights

All Material Copyright © 2021-2025 by 
General Electric Company Inc. All Rights Reserved.
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Chapter 1

Introduction

This chapter describes important issues related to 
safely servicing the Ultrasound system. The service 
provider must read and understand all the information 
presented here before installing or servicing the units. 
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Overview

Contents in this chapter

• ‘Overview’ on page 1-2
• ‘Manual Overview’ on page 1-3
• ‘Important Conventions’ on page 1-7
• ‘Product Icons’ on page 1-11
• ‘Labels Locations’ on page 1-12
• ‘Safety Considerations’ on page 1-14
• ‘Dangerous Procedure Warnings’ on page 1-22
• ‘Lockout/Tagout (LOTO) Requirements’ on page 1-23
• ‘Returning Probes and Repair Parts’ on page 1-24
• ‘EMC, EMI and ESD’ on page 1-25
• ‘Customer Assistance’ on page 1-27
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Manual Overview

This manual provides installation and service information for the 
Versana BalanceTM/Versana BalanceTM Vet Ultrasound 
system. It is divided in ten chapters as shown below.

Contents in this manual

The manual is divided into ten chapters.

In the beginning of the manual, before chapter 1, you will find 
the Revision overview, the Important precautions including 
Translation policy, Damage in transportation, Certified electrical 
contractor statement, Omission & errors, Service safety 
considerations and Legal notes, and the Table of Contents 
(TOC).

An Index has been included after Chapter 10.

Table 1-1:  Contents in this manual 

Chapter 
number

Chapter title Description

1. Introduction Contains a content summary and warnings.

2. Site preparations Contains pre-setup requirements for the 
Versana BalanceTM/Versana BalanceTM Vet.

3. System Setup Contains setup procedure with procedure 
checklist for the system.

4. General Procedures 
and Functional 
Checks

Contains functional checks that must be 
performed as part of the installation, or as 
required during servicing and periodic 
maintenance.

5. Components and 
Functions (Theory)

Contains block diagrams and functional 
explanations of the electronics.

6. Service Adjustments Contains instructions on how to make any 
available adjustments to the Versana 
BalanceTM/Versana BalanceTM Vet.
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Typical users of the Proprietary Service Manual

• GEHC Service Personnel (setup, maintenance, etc.)
• GEHC Online Center Personnel
• Licensed Hospital’s Service Providers

Purpose of Operator Manual(s)
The Operator Manual(s) should be fully read and understood 

before operating the Versana BalanceTM/Versana Balan-
ceTM Vet and also kept near the unit for quick reference.

NOTE: Probe information displayed on screen does not necessarily 
reflect the probes available on your ultrasound system. Please 
refer to the probe list for available probes and features.

7. Diagnostics/
Troubleshooting

Provides procedures for running diagnostic or 
related routines for the Versana BalanceTM/
Versana BalanceTM Vet.

8. Replacement 
procedures

Provides disassembly procedures and 
reassembly procedures for all changeable FRU.

9. Renewal Parts Contains a complete list of replacement parts for 
Versana BalanceTM/Versana BalanceTM Vet.

10. Care & Maintenance Provides periodic maintenance procedures for 
Versana BalanceTM/Versana BalanceTM Vet.

N/A Index A quick way to the topic you’re looking for.

Table 1-1:  Contents in this manual  (Continued)

Chapter 
number

Chapter title Description
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Versana BalanceTM/Versana BalanceTM Vet models covered by 
this manual

NOTE: When not otherwise specified, the contents of this manual 
applies to all Versana BalanceTM/Versana BalanceTM Vet 
models.

Table 1-2:  Versana BalanceTM Model Designations

Model Name System SW

Versana BalanceTM VA R2.x.x

Versana BalanceTM VS R2.x.x

Table 1-3:  Versana BalanceTM Vet Model Designations

Model Name System SW

Versana BalanceTM Vet VA R2.x.x

Versana BalanceTM Vet VS R2.x.x
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Smart Manual Function

On each page of this Proprietary Service Manual, there is a 
smart manual icon to bring you back to Overview of Versana 
BalanceTM/Versana BalanceTM Vet. By clicking on the 
system overview list, you can be brought to the FRU list directly.

Figure 1-1. Smart Manual Icon
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Important Conventions

Conventions used in book

Important conventions, used in this document, are described 
next.

Model designations

This manual covers the Versana BalanceTM/Versana 
BalanceTM Vet Ultrasound systems listed in: 

‘Versana BalanceTM/Versana BalanceTM Vet models covered 
by this manual’ on page 1-5.

Icons

Pictures, or icons, are used wherever they will reinforce the 
printed message. The icons, labels, and conventions used on 
the product and in the service information are described in this 
chapter.
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Safety precaution messages

Various levels of safety precaution messages may be found on 
the equipment and in the service information. The different 
levels of concern are identified by a flag word that precedes the 
precautionary message. Known or potential hazards to 
personnel are labeled in one of three ways:

• DANGER
• WARNING
• CAUTION

NOTE: Notes are used to provide important information about an item 
or a procedure. 

NOTE: Be sure to read the notes; the information contained in a note 
can often save you time or effort.

DANGER
 

Danger is used to indicate the presence of a hazard that will 
cause severe personal injury or death if the instructions are 
ignored.

WARNING Warning is used to indicate the presence of a hazard that can 
cause severe personal injury and property damage if 
instructions are ignored.

CAUTION Caution is used to indicate the presence of a hazard that will or 
can cause minor personal injury and property damage if 
instructions are ignored. Equipment damage possible.
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Standard hazard icons

Important information will always be preceded by either the 
exclamation point (!) contained within a triangle, or the symbols 
for “Danger”, “Warning” or “Caution”, as seen throughout this 
chapter. In addition to text, several different graphical icons 
(symbols) may be used to make you aware of specific types of 
hazards that could possibly cause harm.

NOTE: Even if a symbol isn’t used on the product or in this manual, it 
may be included for your reference.

Table 1-4:   Standard hazard icons

ELECTRICAL

 

MECHANICAL

 

RADIATION

 

LASER

 

HEAT

 

PINCH
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Standard Icons that indicate that a special procedure is to be used

Some others icons make you aware of specific procedures that 
should be followed.

Be sure to read the notes; the information contained in a note 
can often save you time or effort.

Conventions

ATTENTION: Versana Balance Vet system used for animal 
scanning:

1. Whenever the term “Physician” appears in this manual, it 
must be replaced by the term “Veterinarian”.

2. Whenever the term “Patient” appears in this manual, it must 
be replaced by the term “Animal”.

3. Whenever the term “Versana Balance” appears in this 
manual, it must be replaced by the term “Versana Balance 
Vet”.

Table 1-5:  Standard Icons that indicates that a special procedure is to be used

Avoid Static Electricity Tag and Lock Out Wear Eye Protection

 

 

 

Hand Protection Foot Protection Wear Eye Protection 
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Product Icons

It is important to refer to the current revision of the Ultrasound 
system’s User Manual for a full list of product labels prior to 
servicing the system.
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Labels Locations

It is important to refer to the current revision of the Ultrasound 
system’s User Manual for a full list of product labels prior to 
servicing the system.

Rating Plate Location

Versana BalanceTM/Versana BalanceTM Vet labels are 
provided in English.

The labels are at the rear of the system. The label content may 
be different for different regions. Please refer to the labels on the 
system for the actual content.

 Figure 1-2. Versana BalanceTM/Versana BalanceTM Vet Label Location
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Rating Plate Location(continued)

1. Rating Plate

NOTE: If the new label is needed during the service activities, please 
click “Ask an Expert” to submit the case in the support central: 
http://supportcentral.ge.com/products/sup_products.asp?prod_ 
id=44177. It’s recommended to use Internet Explorer to open 
this link.

Table 1-6:  Label Icons

Label/Icon Purpose/Meaning Location

Every system has a unique 
marking for identification, the 
Unique Device Identification 
(UDI) Label. The UDI label 
consists of a series of 
alpha-numeric characters and 
barcode which uniquely identify 
the Versana BalanceTM/
Versana BalanceTM Vet system 
as a medical device 
manufactured by General 
Electric. Scan or enter the UDI 
information into the patient health 
record as required by 
country-specific laws.

Rating plate

Serial Number. Rating plate
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Safety Considerations

Contents in this section

• ‘Introduction’ on page 1-14
• ‘Human Safety’ on page 1-14
• ‘Mechanical safety’ on page 1-17
• ‘Electrical safety’ on page 1-20

Introduction

The following safety precautions must be observed during all 
phases of operation, service and repair of this equipment. 
Failure to comply with these precautions or with specific 
warnings elsewhere in this manual, violates safety standards of 
design, manufacture and intended use of the equipment.

Human Safety

• Operating personnel must not remove the system covers.
• Servicing should be performed by authorized personnel 

only. 

Only personnel who have participated in a Versana 
BalanceTM/Versana BalanceTM Vet Training Seminar are 
authorized to service the equipment.
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Human Safety(continued)

WARNING Because of the limited access to cabinets and equipment in the 
field, placing people in awkward positions, GE has limited the 
lifting weight for one person in the field to 16 KG (35 LBS). 
Anything over 16 KG (35 LBS) requires 2 people.

WARNING Have two people available to deliver and unpack the Versana 
BalanceTM/Versana BalanceTM Vet. 

Attempts to move the Ultrasound system considerable 
distances or on an incline by one person could result in injury 
or damage or both.

WARNING Ensure that the Ultrasound system is turned off and unplugged.

Wait for at least 20 seconds for capacitors to discharge as 
there are no test points to verify isolation. The amber light on 
the OP panel ON/OFF button will turn off.

Ultrasound system components may be energized. Always 
refer to the Ultrasound system's Proprietary Service Manual for 
LOTO warnings and cautions.
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Human Safety(continued)

WARNING Risk of electrical shock, Ultrasound system must be turned off 
and disconnected from power source. Cord must be controlled 
at all times.

Wait for at least 20 seconds for capacitors to discharge as 
there are no test points to verify isolation. The amber light on 
the OP panel on/off button will turn off.

Ultrasound System components may be energized. Always 
refer to the Ultrasound system's Proprietary Service Manual for 
LOTO warnings and cautions

WARNING Use all Personal Protection Equipment (PPE) such as gloves, 
safety shoes, safety glasses, and kneeling pad, to reduce the 
risk of injury. 

WARNING Beware of possible sharp edges on all mechanical parts. If 
sharp edges are encountered, the appropriate PPE should be 
used to reduce the risk of injury.

WARNING Wear all PPE including gloves as indicated in the chemical 
MSDS.
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Mechanical safety

WARNING While the software install procedure is designed to preserve 
data, you should save any patient data, images, system setups 
to removable media or hardcopy before doing a software 
upgrade.

WARNING Ultrasound probes are highly sensitive medical instruments 
that can easily be damaged by improper handling. Use care 
when handling and protect from damage when not in use. Do 
NOT use a damaged or defective probe. Failure to follow these 
precautions can result in serious injury and equipment 
damage.

WARNING Never use a probe that has fallen to the floor. Even if it looks 
OK, it may be damaged.

WARNING When the Ultrasound system is raised for a repair or moved 
along any incline, use extreme caution since it may become 
unstable and tip over.

CAUTION Take extra care when moving the system. 

The Versana BalanceTM/Versana BalanceTM Vet weighs 
approximately 70kg (150 lbs) or more, depending on installed 
peripherals, when ready for use. To avoid possible injury and 
equipment damage when transporting from one area of use to 
another:

• Be sure the pathway is clear.
• Limit movement to a slow careful walk.
• Use two or more persons to move the equipment on 

inclines or long distance.

CAUTION Before you move or transport the Ultrasound system, make 
sure to lock the monitor arm firmly and flip down the monitor to 
prevent damage to the Ultrasound system. 
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Mechanical safety(continued)

CAUTION To avoid injury when you move the monitor and the monitor 
arm, do not put your finger, hand, or object on the joint of the 
monitor or the monitor arm.

CAUTION Ensure that nobody touches the console arm when moving the 
operator panel.

CAUTION Do not move the Ultrasound system if the Operator Panel is in 
unlocked position.

CAUTION Do not transport Versana BalanceTM/Versana BalanceTM 
Vet in a vehicle without locking the casters (wheels) and 
securing it as described in chapter 4.

CAUTION Use protective glasses during drilling, filing smooth surfaces, 
and during all other work where eyes need protection.

CAUTION Use safety shoes when doing work where there is any chance 
of foot injury.
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Mechanical safety(continued)

NOTE: Special care should be taken when transporting the Ultrasound 
system in a vehicle:

• Before transporting, place the system in its special storage 
case.

• Lock the wheels (brake).
• Ensure that the system is firmly secured while inside the 

vehicle.
• Secure system with straps or as directed otherwise to 

prevent motion during transport.
• Prevent vibration damage by driving cautiously. Avoid 

unpaved roads, excessive speeds, and erratic stops or 
starts.

CAUTION Use protective gloves when working with sharp edges or when 
directed to wear PPE during a removal/replacement procedure.

CAUTION Be careful not to pinch any of the cables.
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Electrical safety

Safe practices

Follow these guidelines to minimize shock hazards whenever 
you are using the Ultrasound system:

• To minimize shock hazard, the equipment chassis must be 
connected to an electrical ground. 

• The Ultrasound system is equipped with a three-conductor 
AC power cable. This must be plugged into an approved 
electrical outlet with safety ground.

• The power outlet used for this equipment should not be 
shared with other types of equipment.

• Both the system power cable and the power connector must 
meet international electrical standards.

WARNING Connecting a Versana BalanceTM/Versana BalanceTM Vet 
to the wrong voltage level will most likely destroy it.

WARNING DO NOT SERVICE OR DISASSEMBLE PARTS UNDER FRU 
UNIT LEVEL AT ANY CIRCUMSTANCES.
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Probes

Follow these guidelines before connecting a probe to the 
Ultrasound system:

• Inspect the probe prior to each use for damage or 
degradation to the:
• housing
• cable strain relief
• lens
• seal
• connector pins
• locking mechanism

• Do not use a damaged or defective probe. 
• Never immerse the probe connector or adapter into any 

liquid. 
• The system has more than one type of probe port. Use the 

appropriate probe port designed for the probe you are 
connecting. 

Peripherals

Refer to the Patient Safety Environment section of the User’s 
Manual for peripheral isolation information. 

CAUTION The system will do probe check procedure during active the 
probes.
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Dangerous Procedure Warnings

Warnings, such as the example below, precede potentially 
dangerous procedures throughout this manual. Instructions 
contained in the warnings must be followed.

DANGER
 

DANGEROUS VOLTAGES, CAPABLE OF CAUSING 
DEATH, ARE PRESENT IN THIS EQUIPMENT. USE 
EXTREME CAUTION WHEN HANDLING, TESTING 
AND ADJUSTING.

WARNING If the covers are removed from an operating Versana 
BalanceTM/Versana BalanceTM Vet, some metal surfaces 
may be warm enough to pose a potential heat hazard if 
touched, even while in shutdown mode.

WARNING Explosion Warning

DO NOT operate the equipment in an explosive atmosphere. 
Operation of any electrical equipment in such an environment 
constitutes a definite safety hazard.

WARNING DO NOT substitute parts or modify equipment

Because of the danger of introducing additional hazards, ONLY 
install GE approved parts. DO NOT perform any unauthorized 
modification of the equipment. 

WARNING SHUT DOWN FORCEDLY OR PLUG IN/OUT ACDC 
INVALID MAY CAUSE THE DAMAGE OF SYSTEM 
FILES.

WARNING AFTER UNPLUG POWER CORD, WAIT FOR AT LEAST 
20 SECONDS FOR CAPACITORS TO DISCHARGE AS 
THERE ARE NO TEST POINTS TO VERIFY 
ISOLATION.
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Lockout/Tagout (LOTO)

Requirements

Follow Lockout/Tagout requirements by ensuring you are in total 
control of the AC power plug at all times during the service 
process.

To apply Lockout/Tagout (LOTO):

1. Plan and prepare for shutdown.
2. Shutdown the equipment.
3. Isolate the equipment.
4. Remove/disconnect the battery, if present.
5. Apply Lockout/Tagout Devices.
6. Control all stored and residual energy.
7. Verify isolation.

All potentially hazardous stored or residual energy is relieved.

WARNING Energy Control and Power Lockout for Versana BalanceTM/
Versana BalanceTM Vet.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   

Ultrasound System components may be energized. 
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Returning Probes and Repair Parts

Equipment being returned must be clean and free of blood and 
other infectious substances. GE policy states that body fluids 
must be properly removed from any part or equipment prior to 
shipment. GE employees, as well as customers, are responsible 
for ensuring that parts/equipment have been properly 
decontaminated prior to shipment. Under no circumstance 
should a part or equipment with visible body fluids be taken or 
shipped from a clinic or site (for example, body coils or an 
ultrasound probe). 
The purpose of the regulation is to protect employees in the 
transportation industry, as well as the people who will receive or 
open this package.

NOTE: The US Department of Transportation (DOT) has ruled that 
“items that were saturated and/or dripping with human blood 
that are now caked with dried blood; or which were used or 
intended for use in patient care” are “regulated medical waste” 
for transportation purposes and must be transported as a 
hazardous material.

NOTE: The USER/SERVICE staff should dispose of all the waste 
properly, per federal, state, and local waste disposal regulations. 
The Ultrasound system is not meant to be used for long-term 
storage of patient data or images. The user is responsible for the 
data on the system and a regular backup is highly 
recommended.
If the system is sent for repair, please ensure that any patient 
information is backed up and erased from the system before 
shipping. It is always possible during system failure and repair to 
lose patient data. GE is not responsible for the loss of this data.
If PHI (Patient Healthcare Information) data needs to be sent to 
GE employees for service purposes, GE will ascertain 
agreement from the customer. Patient information shall only be 
transferred by approved service processes, tools and devices 
restricting access, protecting or encrypting data where required, 
and providing traceability in the form of paper or electronic 
documents at each stage of the procedure while maintaining 
compliance with cross-border restrictions of patient information 
transfers. 



EMC, EMI and ESD

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 1-25
5866796-100 English Rev.12

EMC, EMI and ESD

Electromagnetic Compatibility (EMC)

Electromagnetic compatibility describes a level of performance 
of a device within its electromagnetic environment. This 
environment consists of the device itself and its surroundings 
including other equipment, power sources and persons with 
which the device must interface. Inadequate compatibility results 
when a susceptible device fails to perform as intended due 
interference from its environment or when the device produces 
unacceptable levels of emission to its environment. This 
interference is often referred to as radio–frequency or 
electromagnetic interference (RFI/EMI) and can be radiated 
through space or conducted over interconnecting power of 
signal cables. In addition to electromagnetic energy, EMC also 
includes possible effects from electrical fields, magnetic fields, 
electrostatic discharge and disturbances in the electrical power 
supply.

CE Compliance 

Versana BalanceTM/Versana BalanceTM Vet conforms to all 
applicable conducted and radiated emission limits and to 
immunity from electrostatic discharge, radiated and conducted 
RF fields, magnetic fields and power line transient requirements.

For applicable standards, refer to the Safety Chapter of the 
Ultrasound system User’s Manual. 

NOTE: For CE Compliance, it is critical that all covers, screws, 
shielding, gaskets, mesh, clamps, are in good condition, 
installed tightly without skew or stress. Proper installation 
following all comments noted in this service manual is required 
in order to achieve full EMC performance.
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Electrostatic discharge (ESD) prevention 

WARNING DO NOT touch any boards with integrated circuits prior to 
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised 
ESD connection point located on the rear of the Ultrasound 
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive 
equipment.

WARNING Risk of electrical shock, Ultrasound system must be turned off. 
Avoid all contact with electrical contacts, conductors and 
components. Always use non-conductive handles designed for 
the removal and replacement of ESD sensitive parts. All parts 
that have the potential for storing energy must be discharged or 
isolated before making contact.



Customer Assistance

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 1-27
5866796-100 English Rev.12

Customer Assistance

Contact information

If this equipment does not work as indicated in this service 
manual or in the User Manual, or if you require additional 
assistance, please contact the local distributor or appropriate 
support resource, as listed below.

Before you call, identify the following information, and acquire 
log (Alt+D) to send to the Customer Care team:

1. System ID / serial number.
2. Software version.
3. Date and time of occurrence.
4. Sequence of events leading to issue.
5. Is the issue repeatable?
6. Imaging mode, probe, preset/application.
7. Media brand, speed, capacity, type.
8. Save secondary image capture, cine loop.

NOTE: Restart the application before resuming clinical scanning. 

NOTE: The serial number can be found at the rear of the system. 
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Phone numbers for Customer Assistance

System manufacturer

Table 1-7:  Phone numbers for Customer Assistance

LOCATION PHONE NUMBER

USA
GE Healthcare - GE Medical Systems 
Ultrasound Service Engineering
9900 Innovation Drive
Wauwatosa, WI 53226

Service: On-site 1-800-437-1171

Service Parts 1-800-558-2040

Application Support 1-800-682-5327 or
1-262-524-5698

Canada Phone: 1-800-668-0732

Latin America Service
Application Support

1-800-321-7937
1-262-524-5698

OLC - EMEA
Phone: +49 (0) 211 73744789

+33 1 3083 1300

Fax: +49 (0) 211 73744685

Online Services Ultrasound Asia Phone:
• Australia
• China
• India
• Japan
• Korea
• Singapore

+(61) 1-800-647-855
+(86) 800-810-8188
+(91) 1800-425-8025
+(81) 42-648-2940
+(82) 2620 13585
+(95) 6277-3444

Table 1-8:  System manufacturer

MANUFACTURER PHONE NUMBER FAX NUMBER

GE Medical Systems (China) Co., Ltd. 
No.19 Changjiang Road
WuXi National Hi-Tech Dev.Zone
214028 Jiangsu China

+86 510 85225888 +86 510 85226688

Europe (OLC-EMEA)
GE Healthcare GmbH
Peter-Müller-Straße 24-26
40468 Düsseldorf
Germany
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Authorized Representative

Factory Sites
GE Medical Systems (China) Co., Ltd.
No. 19, Changjiang Road
Wuxi National Hi-Tech Dev.Zone
214028 Jiangsu China
TEL: +86 510 85225888; FAX: +86 510 85226688

The product from below factory site only can be available in 
India:
Wipro GE Medical Device Manufacturing Private Limited
No.4 Kadugodi Industrial Area, Sadarmangala,
Whitefield, Bangalore, Kamataka, 560067 INDIA

Table 1-9:  Authorized Representative

AUTHORIZED REPRESENTATIVE

The location of the CE marking is shown in the Safety chapter of the User Manual.

Authorized EU Representative:
GE Medical Systems SCS
283 rue de la Minière 78530 BUC, France
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Chapter 2

Site Preparations

This chapter provides the information required to plan 
and prepare for the setup of an Ultrasound system. 
Included the descriptions of the facility and electrical 
needs to be met by the purchaser of the units. 
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Overview

Contents in this chapter

• ‘Overview’ on page 2-2
• ‘General Ultrasound System Requirements’ on page 2-3
• ‘Facility Needs’ on page 2-11
• ‘Environmental Dangers’ on page 2-20
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General Ultrasound System

Requirements

Contents in this section

• ‘Ultrasound system environmental requirements’ on 
page 2-3

• ‘Electrical requirements’ on page 2-6
• ‘EMI limitations’ on page 2-8
• ‘Probes environmental requirements’ on page 2-10
• ‘Time and manpower requirements’ on page 2-10

Ultrasound system environmental requirements

If the Ultrasound system is very cold or hot 

When unpacking the Ultrasound system, allow the temperature 
of the Ultrasound system to stabilize before powering up. The 
following table describes guidelines for reaching operational 
temperatures from storage or transport temperatures.

CAUTION If the Ultrasound system is very cold or hot, do not turn on its 
power until it has had a chance to acclimate to its operating 
environment.

Table 2-1:  System Acclimation Time Chart

Degree C -4.5 -2 0.5 3 40 42.5 45 47.5 50 55 60

Degree F 23.9 28.4 32.9 37.4 104 108.5 113 117.5 122 131 140

hours 3 2 1 0 0 1 2 3 4 6 8
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Environmental specifications for Ultrasound system 

The system should be operated, stored, or transported within 
the parameters outlined below. Either its operational 
environment must be constantly maintained or the unit must be 
turned off.

Table 2-2:  System Environmental Requirements

Operational               
(Versana Balance with 

probe)

Storage               
(Versana Balance) 

Transport        
(Versana Balance) 

Temperature 3 - 40° C (without battery)

37.4 - 104° F

-5 - 50° C

23 - 122° F

-5 - 50° C

23 - 122° F

10 - 30° C (with battery) 

50 - 86° F

Humidity 30 - 85% non-condensing 10 - 90% non-condensing 10 - 90% non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

CAUTION The Versana BalanceTM/Versana BalanceTM Vet system 
and probe connector is not waterproof. Do not expose the 
device to water or any kind of liquid.
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Cooling

The cooling requirement for a console Ultrasound system with 
monitor and on board peripherals, is up to 3800 BTU/h. This 
figure does not include cooling needed for lights, people, or 
other equipment in the room. 

NOTE: Each person in the room places an additional 300 BTU/h 
demand on the cooling system.

Lighting

Bright light is needed for Ultrasound system installation, updates 
and repairs. However, operator and patient comfort may be 
optimized if the room light is subdued and indirect. Therefore a 
combination lighting system (dim/bright) is recommended. Keep 
in mind that lighting controls and dimmers can be a source of 
EMI which could degrade image quality. These controls should 
be selected to minimize possible interference.
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Electrical requirements

General requirements

NOTE: GE requires a dedicated power and ground for the proper 
operation of its Ultrasound equipment. This dedicated power 
shall originate at the last distribution panel before the Ultrasound 
system.

Sites with a mains power system with defined Neutral and Live:

The dedicated line shall consist of one phase, a neutral (not 
shared with any other circuit), and a full size ground wire from 
the distribution panel to the Ultrasound outlet.

Sites with a mains power system without a defined Neutral:

The dedicated line shall consist of one phase (two lines), not 
shared with any other circuit, and a full size ground wire from the 
distribution panel to the Ultrasound outlet.

NOTE: Please note that image artifacts can occur, if at any time within 
the facility, the ground from the main facility's incoming power 
source to the Ultrasound system is only a conduit.

Electrical requirements for the Ultrasound system

In the table below, the electrical specifications for the Ultrasound 
system includes monitor and on board peripherals.

Table 2-3:  Electrical Specifications for Versana BalanceTM/Versana BalanceTM Vet 
system

Voltage Tolerance Power Consumption Frequency

100-240 VAC ±10% Max. 350VA 50/ 60HZ
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Site circuit breaker

It is recommended that the branch circuit breaker for the 
Ultrasound system be readily accessible.

Site power outlets

A dedicated AC power outlet must be within reach of the 
Ultrasound system without extension cords. Other outlets 
adequate for the external peripherals, medical and test 
equipment needed to support this Ultrasound system must also 
be present within 1 m (3.2 ft.) of the Ultrasound system. 
Electrical installation must meet all current local, state, and 
national electrical codes.

Unit power plug

If the Ultrasound system arrives without a power plug, or with 
the wrong plug, you must contact your GE dealer or the 
installation engineer must supply what is locally required.

Power stability requirement

CAUTION POWER OUTAGE MAY OCCURE. 

The Versana BalanceTM/Versana BalanceTM Vet requires a 
dedicated single branch circuit. To avoid circuit overload and 
possible loss of critical care equipment, make sure you DO 
NOT have any other equipment operating on the same circuit.

Table 2-4:  Power stability requirement

IEC 61000-4-11
Voltage dips, short 
interruptions and 
voltage variations on 
mains supply

< 5%T (> 95% dip) for 
0.5 cycle;

< 5%T (> 95% dip) for 
0.5 cycle;

Mains power quality 
should be that of a 
typical commercial or 
hospital environment.40%T (60% dip) for 5 

cycles;
40%T (60% dip) for 5 
cycles;

70%T (30 dip) for 25 
cycles;

70%T (30 dip) for 25 
cycles;

< 5%T (>95% dip) for 5 
sec

< 5%T (>95% dip) for 5 
sec
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EMI limitations

Ultrasound systems are susceptible to Electromagnetic 
Interference (EMI) from radio frequencies, magnetic fields, and 
transients in the air or wiring. They also generate EMI. The 
Ultrasound system complies with limits as stated on the EMC 
label. However there is no guarantee that interference will not 
occur in a particular installation.

Possible EMI sources should be identified before the Ultrasound 
system is installed.

Electrical and electronic equipment may produce EMI 
unintentionally as the result of a defect. Some of these sources 
include:

• medical lasers
• scanners
• cauterizing guns
• computers
• monitors
• fans
• gel warmers
• microwave ovens
• light dimmers
• mobile phones
• in-house wireless phones (DECT phones)
• wireless computer keyboard and mouse
• air conditioning system
• High Frequency (HF) surgery equipment
• general AC/DC adapters
• portable phones

The presence of a broadcast station or broadcast van may also 
cause interference.

See: ‘EMI prevention/abatement’ on page 2-9 for EMI 
prevention tips.
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EMI prevention/abatement

Table 2-5:  EMI prevention/abatement

EMI RULE DETAILS

Be aware of Radio 
Frequency sources

• Keep the Ultrasound system at least 5 meters (15 feet) away from other EMI 
sources.

• Special shielding may be required to eliminate interference problems caused by 
high frequency, high powered radio or video broadcast signals.

Ground the 
Ultrasound system

Poor grounding is the most likely reason an Ultrasound system will have noisy 
images. Check grounding of the power cord and power outlet.

Replace all screws, 
Radio Frequency 
gaskets, covers, 
cores

• After you finish repairing or updating the Ultrasound system, replace all covers 
and tighten all screws.

• Any cable with an external connection requires a magnet wrap at each end.
• Install all covers. Loose or missing covers or Radio Frequency gaskets allow 

radio frequencies to interfere with the ultrasound signals.

Replace broken 
Radio Frequency 
gaskets

If more than 20% or a pair of the fingers on an Radio Frequency gasket are 
broken, replace the gasket. Do not turn on the Ultrasound system until any loose 
metallic part is removed.

Do not place labels 
where Radio 
Frequency gaskets 
touch metal

Where applicable, never place a label where Radio Frequency gaskets meet the 
Ultrasound system. Otherwise, the gap created will permit Radio Frequency 
leakage. Or, if a label has been found in such a position, move the label.

Use GE specified 
harnesses and 
peripherals

The interconnect cables are grounded and require ferrite beads and other 
shielding. Also, cable length, material, and routing are all important; do not change 
from what is specified.

Take care with 
cellular phones

Cellular phones may transmit a 5 V/m signal; that could cause image artifacts.

Properly route 
peripheral cables

Where applicable, do not allow cables to lie across the top of the Card Rack or 
hang out of the peripheral bays. Loop the excess length for peripheral cables 
inside the peripheral bays. Attach the monitor cables to the frame.
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Probes environmental requirements

Operation, storage and transport temperatures for probes

Probes should be operated, stored, or transported within the 
parameters outlined below.

NOTE: Refer to Table 2-1 on page 2-3 to determine the needed 
settlement time.

Time and manpower requirements

Site preparation takes time. Begin site preparation checks as 
soon as possible, if possible, six weeks before delivery, to allow 
enough time to make any changes.

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.

Table 2-6:  Probe Environmental Requirements

Operational Storage Transport

Temperature 10° - 35° C
50° - 95° F

-5° - 50° C
23° - 122° F

-5° - 50° C
23° - 122° F

Humidity 35- 75%
non-condensing

30 - 90%
non-condensing

30 - 90%
non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION Check the room temperature before you use the probe. 

CAUTION Ensure that the probe face temperature does not exceed the 
normal operation temperature range.
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Facility Needs

Contents in this section 

• ‘Purchaser responsibilities’ on page 2-12
• ‘Required facility needs’ on page 2-13
• ‘Desirable features’ on page 2-14
• ‘Minimal floor plan suggestion’ on page 2-15
• ‘Recommended floor plan suggestion’ on page 2-16
• ‘Suggested floor plan, Ultrasound system, and PC in same 

room’ on page 2-17
• ‘Networking setup requirements’ on page 2-18
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Purchaser responsibilities

The work and materials needed to prepare the site is the 
responsibility of the purchaser. Delay, confusion, and waste of 
manpower can be avoided by completing pre-installation work 
before delivery. Purchaser responsibility includes:

• Procuring the materials required
• Completing the preparations before delivery of the 

Ultrasound system
• Paying the costs for any alterations and modifications not 

specifically provided in the sales contract

NOTE: All electrical installations that are preliminary to the positioning 
of the equipment at the site prepared for the equipment must be 
performed by licensed electrical contractors. Other connections 
between pieces of electrical equipment, calibrations, and testing 
must also be performed by qualified personnel. The products 
involved (and the accompanying electrical installations) are 
highly sophisticated and special engineering competence is 
required. All electrical work on these products must comply with 
the requirements of applicable electrical codes. The purchaser 
of GE equipment must only utilize qualified personnel to perform 
electrical servicing on the equipment. 

The desire to use a non–listed or customer provided product or 
to place an approved product further from the Ultrasound 
system than the interface kit allows, presents challenges to the 
installation team. To avoid delays during installation, such 
variances should be made known to the individuals or group 
performing the installation at the earliest possible date 
(preferably prior to the purchase).

The ultrasound suite must be clean prior to delivery of the 
Ultrasound system. Carpet is not recommended because it 
collects dust and creates static. Potential sources of EMI 
(electromagnetic interference) should also be investigated 
before delivery. Dirt, static, and EMI can negatively impact 
Ultrasound system reliability.
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Required facility needs

NOTE: GE requires a dedicated power and ground for the proper 
operation of its Ultrasound equipment. This dedicated power 
shall originate at the last distribution panel before the Ultrasound 
system.

Sites with a mains power system with defined Neutral and Live:

The dedicated line shall consist of one phase, a neutral (not 
shared with any other circuit), and a full size ground wire from 
the distribution panel to the Ultrasound outlet.

Sites with a mains power system without a defined Neutral:

The dedicated line shall consist of one phase (two lines), not 
shared with any other circuit, and a full size ground wire from the 
distribution panel to the Ultrasound outlet.
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Required facility needs(continued)

NOTE: Please note that image artifacts can occur, if at any time within 
the facility, the ground from the main facility's incoming power 
source to the Ultrasound unit is only a conduit.

• Dedicated single branch power outlet of adequate 
amperage meeting all local and national codes which is 
located less than 2.5 m (8 ft.) from the unit’s proposed 
location

• Door opening is at least 76 cm (30 in) wide
• Proposed location for unit is at least 0.5m (1.5 ft.) from the 

wall for cooling
• Power outlet and place for any external peripheral are within 

2 m (6.5 ft.) of each other with peripheral within 1 m of the 
unit to connect cables.

• Power outlets for other medical equipment.
• Power outlets for test equipment within 1 m (3.2 ft.) of 

Ultrasound system.
• Clean and protected space to store probes (in their cases or 

on a rack)
• Material to safely clean probes (done with a plastic 

container, never metal)

For the amperage requirements, see: ‘Electrical requirements’ 
on page 2-6.

Desirable features

• Door is at least 92 cm (3 ft.) wide
• Circuit breaker for dedicated power outlet is easily 

accessible
• Sink with hot and cold water
• Receptacle for bio–hazardous waste, like used probe 

sheaths
• Emergency oxygen supply
• Storage for linens and equipment
• Nearby waiting room, lavatory, and dressing room
• Dual level lighting (bright and dim)
• Lockable cabinet ordered by GE for its software and 

proprietary manuals 
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Minimal floor plan suggestion
CSI 8x10

 Figure 2-1. Minimal floor plan, 2.5 m x 3 m (8 by 10 foot)

Scale: 
Each square equals one square 
foot (app. 31 x 31 cm)

1. Door – at least 762 mm (30 
inches)

2. Film Viewer
3. Counter Top, Sink with hot 

and cold water and Supplies 
Storage

4. Linen Supply
5. Probes/Supplies

6. Examination Table – 1930 x 
610 mm (76 x 24 inches)

7. Footswitch
8. Stool
9. Ultrasound system
10. External Peripherals
11. Dedicated Power Outlet - 

Circuit Breaker protected and 
easily accessible

12. Network Interface
13. 457 mm (18 inches) distance 

of Ultrasound system from 
wall or objects

14. GE Cabinet for Software and 
Manuals
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Recommended floor plan suggestion
CSI 14x17

 Figure 2-2. A 14 by 17 foot recommended floor plan

Scale: Each square equals one square foot (app. 31 x 31 cm)

1. Secretaries or Doctors Desk
2. File Cabinet
3. Film Viewer 
4. Counter Top
5. Counter Top and Sink with 

hot and cold water
6. Overhead Lights Dimmer - 

Dual Level Lighting (bright 
and dim)

7. Emergency Oxygen

8. Suction Line
9. Ultrasound system
10. Dedicated Power Outlet - 

Circuit Breaker protected and 
easily accessible

11. Network Interface
12. 457 mm (18 inches) distance 

of Ultrasound system from 
wall or objects

13. Stool

14. Footswitch
15. Storage for Linens and 

Equipment
16. Examination Table – 1930 x 

610 mm (76 x 24 inches)
17. Lavatory and Dressing Room
18. Door – at least 762 mm (30 

inches)
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Suggested floor plan, Ultrasound system, and PC in same room

 Figure 2-3. Suggested Room with EchoPAC PC workstation and Ultrasound Scanner

1. PC workstation parts
2. UPS
3. Ethernet network wall outlet

4. 3x mains power outlets
5. Hot and Cold water
6. Dedicated mains power out-

let

7. Ethernet network wall outlet
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Networking setup requirements

Stand alone Ultrasound system (without network connection)

None.

Scanner connected to hospital’s network

Supported networks:

100/1000 Mbit Ethernet/DICOM network (option)

InSite requirements

InSite requires an Ethernet connection via:

• 100/1000 Mbit Interface 

Purpose of the DICOM network function

DICOM services provide the operator with clinically useful 
features for moving images and patient information over a 
hospital network. 

Examples of DICOM services include the transfer of images to 
workstations for viewing or transferring images to remote 
printers. 

As an added benefit, transferring images in this manner frees up 
the on-board monitor and peripherals, enabling viewing to be 
done while scanning continues. 

With DICOM, images can be archived, stored, and retrieved 
faster, easier, and at a lower cost.



Facility Needs

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 2-19
5866796-100 English Rev.12

DICOM option setup requirements

To configure the Ultrasound system to work with other network 
connections, the site’s network administrator must provide 
information to complete the form “Worksheet for DICOM 
Network Information”. Ensure that there are no spaces in any 
field of the form. 

See: 

Entries must include: 

• A host name, local port number, AE Title, IP address and 
Net Mask for the Ultrasound system. 

• The IP addresses for the default gateway and other routers 
at the site for ROUTING INFORMATION.

• The host name, IP address, port and AE Title for each 
device the site wants connected to the Ultrasound system 
for DICOM APPLICATION INFORMATION. A field for the 
make (manufacturer) and the revision of the device, is also 
included. This information may be useful for error solving.

 Figure 2-4. Worksheet for DICOM Network Information
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Environmental Dangers

Patient Vicinity UL60601-1 (USA)

Commercial devices such as laser cameras, printers, VCRs and external monitors, 
usually exceed allowable leakage current limits and, when plugged into separate AC 
outlets, are in violation of patient safety standards. Suitable electrical isolation of such 
external AC outlets, or providing the device with extra protective earth, will be required 
in order to meet UL60601-1 and IEC60601-1 / IEC60601-1-1 standards for electrical 
leakage. 

2.12.20DV (UL60601-1:2003)

In area in which patients are normally cared for, the patient vicinity is the space with 
surfaces likely to be contacted by the patient or attendant who can touch the patient. 
This encloses a space within the room 1.83 m (6 ft.) beyond the perimeter of the bed 
(examination table, dental chair, treatment booth, and the like) in its intended location, 
and extending vertically 2.29 m (7.5 ft.) above the floor.

1. Patient environment
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Patient Environment IEC60601-1 and ANSI AAMI ES60601-1

 Figure 2-5. Patient environment

Sub Clause 3.79 and figure A.9 (IEC60601-1:2005 and ANSI AAMI 
ES60601-1:2005)

Such an area is an environment in which medical diagnosis, monitoring or treatment is 
carried out. It is very difficult to attach unique dimensions to the PATIENT 
ENVIROMENT.

In practice a distance of 2,5 m (8.2 ft.) above the floor on which the medical personnel 
stand and a horizontal distance of 1,5 m (4.9 ft.) have justified themselves as 
indicative of the dimensions of the Patient Environment.

The patient environment/vicinity will be depicted as a dashed line in this procedure. 
See example below.

1. Patient environment
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Chapter 3

System Setup

This chapter contains information needed to install 
Versana BalanceTM/Versana BalanceTM Vet 
system.

Included is a procedure that describes how to receive 
and unpack the equipment and how to file a damage or 
loss claim.

How to prepare the facility and unit of the actual 
installation, and how to check and test the unit, probes, 
and external peripherals for electrical safety are also 
included in this procedure.
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Overview

Contents in this chapter

• ‘Overview’ on page 3-2
• ‘Setup Reminders’ on page 3-3
• ‘Receiving and Unpacking the Equipment’ on page 3-6
• ‘Packing Materials - Recycling Information’ on page 3-17
• ‘Preparing for Setup’ on page 3-18
• ‘Completing the Setup’ on page 3-19
• ‘System Configuration’ on page 3-26
• ‘Peripherals Installation’ on page 3-29
• ‘Probe Check’ on page 3-63
• ‘Connectivity setup’ on page 3-77
• ‘Option Setup’ on page 3-109
• ‘Paperwork after setup’ on page 3-112
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Setup Reminders

Average setup time

• Unpacking the Versana BalanceTM/Versana BalanceTM 
Vet: 30 minutes

• Set up Versana BalanceTM/Versana BalanceTM Vet 
options: 30 minutes

• DICOM Network Configuration: 30 minutes or more, 
depending on the configuration

• Install Insite: 0.5 hour

The Versana BalanceTM/Versana BalanceTM Vet installation 
and functional checkout will take approximately 1 hour. 
Versana BalanceTM/Versana BalanceTM Vet consoles with 
optional equipment may take slightly longer.

Setup warnings

DANGER
 

WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE 
OF OPENING THE AC GROUND LINE (I.E., METER’S 
GROUND SWITCH IS OPEN), DON’T TOUCH THE 
ULTRASOUND SYSTEM!

CAUTION To prevent electrical shock, connect the unit to a properly 
grounded power outlet. DO NOT use a three to two prong 
adapter. This defeats safety grounding.

CAUTION DO wear the ESD wrist strap when you work on circuits.

CAUTION DO NOT operate this unit unless all board covers and frame 
panels are securely in place. System performance and cooling 
require this.
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Setup warnings(continued)

1. There are no operator serviceable components. To prevent 
shock, do not remove any covers or panels. Should 
problems or malfunctions occur, unplug the power cord. 
Only qualified service personnel should carry out servicing.

NOTE: For information regarding packing labels, refer to LABELS 
ON PACKAGE.

2. After being transported, the unit may be very cold or hot. If 
this is the case, allow the unit to acclimate before you turn it 
on. It requires one hour for each 2.5°C increment it's 
temperature is below 3°C or above 40°C.

The following table describes guidelines for reaching operational 
temperatures from storage or transport temperatures.

DANGER
 

Equipment damage possibility. Turning the system on without 
acclimation after arriving at site may cause the system to be 
damaged.

CAUTION If the Ultrasound system is very cold or hot, do not turn on its power 
until it has had a chance to acclimate to its operating environment.

Table 3-1:  System Acclimation Time Chart

Degree C 50 45 40 35 30 25 20 15 10 5 0 -5

Degree F 122 113 104 95 86 77 68 59 50 41 23 23

hours 4 2 0 0 0 0 0 0 0 2 4 6
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Setup warnings(continued)

CAUTION Operator Manual(s)

The User Manual(s) should be fully read and understood 
before operating the Versana BalanceTM/Versana 
BalanceTM Vet and kept near the Ultrasound system for quick 
reference.

CAUTION Acoustic Output Hazard 

Although the ultrasound energy transmitted from the Versana 
BalanceTM/Versana BalanceTM Vet probe is within AIUM/
NEMA standards, avoid unnecessary exposure. ultrasound 
energy can produce heat and mechanical damage.
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Receiving and Unpacking the

Equipment

Purpose of this section

This section describes how to receive and unpack Versana 
BalanceTM/Versana BalanceTM Vet.

Contents in this section

• ‘Warnings for receiving and unpacking’ on page 3-6
• ‘The Tilt indicator’ on page 3-7
• ‘Receiving the Versana BalanceTM/Versana BalanceTM 

Vet’ on page 3-8
• ‘Unpacking the Versana BalanceTM/Versana BalanceTM 

Vet’ on page 3-14

Warnings for receiving and unpacking

CAUTION Two people are needed to unpack the Ultrasound system 
because of its weight. Attempts to move the Ultrasound system 
considerable distances or on an incline by one person could 
result in injury or damage or both. 

Two people are required whenever a part weighing 16 KG      
(35 LBS) or more must be lifted.

 

CAUTION Remember to use relevant personal protecting equipment 
(PPE) during packing and unpacking. Check with your local 
EHS representative.
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The Tilt indicator

Overview

Improper handling during transportation may harm the 
equipment inside the package even if the package itself is 
undamaged.

To make it easier to detect if the handling during transportation 
has been improper, a set of Tilt indicator has been attached to 
the transportation box.

Table 3-2:  Tilt Watch

Description Illustration

Tilt Watch
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Receiving the Versana BalanceTM/Versana BalanceTM Vet

Examine all packages

Examine package closely at time of delivery, as described in the 
procedure below.

Table 3-3:  Examine all packages 

Step Task Illustrations

1. Is damage apparent?
• If YES; continue with the instructions in 

‘Damage in transportation’ on page 3-11.
• If NO; continue with the next step.

2. Is the Tilt Indicator red colored inside the 
middle of the indicator?
• If YES: The Tilt Indicator has been 

activated. Continue with the instructions in 
‘Damage in transportation’ on page 3-11  
before you continue with the next step.

• If NO: continue with the next step.

1 - Red Color

3. Continue with the instructions in ‘Unpacking 
the Versana BalanceTM/Versana BalanceTM 
Vet’ on page 3-14.
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Position of the Tilt indicator

The Tilt indicator has been attached to the transportation box as 
illustrated in the figure below.

Figure 3-1. Tilt indicator

1. Tilt Indicator
NOTE: Before cutting the straps, check Tilt Tag to make sure it has not 

been triggered. If damaged, report it to the carrier. If not, then 
cut the straps around the crate.
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If Tilt Indicator has triggered or is missing

The purpose of the tilt indicator label is to alert people handling a 
product that it is sensitive to tipping and it must remain upright at 
all times. It is basically an active "Up Arrow" that changes color if 
the package is tipped 89 degrees or more from horizontal. 
These labels can be false activated if tipped less than 89 
degrees, and shocked or vibrated at the same time. This event 
does occur, but is considered uncommon. If a package is 
received with an activated tilt indicator label, there is high 
degree of certainty it tipped 89 degrees or more from horizontal 
during shipment.

An activated tilt indicator label does not indicate if the package 
was simply “Tipped” (laid down with no impact shock) or “Tipped 
Over” (free fall, with an impact shock). Using both shock 
indicator labels and tilt indicator labels will help identify if a Tip 
Over impact shock occurred.

Table 3-4:  Tilt Indicator has triggered or is missing

Step Task

1. If the Tilt Indicator is missing:

Note on the shipping papers at the time of 
receipt that the Tilt Indicator label is missing.

If the Tilt Indicator has triggered: 

Note on the shipping papers at the time of 
receipt that the Tilt Indicator label was activated.

2. Inspect the product for possible concealed 
damage. 
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Damage in transportation

Follow this procedure if damage is apparent:

1. Write “Damage In Shipment” on ALL copies of the freight or 
express bill BEFORE delivery is accepted or “signed for “by 
a GE representative or hospital receiving agent.

2. Report the damage to the carrier.

• Whether noted or concealed, damage MUST be 
reported to the carrier immediately upon discovery, or in 
any event, within 14 days after receipt, and the contents 
and containers held for inspection by the carrier.

• A transportation company will not pay a claim for 
damage if an inspection is not requested within this 14 
day period.

Versana BalanceTM/Versana BalanceTM Vet transportation box label

The Versana BalanceTM/Versana BalanceTM Vet 
transportation box label is located at the front of the 
transportation box.

 Figure 3-2. Versana BalanceTM/Versana BalanceTM Vet transportation box label 1

 Figure 3-3. Versana BalanceTM/Versana BalanceTM Vet transportation box label 2
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Versana BalanceTM/Versana BalanceTM Vet transportation box 
label(continued)

Table 3-5:  Package Label Icons

Label/Icon Purpose/Meaning Location

Keep this way up. Package

Fragile. Package

Keep it away from rain.
Package

Humidity Limitation Package
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Temperature Limitation Package

Pressure Limitation Package

Table 3-5:  Package Label Icons

Label/Icon Purpose/Meaning Location
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Unpacking the Versana BalanceTM/Versana BalanceTM Vet

When a new system arrives, check that any components are not 
damaged and are not in short supply. If shipping damage or 
shortage occurs, contact the address shown in Chapter 1.

NOTE: Please check the Versana BalanceTM/Versana BalanceTM 
Vet console is well assembly after unpacking the system.

CAUTION Please carefully unpack the system, and do not dispose the 
package of Versana BalanceTM/Versana BalanceTM Vet, so 
that it can be reused for service.

CAUTION Do not lift the unit by the Keyboard. Equipment damage may 
result.

CAUTION The crate with the Versana BalanceTM/Versana BalanceTM 
Vet weighs approximately 50kg. Be prepared for a sudden shift 
of weight as the unit is removed from its base (pallet).

Table 3-6:  Unpacking the Versana BalanceTM/Versana BalanceTM Vet

Step Description Corresponding Graphic

1 Cut off the two packing straps around the crate.

Note: To avoid injury, hold the strap clasp with 
one hand when cutting the strap.
 

2 Remove the top cover.

3 Remove the outside shipping box.
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4 Remove the barrier bag from the unit.

Note: Remove the PE bag if the system is 
transported by air.

Note: The system may have different wrap film 
packaging status, refer to the graphics on the 
right.

5 Cut the cable ties around the four wheels.

Table 3-6:  Unpacking the Versana BalanceTM/Versana BalanceTM Vet

Step Description Corresponding Graphic
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Moving into Position

Please refer to User Manual on how to move the system.

Packing the Equipment

Please pack Versana BalanceTM/Versana BalanceTM Vet in 
the reverse order of unpacking.

6 Remove the foams beside the monitor.

7 Remove any additional packing material 
surrounding the system.

8 Unlock the wheels, and then 2 people hold the 
front handle and rear handle to move the whole 
system on the ground.

Table 3-6:  Unpacking the Versana BalanceTM/Versana BalanceTM Vet

Step Description Corresponding Graphic
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Packing Materials - Recycling

Information

The packing materials for Versana BalanceTM/Versana 
BalanceTM Vet are recyclable:

• The Transportation Box is made of spruce or similar 
material. (“PHYTOSANITARY CERTIFICATE” included in all 
shipments to The People's Republic of China.)

• Lever lockings (hinges) are made of zinc plated steel.
• The inner reinforcements are made of Ethafoam 

(Polyethylene foam).
• The plastic foil is made of LDPE (Low Density 

Polyethylene).
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Preparing for Setup

Verify customer order

Compare items received by the customer to that which is listed 
on the delivery order. Report any items that are missing, back 
ordered, or damaged.

Physical inspection

Verify that the system arrived intact (visual inspection). 

If the system has been damaged, please refer to ‘Damage in 
transportation’ on page i-16 in the beginning of this manual.

EMI protection

The Versana BalanceTM/Versana BalanceTM Vet has been 
designed to minimize the effects of Electro-Magnetic 
Interference (EMI). Many of the covers, shields, and screws are 
provided primarily to protect the system from image artifacts 
caused by this interference. For this reason, it is imperative that 
all covers and hardware are installed and secured before the 
unit is put into operation.

See ‘EMI limitations’ on page 2-8 for more information about 
EMI protection.
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Completing the Setup

Purpose of this section

This section describes how to complete the installation of 
Versana BalanceTM/Versana BalanceTM Vet.

Contents in this section

• ‘System specifications’ on page 3-20
• ‘Electrical specifications’ on page 3-21
• ‘Peripherals/Accessories Connector Panel’ on page 3-22
• ‘Connections on the I/O Rear Panel’ on page 3-25
• ‘Connecting probes’ on page 3-25
• ‘Powering the system’ on page 3-25
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System specifications

System requirements verification

• Verify that the site meets the requirements listed in 
Chapter 2. 
(See: ‘Facility Needs’ on page 2-11.)

• Verify that the specifications below don’t conflict with any 
on-site conditions.

Console Weight

• Weight: less than. 70 kg (145.5 lbs) 

Physical dimensions

Table 3-7:  Physical dimensions of Versana BalanceTM/Versana BalanceTM Vet

Height Width Depth Unit

1325 ± 30        660 ± 30 800 ± 30 mm

52.2 ± 1.2 26 ± 1.2 31.5 ± 1.2 Inches
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Electrical specifications

Verification of the system’s voltage setting

Verify that the mains voltage specified for the Versana 
BalanceTM/Versana BalanceTM Vet is available on-site.

Refer to the latest revision of the User Manual for a full list of 
product labels prior to serving the system.

Electrical specifications for Versana BalanceTM/Versana BalanceTM Vet

In the table below, the electrical specifications for Versana 
BalanceTM/Versana BalanceTM Vet includes monitor and on 
board peripherals.

WARNING Connecting a Versana BalanceTM/Versana BalanceTM Vet 
to the wrong voltage level will most likely destroy it.

Table 3-8:  Electrical specifications for Versana BalanceTM/Versana BalanceTM 
Vet

Model Name Voltage Tolerances Power consumption Frequency

Versana 
BalanceTM/
Versana 
BalanceTM Vet VA

100-240V ±10%  Max.350VA 50/60 Hz
Versana 
BalanceTM/
Versana 
BalanceTM Vet VS

Table 3-9:  Power consumption for Versana BalanceTM/Versana BalanceTM Vet

Working Scenario Power Consumption (Typical Values for reference)

normal working 130VA

Standby mode (from normal working) 110VA

normal working with battery charging 170VA
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Peripherals/Accessories Connector Panel

Versana BalanceTM/Versana BalanceTM Vet peripherals and 
accessories can be properly connected using the side connector 
panel.

 Figure 3-4. Rear Connector Panel

Electronic Interface Description Interface standards/data rate or 
bandwidth

1. Power out port DC 12V 
1.5A Out

DC 12V 1.5A Out Not Applicable

2. Diagnostic LED Diagnostic LED 1, Diagnostic 
LED 2, Diagnostic LED 3

Not Applicable

3. USB 2.0 port USB for use USB 2.0
Max 480 Mbps

4. Ethernet 1000MBase-T 
for net connectivity

Ethernet 1000MBase-T for net 
connectivity

IEEE 802.3 10 Base-T, 100 Base-TX and 
1000 Base-T

5. USB 3.0 port USB USB for use USB 3.0
Max  5.0 Gbps

6. HDMI port For video port HDMI 1.4

7. VGA VGA Video Out VGA

8. Audio Out Audio Out RCA

9. S-Video S-Video Out S-Video

10. Composite Out Composited Video Out RCA
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11. Supply Mains Switch Supply Mains Switch Not Applicable

12. AC Inlet 100-240V 100-240V Not Applicable

13. Equipotentiality terminal Ground Terminal Not Applicable
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Pin assignment for each connector

Table 3-10:  Pin Assignments of External VGA

Pin No. Signal Pin No. Signal

1 RED 9 NC

2 GREEN 10 NC

3 BLUE 11 NC

4 NC 12 NC

5 NC 13 HSY

6 GND 14 VSY

7 GND 15 NC

8 GND

Table 3-11:  Pin Assignments of USB

Pin No. Signal

1 +5 VDC

2 DATA

3 DATA

4 GND

Table 3-12:  Pin Assignment of S-Video

Pin No. Output Signal Pin No. Output Signal

1 GND 3 Y

2 GND 4 C

Table 3-13:  Pin Assignment of Composite Video Out

Pin No. Output Signal Pin No.
Output 
Signal

1 Composite Out 2 GND
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Connections on the I/O Rear Panel 

NOTE: Accessory equipment connected to the analog and digital 
interfaces must be certified according to the respective IEC 
standards (e.g. IEC60950 for data processing equipment and 
IEC60601-1 for medical equipment). Furthermore, all complete 
configurations shall comply with the valid version of the system 
standard IEC60601-1. Everybody who connects additional 
equipment to the signal input part or signal output part of 
Versana BalanceTM/Versana BalanceTM Vet, configures a 
medical system, and is therefore responsible that the Ultrasound 
system complies with the requirements of the valid version of 
IEC60601-1. If in doubt, consult the technical service 
department or your local representative for GE.

Connect Ethernet

Connect the network cable to the Ethernet connector on the I/O 
Rear Panel.

The connector is located on the rear side of Versana 
BalanceTM/Versana BalanceTM Vet.

Connect USB Flash Drive 

NOTE: USB Flash Drive approved for Versana BalanceTM/Versana 
BalanceTM Vet are verified for EMC performance according to 
EN55011 class B. The use of any other USB Flash Drive will 
compromise this verification, and may cause interference on 
Versana BalanceTM/Versana BalanceTM Vet itself, or on 
other electronic devices. 

For approved models, please refer to Chapter 9.

Insert the USB Flash Drive in one of the USB ports on the 
Versana BalanceTM/Versana BalanceTM Vet. 

Connecting probes

Please refer to User Manual on how to connect/disconnect a 
probe.

Powering the system

Please refer to User Manual on how to power the system.
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System Configuration

Purpose of this section

This section describes how to configure the Versana 
BalanceTM/Versana BalanceTM Vet.

Versana BalanceTM/Versana BalanceTM Vet configuration

For complete instructions, refer to the latest revision of the 
Versana BalanceTM/Versana BalanceTM Vet User Manual, 
Chapter 10.

Information includes Entering Location, Adjusting Date and 
Time, Selecting User interface Language, Selecting Online 
Manual Language, Selecting Unites of Measure.
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User Configurable Key installation

When the system is received, please check the software option 
installed on the system.

• Power on the system.
• Enter Utility -> Admin -> System Admin -> Option 

Information to check the option status.

 Figure 3-5. Check SW Option Status
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User Configurable Key installation(continued)

To configure the user configurable key, enter Utility-> System-> 
User Configurable Key and assign the user defined key.

 Figure 3-6. Assign User Configurable Key



Peripherals Installation

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 3-29
5866796-100 English Rev.12

Peripherals Installation

Overview

This section describes how to install and configure the 
peripherals validated for the Versana BalanceTM/Versana 
BalanceTM Vet.

About the operation check-out of peripherals, See ‘Peripheral 
checks’ on page 4-66 for more information.

Table 3-14:  Versana BalanceTM/Versana BalanceTM Vet Peripherals

Description Control Model

B/W USB Printer USB port Sony UP-D898MD Printer

USB Printer USB port Sony UP-D898DC Printer

Color USB Printer USB port Sony UP-D25MD Printer

3-Pedal Footswitch USB port Footswitch MKF 2-MED USB GP26

1-Pedal Footswitch USB port Whanam FSU-1000

USB Stick USB port USB stick H48392BB (32G)

USB HDD USB port 1TB mobile USB HD

ECG ECG Port USB ECG Module

Wireless Adaptor USB port Wireless Adaptor

Bluetooth Adaptor USB port Bluetooth Adaptor

DVD RW USB port DVDRW kit with SW
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Furnished materials

This section describes the materials with the Peripherals and 
with the system.

Retain the original carton and packing materials in case 
transport is needed in the future.

• B/W USB Printer

• Color USB Printer

• Printer Shelf

• Isolation Transformer

• USB Stick

Table 3-15:  Materials furnished with B/W Printer

Item Description Quantity Note

1 Sony UP-D898DC Printer 1

2 Sony UP-D898MD Printer 1

3 Paper Roll 1

4 USB cable 1

Table 3-16:  Materials furnished with Color USB Printer

Item Description Quantity Note

1 Sony UP-D25MD Printer 1

2 Paper Roll 1

3 AC Power Cord (local purchase) 1

4 USB cable 1

Table 3-17:  Materials furnished with the Printer Shelf

Item Description Quantity Note

1 898DC Printer Shelf 1

2 898MD Printer Shelf 1

Table 3-18:  Materials furnished with the Isolation Transformer

Item Description Quantity Note

1 AC Printer Transformer 110V 1

2 AC Printer Transformer 220V 1

Table 3-19:  Materials furnished with USB Stick

Item Description Quantity Note

1 USB Stick 1
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Furnished materials(continued)

• USB HDD

• Wireless Adaptor

• Bluetooth Adaptor

• Paper Tray

Table 3-20:  Materials furnished with the USB HDD

Item Description Quantity Note

1 USB HDD 1

2 USB Cable 1

Table 3-21:  Materials furnished with the Wireless Adaptor

Item Description Quantity Note

1 1 Wireless Adaptor 1

Table 3-22:  Materials furnished with the Bluetooth Adaptor

Item Description Quantity Note

1 1 Bluetooth Adaptor 1

Table 3-23:  Materials furnished with the Paper Tray

Item Description Quantity Note

1 Paper Tray 1
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Furnished materials(continued)

• Footswitch

• DVD RW

• Barcode Scanner

Table 3-24:  Materials furnished with the Footswitch

Item Description Quantity Note

1 1 Pedal Footswitch 1

2 3 Pedal Footswitch 1

Table 3-25:  Materials furnished with the DVD RW

Item Description Quantity Note

1 DVD RW 1

2 USB cable 1

Table 3-26:  Materials furnished with the Barcode Scanner

Item Description Quantity Note

1 Barcode Reader 1
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Peripherals Installation Instructions

Sony UP-898MD/UP-898DC Printer Installation

Tools
Common Phillips screwdrivers

Manpower
One person 20 minutes + travel.

Preparations
1. Unpack B/W Printer.
2. Ensure no physical damage.
3. Shut down the system and disconnect the power cord.

Installation Procedure
NOTE: The printer driver is customized for the Versana BalanceTM/

Versana BalanceTM Vet at the factory, you do not need to 
change the settings. 

1. Put the printer shelf on the bottom of the printer, then screw 
4 screws to fix the printer shelf.

 Figure 3-7. Install Printer to Printer Shelf
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Sony UP-898MD/UP-898DC Printer Installation(continued)

2. For UP-898MD, paste the black foam to the back cover of 
the printer, align it to the second hole in the top line. For 
UP-898DC, paste the black foam to the back cover of the 
printer, centrally align it to the black line.

Figure 3-8. Paste the foam to the 898MD printer

Figure 3-9. Paste the foam to the 898DC printer
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Sony UP-898MD/UP-898DC Printer Installation(continued)

NOTE: Shut down the system and disconnect the power cord 
before installing the printer.

3. Remove printer cover from the system.

 Figure 3-10. Remove Printer Cover

4. Remove the three ties for power cable, USB cable and DC 
power extension cable.

 Figure 3-11. Remove three ties
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Sony UP-898MD/UP-898DC Printer Installation(continued)

5. Install the Supra body printer DVD cover to the system, 
insert one side first, bend it a bit then insert another side.

 Figure 3-12. Insert DVD cover

6. For UP-898MD, connect the power cable and USB cable to 
the printer.

Figure 3-13. Connect power cable and USB cable to Printer
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Sony UP-898MD/UP-898DC Printer Installation(continued)

7. For UP-898DC, connect the DC power extension cable to 
the connector, then connect USB cable and DC power 
extension cable to the printer.

 Figure 3-14. Connect the Power cable and USB cable to Printer

8. Put the printer to the system.

Figure 3-15. Put Printer into system 
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Sony UP-898MD/UP-898DC Printer Installation(continued)

9. Press Utility, Select Connectivity -> Service, add 
Standard Print.

 Figure 3-16. Connectivity -> Service

10. Highlight Standard Print in the Service list. Select the 
printer from the Printer pull-down Properties menu. Type the 
printer name in the Name Field. This name is used on the 
Button screen. Press Save. 

 Figure 3-17. Select the Printer
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Sony UP-898MD/UP-898DC Printer Installation(continued)

11. Select Button. Select the appropriate print key (Print, 
Print3...) from the Physical Print Buttons selection. Select 
the printer from MyComputer column and press >> to move 
it to the Printflow View column. PressSave.

 Figure 3-18. Select the Printer

12. Press Utility --> System --> Peripherals. Select the 898DC 
or 898MD from the pull-down menu, then click Properties.

 Figure 3-19. Properties
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Sony UP-898MD/UP-898DC Printer Installation(continued)

13. Click Printer --> Printing Preferences at the menu of 
Properties Window.

 Figure 3-20. Properties

14. Select Paper Size. Press Apply. Press OK.

 Figure 3-21. Printing Preferences

15. Press Save, then Exit.
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Sony UP-898MD/UP-898DC Printer Installation(continued)

Set up Paper Size
Follow these steps to set up the paper size of the printer, take 
Sony UP-D898MD/D898DC as an example.

• Press Utility-->System-->Peripherals. Select the 
UP-D898MD/D898DC from the pull-down menu under 
Standard Printer Properties. Then Click Properties.

Figure 3-22. Properties

• Click Printer -> Printing Preferences... at the menu of 
Properties Window.

Figure 3-23. Properties
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Sony UP-898MD/UP-898DC Printer Installation(continued)

• Select Paper Size. Press Apply. Press OK.

Figure 3-24. Printing Preferences

• Press Save, then Exit.

Printer Brightness Adjustment
Follow these steps to adjust the printer brightness, take Sony 
UP-D898MD as an example.

1. The first setting method is to adjust by “BRIGHT” button on 
printer.

Figure 3-25. BRIGHT button on printer
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Printer Brightness Adjustment(continued)

2. The second setting method is to adjust brightness by Printer 
properties on Versana Balance user interface. Please refer 
to below steps to set.

NOTE: For some commerical printers, user might not find 
brightness adjustment option from system user interface 
setting menu. It depends on the commercial printer drive 
itself. Please find brightness adjustment option on 
commercial printer’s own physical setting menu.

• Press Utility-->System-->Peripherals. Select the 
UP-D898MD/D898DC from Standard Printer 
Properties list. Then click Properties.

 Figure 3-26. Peripherals Setting

• Click Printer -> Printing Preferences... to enter 
Printing Preferences setting.

Figure 3-27. Properties
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Printer Brightness Adjustment(continued)

3. Select Density Adjust to adjust Light to the desired value. 
Then press OK to save.

Figure 3-28. Density Adjust
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Sony UP-D25MD Printer Installation

Tools
No special tools needed.

Manpower
One person 5 min.

Preparations
1. Unpack the Sony UP-D25MD Printer.
2. Ensure no physical damage.

Installation Procedure
1. Place the device in a suitable place.
2. Connect the USB Cable on the Printer.
3. Connect the power cord with the AC output in the wall outlet, 

and then turn on the printer.
4. Connect USB cable to Versana BalanceTM/Versana 

BalanceTM Vet isolated USB port.

Figure 3-29. Color Printer connection

5. Refer to the Connectivity configure steps of ‘Sony 
UP-898MD/UP-898DC Printer Installation’ on page 3-33. 
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Footswitch Installation

Tools
No special tools needed.

Manpower
One person 2 min.

Preparations
1. Unpack the Footswitch.
2. Ensure no physical damage.

Installation Procedure
1. Connect the Footswitch to the USB port on the Versana 

BalanceTM/Versana BalanceTM Vet system.

Figure 3-30. Connect Footswitch to the system (1)

Figure 3-31. Connect Footswitch to the system (2)
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Configuring Footswitch
Footswitch supports these configurations: No Function, Freeze, 
Store, Print, Update, Next Step (Scan Coach), Previous Step 
(Scan Coach), Scan Coach Pause/Resume.

Enter Utility -> Application-> Settings to configure the 
Footswitch functions. 

Figure 3-32. Configuring Footswitch Functions



System Setup

3-48 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

USB HDD Installation

Tools
No special tools needed.

Manpower
One person 1 min.

Preparations
1. Unpack the USB HDD.
2. Ensure no physical damage.

Installation Procedure
1. Connect the USB HDD to the USB port on the Versana 

BalanceTM/Versana BalanceTM Vet system.

Figure 3-33. Connect HDD to the system
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External ECG Installation

Tools
NA

Manpower
One person 8 minutes + travel.

Preparations
1. Unpack the ECG Assy.
2. Ensure no physical damage.

Installation Procedure
1. Insert the ECG USB connector into the USB port.

Figure 3-34. Connect the USB port
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DVDRW Installation

Tools
No special tools needed.

Manpower
One person 5 min.

Preparations
1. Unpack the DVDRW.
2. Ensure no physical damage.

Installation Procedure
1. Remove the body left and right cover.

Figure 3-35. Remove the body left and right Cover
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DVDRW Installation(continued)

2. Remove printer cover from the system. 

3. Unscrew the 3 screws on each side, then remove the body 
4PP/3PP front cover assy.

 Figure 3-36. Remove Body 4PP/3PP Cover Assy
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DVDRW Installation(continued)

4. Connect the 2 USB cables to system

Figure 3-37. Connect to DVD USB

5. Pull out the USB cable.

Figure 3-38. Connect to DVD USB



Peripherals Installation

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 3-53
5866796-100 English Rev.12

DVDRW Installation(continued)

6. Connect the USB cable with DVD.

Figure 3-39. Connect to DVD USB

7. Push DVD into the system.

Figure 3-40. Push DVD into system
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DVDRW Installation(continued)

8. Install the printer cover and push the body 4PP/3PP front 
cover assy into system, and screw 3 screws on each side.

 Figure 3-41. Install Body 4PP/3PP Cover Assy
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Wireless Adapter

Tools
No special tools needed.

Manpower
One person 1 min.

Preparations
1. Unpack the wireless adapter
2. Ensure no physical damage.

Installation Procedure
1. Connect the wireless adapter to the USB port on the 

Versana BalanceTM/Versana BalanceTM Vet system.

Figure 3-42. Connect Wireless Adapter

NOTE: It’s recommand to connect the wireless adapter from the 
back of system for avoiding damage.

2. Refer to the Wireless Network configure steps of 
‘Wireless-LAN Network’ on page 7-82.
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Bluetooth Adapter

Tools
No special tools needed.

Manpower
One person 5 min.

Preparations
1. Unpack the bluetooth adaptor.
2. Ensure no physical damage.

Installation Procedure
1. Connect the Bluetooth Adapter to the USB port on the 

Versana BalanceTM/Versana BalanceTM Vet system.

Figure 3-43. Connect Bluetooth Adapter

2. Reboot the system.
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Bluetooth Adapter(continued)

3. After the power-up sequence is complete, press Utility on 
the Control Panel. Select Connectivity-> Bluetooth, click 
Add New Device.

NOTE: For Bluetooth Adapter connection, the operator must login 
as Administrator.

 Figure 3-44. Add New Device

4. Follow the Bluetooth pairing wizard to turn on Bluetooth on 
your mobile device. Scan for surrounding devices. Then 
select the device name of Versana Balance in your 
surrounding device list to pair.

Figure 3-45. Bluetooth Pairing Wizard (1)

NOTE: Versana BalanceTM/Versana BalanceTM Vet system 
does not support to pair with Apple device.
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Bluetooth Adapter(continued)

5. The Pincode is shown in the dialogue, click Accept to 
continue.

Figure 3-46. Bluetooth Pairing Wizard (2)

6. On your mobile device a dialogue box should appear asking 
for permission to connect to the Versana BalanceTM/
Versana BalanceTM Vet system. Click OK and wait for the 
process to complete.

Figure 3-47. Bluetooth Pairing Request

7. After pairing is done, the mobile device name appears in the 
Authorized Bluetooth Devices field.

Figure 3-48. Connected Successfully
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EMI Filter

EMI filter can improve power grid environment.

Tools
No special tools needed.

Manpower
One person 5 min.

Preparations
1. Unpack the EMI Filter.
2. Ensure no physical damage.

Installation Procedure
1. Take out the EMI filter from the package. The EMI filter 

option includes the EMI filter and the cable.

Figure 3-49. EMI Filter
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EMI Filter(continued)

2. Insert one side of the cable into the EMI Filter OUTPUT 
side. 

 Figure 3-50. Insert the cable into the EMI filter output side

3. Insert the Ultrasound system’s main power cord into the EMI 
filter INPUT side. 

Figure 3-51. Insert the system power cord into the EMI filter 
input side
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EMI Filter(continued)

4. Connect the EMI filter cable to the Ultrasound system, and 
plug the system power cord into wall AC power outlet. 

 Figure 3-52. Connect successfully
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Ferrite core Assy

Tools
No special tools needed.

Manpower
One person 2 min.

Preparations
Remove the S-Video cable

Installation Procedure
NOTE: The ferrite core is a standard part for China console, which is 

designed for specific use scenario. Option part number: 
H48862BA.

1. Wind up the Ferrite core assy to the S-video cable (at the 
Ultrasound system end) for 5 turns, refer to Figure 3-53 on 
page 3-62.

 Figure 3-53. Wind up the Ferrite core assy to the S-video cable
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Probe Check

Introduction

Probe Check is a probe assessment tool that evaluates each 
probe element response scanning in the air. Probes must be 
clean, any gel residue will provide incorrect data. This test is an 
assessment that is intended to be used comparatively during the 
life of the probe to evaluate possible probe deterioration over 
time.

Probe check will evaluate the probe performance and provide 
the user with an indication of potential impact to the diagnostic 
image if it is compromised due to transducer malfunction.

Supported probes

Probe Check supports for 3Sc-RS, 6S-RS, 12S-RS, 4C-RS, 
8C-RS, E8Cs-RS, E8C-RS, 12L-RS, L6-12-RS, L8-18i-RS, 
LK760-RS and RAB2-6-RS probes.

CAUTION Probe Check can detect most probe defects, but not all 
possible probe defects.

CAUTION GE is NOT responsible for the confirmation related to the 
normal function of the ultrasound probe before use.



System Setup

3-64 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Pass/Fail criteria

NOTE: If any one of the two Pass or Fail criteria listed below are met, 
the result is a failure:

1. the total number of defect elements is larger than or equal to 
"Maximum number of total defect elements";

2. the number of defect elements within the largest nearby 
group is larger than or equal to "Defects of nearby 
elements".

NOTE: If two groups of nearby defect elements are separated by a gap 
smaller than or equal to "Gap between defect nearby elements", 
these two groups are considered as one nearby group.

Table 3-27:  Pass/Fail criteria

Probe Name

Maximum number 
of total defect 

elements
Defects of nearby 

elements
Gap between defect 

nearby elements

3Sc-RS 13 9 0

6S-RS 13 9 0

12S-RS 13 9 0

4C-RS 17 9 1

8C-RS 17 7 1

E8CS-RS 17 7 1

E8C-RS 17 7 1

12L-RS 17 7 3

L6-12-RS 17 9 1

L8-18i-RS 13 7 1

LK760-RS 17 9 1

RAB2-6-RS 17 9 3
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Presets

Probe Check provides five interval options for auto triggering, 
press Utility -> System -> General -> Probe Check to select 
the preset.

• Never: probe checking will never automatically open.
• Every time: probe checking will be automatically opened 

each time while triggering probe active.
• Once 1 day: probe checking will be automatically opened  

one time every day while triggering probe active.
• Once 7 days: probe checking will be automatically opened 

one time every week while triggering probe active.
• Once 30 days: probe checking will be automatically opened 

one time every month while triggering probe active.

NOTE: The system default is every time for USA region, for other 
regions, the system default is Never. The first boot up shall 
follow this setting.

 Figure 3-54. Probe Check preset



System Setup

3-66 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Probe Test

Auto Trigger

NOTE: Always remember to clean the probe surface before probe 
check procedure.

1. Check that the probe to be tested is thoroughly clean and 
dry. Connect it to the probe port on the scanner, then hold 
the probe in the air ready for testing.

NOTE: The auto trigger assessment is only available when the Probe 
Check preset is Every Time.

NOTE: The auto trigger assessment is only available for the probe 
connected to the activated probe port.

NOTE: Prior to inserting the probe, ensure that the connector locking 
handle is positioned to the unlock state.

NOTE: Ensure the probe is locked to the system before you start the 
probe diagnostics.

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage.

CAUTION DO NOT unplug the probe during Probe Check process, 
otherwise the test result will fail.
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Auto Trigger(continued)

2. Press Probe, select the probe, the system will perform 
probe test automatically, a message will pop-up on the 
monitor “Probe Check:Testing probe, please wait...”.

Figure 3-55. Probe Check:Testing probe, please wait...

3. If the probe test is Passed, there will be a message “Probe 
Check: Probe test passed.” showing on the monitor.

Figure 3-56. Probe Test passed
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Auto Trigger(continued)

4. If the probe test is Failed, the checking results will be shown 
on the pop-up dialog.

Figure 3-57. Probe Test Fail

5. Click Retest Probe on the dialog to retest the probe or click 
OK to close the dialog.
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Auto Trigger(continued)

6. For the failed test result, user should contact the Field 
Engineer(Hereinafter referred to as FE ) immediately to 
evaluate the test result. FE will collect the below failure 
information:
• Console Name

• Console Serial Number

• Current SW revision

• Probe name

• Probe port number the probe connected

• The trigger mode of the diagnostic (Auto Trigger / 
Manual Trigger)

• Trigger interval for auto trigger (only for the auto trigger 
log)

• Start and end timestamp of the diagnostic activity

• User activity during probe check

• Pass/Fail result
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Auto Trigger(continued)

7. With the remote control of the machine plus an authority of 
Class M or SSA dongle, FE can obtain the information more 
conveniently by exporting the test logfile.
Press ALT+D to export the test report and store to the 
specific destination, there are 2 methods for exporting the 
report:

Figure 3-58. Export reports

Complete Log: export all the files from D:\Log folder in the 
form of a compressed package.

Figure 3-59. Complete Log
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Auto Trigger(continued)

Service Log: export files only in D:\Log\Service folder in the 
form of a compressed package.

Figure 3-60. Service Log

The file logfile-ProbeWatch and logfile-VITA record all the 
necesssary probe test information.

Figure 3-61. Logfile Information
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Auto Trigger(continued)

8. After all information is collected, FE will remotely instruct the 
user to cross check the probe and probe port to detect if the 
issue is related to the probe or the system itself.

NOTE: Suggest to prepare at least 2 probes to conduct the cross 
check.

a. Freeze active probe or select another probe and 
disconnect the failed probe from the port, if the test 
result passed, it shows the original probe has an issue. 
If the test result failed, please continue with next step.

b. Test the two probes on other probe ports separately, if 
both test results failed, it indicates the possible issue is 
related to the probe port or MST board. If only one 
probe tested failed, it indicates the issue may be related 
to the probe.

c. For the failed test probe, suggest to replace with new 
one, if the new probe test fails, suggest to replace the 
probe port or MST board.
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Manual Trigger

A manual probe check should be conducted when images 
acquired with a deficient probe look abnormal. Phenomenon 
includes but not limited to overall decreased brightness or/and 
partial signal loss.

Figure 3-62. Normal image acquired with a 12L-RS probe

Examples (phantom scanning) are provided below for your 
reference. Whenever you see similar cases or aren't confident in 
the status of a probe, please conduct probe check manually.

• Condition 1: Total number of element failures exceeded.

Figure 3-63. Abnormal image acquired with a deficient 12L-RS 
probe that has distributed defect elements
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Manual Trigger(continued)

Condition 2: Number of adjacent element failures exceeded.

Figure 3-64. Abnormal image acquired with a deficient 12L-RS 
probe that has adjacent defect elements
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Manual Trigger(continued)

1. Press Probe, select the probe to be tested, click Test Probe 
button.

Figure 3-65. Manual Probe Test on Touch Panel

Figure 3-66. Manual Probe Test on Non-Touch Panel

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage.

CAUTION DO NOT unplug the probe during Probe Check process, 
otherwise the test result will fail.
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Manual Trigger(continued)

2. Click Test Probe button on the pop-up window. The testing 
workflow for Manual Trigger is same as Auto Trigger from 
step 2 to step 5, refer to ‘Auto Trigger’ on page 3-66 for 
information.

Figure 3-67. Manual Probe Test
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Connectivity setup

EZ configuration Wizard

EZ Configuration wizard is a function to enable the operator to 
configure some common system settings when turning on the 
system for the first time after the software installation.

NOTE: Password setting is required when turning on the system for the 
first time after the software installation.

For Versana BalanceTM/Versana BalanceTM Vet, you can 
also enter EZ Configuration Wizard by clicking the Insite icon at 
the top right of the screen.

Figure 3-68. Enter EZ Configuration Wizard
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EZ configuration Wizard(continued)

1. Select password level in Password Policies. User can 
change the policy level later by Utility -> Admin -> User 
policies.

NOTE: Password policy level setting is only required when turning 
on the system for the first time or after the software 
installation.

 Figure 3-69. Select password policy level
NOTE: When user select lowest, a warning will display to inform 

that the current security policy will put your system at risk.

 Figure 3-70. Lowest policy level warning
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EZ configuration Wizard(continued)

Users can select the option Lowest, Medium, High or 
Highest for policy level. The complexity of the password will 
be differed by the policy level you selected:

NOTE: If user select lowest level in password policies, ADM 
password can be empty during Admin Registration

NOTE: Exit button is not activated in password policies setting, 
users are not able to exit the EZ Configuration Wizard in this 
step.

Table 3-28:  Password Policy Level and Complexity

Policy Level Complexity

Lowest Auto Logon: Enabled
Minimum Password Requirements:
- No password complexity rules

Medium Auto Logon: Disabled
Minimum Password Requirements:
- 8 character(s)
- Include at least 3 of the following: upper, lower, number or special character
- 1 lower case character(s)
- 1 upper case character(s)
- 0 special character(s)
- 1 number(s)
- Cannot contain username
- Cannot use the last 10 passwords

High Auto Logon: Disabled
Minimum Password Requirements:
- 10 character(s)
- Include at least 4 of the following: upper, lower, number or special character
- 1 lower case character(s)
- 1 upper case character(s)
- 1 special character(s)
- 1 number(s)
- Cannot contain username
- Cannot use the last 15 passwords

Highest Auto Logon: Disabled
Minimum Password Requirements:
- 14 character(s)
- Include at least 4 of the following: upper, lower, number or special character
- 1 lower case character(s)
- 1 upper case character(s)
- 1 special character(s)
- 1 number(s)
- Cannot contain username
- Cannot use the last 25 passwords
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EZ configuration Wizard(continued)

2. Set ADM password in Admin Registration.
If users didn’t set ADM password during system setup. User 
can also set operator password later by Utility -> Admin -> 
Users. Refer to User Manual for details.

NOTE: Admin Registration is only required when turning on the 
system for the first time or after the software installation.

NOTE: Exit button is not activated in Admin Registration setting, 
users are not able to exit the EZ Configuration Wizard in this 
step.

NOTE: ADM password can be empty if password policy level is 
selected as LOWEST.

NOTE: A valid password must be at least 8 characters long and has 
a maximum length of 256 characters.

Figure 3-71. ADM password setting

If users didn’t set ADM password during system setup. User 
can also set operator password later by Utility -> Admin -> 
Users. For instructions, please see “Users” in the User 
Manual.
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EZ configuration Wizard(continued)

3. Select Encryption OFF / Encryption ON 
(Recommended).

Figure 3-72. Disk Encryption

• If user select Encryption OFF, a warning message will 
display, press OK to continue.

Figure 3-73. Encryption OFF
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EZ configuration Wizard(continued)

• If user select Encryption ON (Recommended), Disk 
Encryption window displays. During the encryption 
progress, press Save Recovery Keys to store the 
Recovery Key carefully and safely.

NOTE: Only when Save Recovery Keys button is available, user 
can press it to store.

Figure 3-74. Save Recovery Keys

An information window of recovery keys been saved 
successfully will display, press OK and Close to continue.

Figure 3-75. Saved successfully

User can also encrypt or decrypt system by Utility -> 
Admin -> System Admin -> Disk Encryption. See ‘Disk 
Encryption’ on page 4-37 for more information.
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EZ configuration Wizard(continued)

4. Select the appropriate language for system language and 
keyboard language from the drop-down list.

Figure 3-76. System Language settings (1)

NOTE: All required setting after turning on system for the first time 
is done. If you select Exit, you will be able to exit the EZ 
Configuration Wizard and start using your system.

• If you do not change the language, press Next to 
continue.

• If you change the language setting, a language setup 
window will display. 
Set language and keyboard language, then press OK to 
restart the system. 

Figure 3-77. System Language settings (2)

NOTE: If you press Previous, you will go to the previous page.
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EZ configuration Wizard(continued)

5. This screen shows the hospital and time information, and 
you can set the system date and time here.

Figure 3-78. General Information

6. Press Next to continue.
7. The Network Information screen shows the configuration 

of wireless and local network:

Figure 3-79. Wireless Network Information
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EZ configuration Wizard(continued)

Figure 3-80. Local Network Information

8. Press Next to continue.

Table 3-29:  Network settings

Preset Parameter Description

Enable DHCP Select to set TCP/IP.
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EZ configuration Wizard(continued)

9. The Insite - Remote Assistant screen shows the 
configuration of Agent and Proxy.

 Figure 3-81. Insite - Remote Assistant

Table 3-30:  Agent and Proxy Configuration

Element DESCRIPTION

CRM No Customer Relationship Management (CRM) number. System identifier assigned to the 
customer unit by the service region. CRM is pre-populated by adding Versana Balance to 
the CRM number. The CRM number of the Versana Balance is editable.

Serial No Serial number of the agent (read-only). If the agent is not registered with a serial number, 
this field is populated with the serial number of the Versana Balance. The serial number of 
the agent is tied to the serial number of the Versana Balance.

Proxy Server When Enable Proxy is selected, name of the proxy server IP.

Proxy Port When Enable Proxy is selected, number of the proxy server port.

Username When Proxy is selected, name of the user.

Password When Proxy is selected, password for the user.
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EZ configuration Wizard(continued)

After Insite - Remote Assistant has been successfully 
configured, these elements will have the corresponding 
values:
• Agent Registered will be Yes
• Agent Quarantine will be No
• Agent CRM Verified will be Yes

The information on System Information is available to all 
service class licenses.
To access System Information, navigate to Utility -> 
Service -> Home.

Figure 3-82. System Information

10. After having set the Insite - Remote Assistant, press Next to 
continue.
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EZ configuration Wizard(continued)

11. This screen shows the report of the previous settings. You 
can export it to the database.

Figure 3-83. Summary Information

Press Export and select the location where you want to 
store the report.

Figure 3-84. Export Summary
12. Press Finish to exit EZ Configuration Wizard. The system 

will display a warning to restart to activate your configuration 
after you configure EZ Configuration Wizard for the first time 
turning on the system or software. Press OK to restart.
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TCP/IP Screen

1. Press Utility on the control panel and login as admin, refer 
to ‘Logging on to Versana BalanceTM/Versana BalanceTM 
Vet as “ADM”’ on page 4-12.

2. Select Connectivity on the screen.
3. Select TCP/IP tab, the screen gives an overview of the 

network settings for Versana BalanceTM/Versana 
BalanceTM Vet.

 Figure 3-85. TCP/IP Screen

4. By clicking MACAddressQRCode, there will be a QR code 
poping out on the screen. You can get MAC address here.

 Figure 3-86. MAC Address QR Code
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TCP/IP Screen(continued)

MAC Address can also be found in OAC system as showing 
in Figure 3-87. 

 Figure 3-87. MAC Address in OAC system
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Changing the AE title and/or Port Number

1. To change AE Title and/or Port No, edit the respective 
fields.

Figure 3-88. AE Title/Port No

2. Select Save to store your changes. This will bring up a new 
warning screen.

Figure 3-89. Warning Message

3. Select OK to save your changes or Cancel to return without 
saving any changes.

4. Reboot the system to activate the settings or continue with 
other TCPIP setup tasks.
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Network setup

For network connection setup, refer to ‘Network Configuration’ 
on page 7-80.

Setup connection to a DICOM server

Versana BalanceTM/Versana BalanceTM Vet is configured to 
work with DICOM servers in a network environment. Images are 
first saved on the local image butter on the system. At the end of 
the examination the images are sent to the DICOM server via a 
DICOM spooler and to the local database, depending on 
dataflows.

To connect to the DICOM server, the following information has to 
be entered in the system.

• The DICOM server IP address
• The DICOM server port number
• The DICOM server AE title (the server application's name)

Table 3-31:  Utility ->Connectivity ->TCP/IP screen

1 Enter the Versana BalanceTM/Versana BalanceTM Vet computer name. This may be the 
same as the station name.

2 Enter the Versana BalanceTM/Versana BalanceTM Vet IP address, subnet mask, default 
gateway and network speed. For automatic assignment of IP address, subnet mask and 
default gateway, select DHCP.
Note: If possible, set the Versana BalanceTM/Versana BalanceTM Vet network Speed to 
match that of the Network switch. if in doubt, set it to AutoDetect. Otherwise, transfer 
times can be two or five times longer, during which the Versana BalanceTM/Versana Bal-
anceTM Vet will appear to be locked up. (If the Hard Drive activity light on the front of the 
console is lit steady or blinks quickly, the Versana BalanceTM/Versana BalanceTM Vet is 
most likely not hung.)
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Setup connection to a DICOM server(continued)

Table 3-32:  Utility ->Connectivity ->Device screen

1 Select MyComputer.

2 Assign an AE title to the Versana BalanceTM/Versana BalanceTM Vet. (AE stands 
for Application Entity. DICOM services use this to identify the Versana BalanceTM/
Versana BalanceTM Vet.) AE title is case-sensitive. This title may contain the 
Computer Name from the TCP/IP page, if desired.
 
Note: It is NOT recommended to use the factory default. This is not prohibited, but 
more than one system with the same AE title can cause confusion.

3 Edit Port Number if needed. 104 is typical. Save your changes and reboot the 
system.
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How to get the Versana BalanceTM/Versana BalanceTM Vet to 
recognize another Device on the Network

Table 3-33:  Utility ->Connectivity ->Device screen

1 Select Add. The system creates a device called “NewDevice”.

2 Change the name to one of your choosing.

3 Enter the IP address of the device.

4

Save your changes and then press Ping. A “Smiley Face” indicates successful 
communication between your Versana BalanceTM/Versana BalanceTM Vet and the 
device. A “Frown” indicates failed communication. Check the following:
• Is the device running?
• Is it connected to the network?
• Did you enter the right IP address?
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How to Setup and Use a DICOM Image Storage Service

An Image Storage Service provides a place to store patient and 
exam data from Versana BalanceTM/Versana BalanceTM Vet 
and corresponding images. The Image Storage Service, or the 
device that hosts it, is often called a Patient Archiving and 
Communication System (PACS).

Table 3-34:  Setup an Image Storage Service

1 In Utility -> Connectivity -> Service, from the Destination Device drop-down menu, 
select the device on which the service resides. (This assumes you have already setup 
the device in the Device tab in  ‘How to Setup and Use a DICOM Image Storage 
Service’ on page 3-95 .

2 From the Select Service Type to add drop-down menu, select DICOM Image Storage 
and press Add.

3 Change the name of the service to one of your choosing.

4 Enter the AE Title and port Number of the service. AE Title is case-sensitive.

4 Save your changes and then press Verify. A “Smiley Face” indicates successful 
communication with the service.
Note: If you get a successful Ping (Smiley Face) at the device level but not at the service level, it 
is possible that the AE Title or Port Number of the service settings are incorrect. Ensure that 
these are correct then re-verify. Be sure that the service type (Store, Print, etc) is correct and 
supported by the device.
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Dataflow

A dataflow is a set of pre-configured services. When you select 
a dataflow, the ultrasound system automatically works according 
to the services associated with the dataflow. The Dataflow tab 
allows you to select and review information about dataflows. You 
can also create, change, and remove dataflows.

Set up dataflows for the services. 

NOTE: You must be logged on as Administrator to use the Dataflow tab.

CAUTION DO NOT rename the factory default dataflow. 

Table 3-35:  Setup an Image Storage Service

1 Select the dataflow from the list.

2 Select to store data directly to archive (no buffer storage).

3 Select so that this dataflow does not appear as a Dataflow on the Patient menu. 

4 Select to use this dataflow as the default dataflow when you start the system.
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Button

You can assign print buttons via the Utility --> Connectivity --> 
Button page. 

Assigning print buttons. First select the print button to configure 
on the upper, left corner of the page. Then select the device you 
want to add in the middle part of the page, under Available Input/
Outputs. Then click on the right arrow in the top right corner of 
the page. 

NOTE: You can configure each print key to multiple output devices/
dataflows. 

NOTE: Only attach one DICOM service per print key (e.g., PACS and 
DICOM printer). Multiple DICOM devices should be configured 
via a dataflow.

NOTE: When using a print key to send an image directly to a DICOM 
device, this causes a single DICOM association per image. Most 
devices (all known printers) work fine with this. However, some 
storage devices, such as ALI, Kodak Access, and Cemax, 
assume that the end of each association is the end of the exam 
and can result in a new folder for each image. In the Utility 
menu, select a single association or open PR for the desired 
DICOM storage device. 

 Figure 3-90. Botton Preset Menu
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Button(continued)

Table 3-36:  Physical Print Buttons

Preset Parameter Description

M&A only (no images) Configures the system to send a DICOM structured report only; no image 
isgenerated or sent. 

Table 3-37:  Still Images

Preset Parameter Description

Format RawDICOM, DICOM, or M&A. 

Compression Always set to None. 

Table 3-38:  Cllips/Volumes

Preset Parameter Description

Cllips: Add Multiframe Data Checkbox

Compression None, Rle, Jpeg, Jpeg2000

Quality Lossless, 99, 98, 97, ... 50
Note: The default Compression for Clips is JPEG85. It is strongly 
recommended to keep the Compression set to JPEG85.

Table 3-39:  Active Images Page

Preset Parameter Description

Standard Print Lets you send to a Windows-based printer. 
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Removable Media

The Removable Media tab allows you to:

• Verify the DICOM directory on removable media.
• Verify the free space of the media.
• Verify that the media is finalized or unfinalized.
• Verify that the media is formatted or unformatted.
• Format removable media (rewritable CD/DVD or USB 

device).

 Figure 3-91. Removable Media Preset Menu

The bottom of the screen lists properties of the selected media.

Table 3-40:  Tools

Preset Parameter Description

Removable Media Select the removable media to format or verify.

Label Type a label for a new removable media (free text).

Verify • Select to verify DICOM directory on removable DICOM disk.
• Verify the free space of the media.
• Verify that the media is finalized or unfinalized.
• Verify that the media is formatted or unformatted.

Format Select to format removable media.

Quick Format To format the media quickly, check this box. If you uncheck this box, the 
media is formatted with a full format. New media should always be formatted 
with a full format. 
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Removable Media(continued)

Formatting removable media

1. Select the removable media from the Media list.
2. Type a name for the removable media in the Label field.

NOTE: Do not use the following characters for labelling:

\ / : ; . , * < > | + = [ ]
3. Select Format. Confirm OK or Cancel. 
4. An information window confirms when the format has been 

completed. Select OK to exit. 

Verifying removable media

1. Select the removable media from the Media list.
2. Select Verify.
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Miscellaneous

The Miscellaneous tab allows you to configure tools related to 
patient management and print and store options. You can 
specify default system functionality, such as whether patient ID 
is required when you archive data, or if you want the system to 
automatically search the archive for a patient when you enter 
patient data.

 Figure 3-92. Miscellaneous Preset Menu

Table 3-41:  Patient/Exam Menu Options

Preset Parameter Description

Use birthdate In the Patient information window, enter either the patient age or the 
birthdate:When selected, enter birth date, then the age is 
calculated.Whencleared, enter age (birth date field not available).

Auto search for patient In the Search/Create Patient window: When selected, the system 
automatically searches through the selected patient archive, while the user 
enters patient information.When cleared, the automatic search tool is turned 
off. If you are trying to keep the past patient data confidential, DO NOT use 
this feature. 

Automatic generation 
ofpatient ID

In the Search/Create Patient window: When selected, the Patient ID is 
notrequired when entering a new patient in the archive. The 
systemautomatically generates an ID number. When cleared, the Patient ID 
isrequired when entering a new patient in the archive.

Auto Archiving patient data Archives patient data automatically. 
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After [End Current Patient], 
go to

Select go to Worklist screen or Patient screen when ending the current 
patient. 

Keep Search String Search string is kept rather than cleared. 

Worklist Auto Query Automatically queries the worklist server. 

Show BBT Show BBT field on the OB patient screen to input the basal body 
temperature.

Double click on patient list 
to start 

Select Review or New Exam to display each time you double click on the 
patient name in the patient list on the Patient menu.

Detail Mode Select to display Detail Mode, rather than Exam View, when you select the 
patient name in the patient list on the Patient menu. You can also type 
comments while in Detail Mode.

Export to USB HDD: 
Create DICOMDIR

Create DICOMDIR is a DICOM file format which contains how the directory 
and DICOM files structured for diagnostic portable media behave. It is 
important for portability between the Versana BalanceTM/Versana 
BalanceTM Vet to PACS. If you want to save exams to the USB Hard drive 
and look at it on the PACS, the DICOMDIR is a must.

Export to Network storage: 
Create DICOMDIR

Automatic Disable Patient 
Data

Select to automatically disable patient data. 
If selected, locks the patient name, date of birth and gender (like Patient ID). 
The Factory Default for this preset is unchecked.

Remember Cursor Position 
on the Transfer Screen

To set a default cursor location on the Data Transfer screen: 
1. Select the “Remember cursor position in the Transfer screen” preset and 

press Save. 
2. On the Data Transfer screen, move the cursor to the desired field. 
3. Exit out of the Data Transfer screen. When returning to the Data Transfer 

screen, the cursor location is in the position your selected. 

Quick New Patient Entry Select to store new patient automatically by pressing the Patient key.

Table 3-42:  Patient/Exam Message Options

Preset Parameter Description

Patient info exist in logfile Check box to select.

Request acknowledge of 
End Exam action

When selected, the user is asked to confirm action when ending an 
examination.

Warn Image Store without 
Patient

Select to receive a warning when you press the Print key without an active 
patient.

Warn Register to No 
Archive

Select to receive a warning when you register a patient to the “No Archive” 
data flow. Select a different data flow for permanent storage of patient data.

Warn image store to Read 
Only dataflow

The system posts a warning message if you attempt to store images to a 
read-only Dataflow. 

Table 3-41:  Patient/Exam Menu Options (Continued)

Preset Parameter Description
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Warn video titles exist in 
the internal storage

The system posts a warning if the video titles exist on the internal DVR flash 
memory. 

Table 3-43:  Columns in examination listing:

Preset Parameter Description

<< & >> Select Date, Category, Exam Description, Img.size, M&A or Disk, then press 
<< or >> to adjust the columns in exam list.

Table 3-44:  Print and Store Options

Preset Parameter Description

P[1-3] Key Sound Select None, Click, Chimes, Ding, Ding-Dong, or Whoosh. 

Store Dual as Dicom Only Select to always store dual images as a DICOM (secondary capture) store, 
rather than Raw DICOM. 

Dual When Color Support 
is Mixed

Dataflow Mixed is not available. While transferring dual images to the PACS, 
send black and white images as gray; send color images as color. Set up 2 
services (one gray and one color), set up 2 dataflows, and set up 2 buttons. 
Each button needs to be tied to a different service.
Select if you want to keep the user preset for Color Photometric Interpretation 
while in Dual mode.

Store Multiframe for Sec 
Capture Loops

Select if you want the CINE loop stored as secondary capture.

Enable Whizz Capture 
Area

Check box to select. 

Store 2D Loop with 
Timeline Data

Check box to select. 

Patient List Print-Font Size Select font size. 

Image Order Scheme Select to Direct Store images in Acquisition Order, Scan Coach/Assistant 
Order, or Off.
• Off. The clipboard on the Ultrasound system shows the image in the order it 

was acquired. Therefore, re-stored images appear where you’d expect. 
However, on the PACS system, images appear in arrival order or in image 
number order. 

• Acquisition Order. From the Ultrasound system perspective, the same as 
“Off.” But on the PACS system (if based on image number order), images 
are displayed consistently with the way they are stored on the Ultrasound 
system. 

• Scan Coach/Assistant Order. You can define the storage order (reading 
order) via Scan Coach/Assistant Creator. Therefore, based on the order 
defined in Scan Coach/Assistant, images are re-ordered and displayed in 
this manner both on the Clipboard and on the PACS system. 

Tip for USB Quick Save 
only First time

Check box to select.

Table 3-42:  Patient/Exam Message Options

Preset Parameter Description
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Table 3-45:  Other ID Options 

Preset Parameter Description

Enable Other ID Not selected is the Default.
If selected, allow entering Other ID, such as Citizen Service Number, Burger 
Service Number (BSN), National Health System (NHS) number, along with 
patient ID information on the Patient Screen.

Validation Format If the Enable Other ID preset is selected, the system validates the format of 
“Other ID” when an ID is entered. Choose: NHS Number *** ** *****, Letters 
and Numbers, Numbers, or Any (no restriction)

Table 3-46:  USB Control 

Preset Parameter Description

Enable USB 
(Restart needed)

Check box to select.
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Bluetooth

To add a new bluetooth device, 

1. Press Add New Device. 
2. Type the device name in the Name field. 

 Figure 3-93. Connectivity Bluetooth Preset Menu

Table 3-47:  Device

Preset Parameter Description

Add New Device/Remove Press Add new device to add a new device; press Remove to delete a 
device. 

Properties: Name Type the name of the device. 

Properties: MAC Address Unique network card address. NOTE: Only available for MyComputer.

Properties: Enabled Select to enable bluetooth device. 

Properties: Image Transfer 
Support

Select to enable image transfer.

Properties: Date Added Display the new device added date.
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Tricefy

New GE Versana ultrasound systems have Tricefy pre-installed. 
Additional software is not necessary for using Tricefy; simply 
activate your account using the following steps.

1. Press Utility -> Connectivity -> Tricefy.
NOTE: The Tricefy tab is only available on machines that have 

Tricefy option.

 Figure 3-94. Tricefy Menu

2. Enable Tricefy checkbox, and enter the email address to 
authorize the account. Press “ Activate account” to 
activate your account, this process may take up to 30 
seconds, and a dialog will pop up if succeeded. And you will 
receive a notification email, click the link to complete the 
whole activating process.

Figure 3-95. Activate Tricefy Account
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Tricefy(continued)

3. Add Tricefy to Print workflow.
• Click Button to configure the P- Bottons for sending 

and sharing images.

 Figure 3-96. Button Menu

• Select Print1 (or Print2, Print3) which you would like to 
use. Then Select Trice Archive and press >> button to 
add it to Printflow View, press Save. Now when you 
press the P1 button, the image will be sent to your 
Tricefy cloud.

 Figure 3-97. Configure the P-Button for Tricefy
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Tricefy(continued)

4. If you want to share the images to patient, please add Trice 
Patient to Printflow View. And also remember input the 
patient’s Phone number or email address.

 Figure 3-98. Share Images to Patient

NOTE: If you has any problem with Tricefy settings, please contact 
your GE service/sales representative.
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Option Setup

Software Option Installation Procedure

NOTE: Not all features described in this section may be available or 
cleared for sale in all markets. Please contact with your local GE 
Ultrasound representative to get the latest information.

1. Power on the system.
NOTE: Keep the power cord connection during the installation.

2. After the power-up sequence is complete, press Utility on 
the control panel, and then select Admin -> System 
Admin.

3. Enter the new SW Option key and then select Add.

Figure 3-99. New Option Key

WARNING For software Option Installation, the operator must login as 
Administrator.
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Software Option Installation Procedure(continued)

4. To activate the changes, press Restart now to restart the 
system.

Figure 3-100. Dialog Window

NOTE: There is no need to restart the system after each 
installation, if several option keys are installed at one time. 
Select Restart later for the first several times, and select 
Restart now after the last installation to activate all the 
changes.

5. After the system is powered on, check the option status.

Figure 3-101. Check Option Status

The option status explanation:
• Permanent: This option is enabled in the system.
• Disabled: This option is disabled in the system.
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Software Option Installation Procedure(continued)

6. Configure the user defined key in Utility. On the screen, the 
user defined key name will be displayed.

7. This completes the option installation of Versana 
BalanceTM/Versana BalanceTM Vet.

NOTE: Installing corresponding hardware is a prerequisite of 
loading software option successfully. Please check below 
table for correspondence.

Table 3-48:  Software Corresponding Hardware

Software Option Hardware

4PP 4PP Front Cover Assy

DVDROM DVD Writer Kit

3D_4D 4D Box Assy
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Paperwork after setup

NOTE: During and after setup, the documentation (i.e. CDs with 
documentation, User Manuals, Installation Manuals, etc.) for the 
Versana BalanceTM/Versana BalanceTM Vet and the 
peripherals must be kept as part of the original Ultrasound 
system documentation. This ensures that all relevant safety and 
user information is available during the operation and service of 
the complete Ultrasound system.

Contents in this Section

• ‘User’s Manual(s)’ on page 3-112
• ‘Product Locator Installation Card’ on page 3-113

User’s Manual(s)

User Check that the correct User Manual(s) for the system and 
software revision, is included with the installation. Specific 
language versions of the User Manual may also be available. 
Check with your GE Sales Representative for availability. 
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Product Locator Installation Card

NOTE: The Product Locator Installation Card shown may not be the 
same as the provided Product Locator card.

 Figure 3-102. Product Locator Installation Card (Example)
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Chapter 4

General Procedures and
Functional Checks

This chapter provides procedures for quickly checking 
major functions of the Versana BalanceTM/Versana 
BalanceTM Vet and diagnostics instructions using the 
built-in service software.
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Overview

Purpose of this chapter

This chapter provides procedures for quickly checking major 
functions of the scanner and diagnostics instructions using the 
built-in service software.

Contents in this chapter

• ‘Overview’ on page 4-2
• ‘General procedures’ on page 4-3
• ‘Disk Encryption/Decryption’ on page 4-36
• ‘Functional checks’ on page 4-46
• ‘Power supply test & adjustments’ on page 4-68

Special Equipment required

To perform these tests, you'll need any of the sector, linear, or 
convex probes. (Normally you should check all the probes used 
on the system).
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General procedures

CAUTION Ultrasound system requires all covers.

Operate this Ultrasound system only when all board covers and 
frame panels are securely in place. The covers are required for 
safe operation, good Ultrasound system performance and 
cooling purposes.

WARNING Energy Control and Power Lockout for Versana BalanceTM/
Versana BalanceTM Vet.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   

Ultrasound System components may be energized. 
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Overview

Some procedures are used more often than other. The intention 
with this section is to keep the most used procedures in one 
place.

Contents in this section

• ‘Power ON/Boot Up’ on page 4-5
• ‘Power off’ on page 4-9
• ‘Check System Date and Time’ on page 4-11
• ‘Logging on to Versana BalanceTM/Versana BalanceTM Vet 

as “ADM”’ on page 4-12
• ‘Reset Logon Accounts to Factory Default (Reboot needed)’ 

on page 4-13
• ‘Service Key (SSA)’ on page 4-15
• ‘Exit to Windows Desktop from the Versana BalanceTM/

Versana BalanceTM Vet application software’ on page 4-16
• ‘Removable media’ on page 4-16
• ‘Backup and Restore Database, Preset Configurations and 

Images’ on page 4-16
• ‘Data Management’ on page 4-27
• ‘Backup’ on page 4-27
• ‘Restore the factory defaults’ on page 4-27
• ‘Installation and Setup Procedure for Peripherals’ on 

page 4-27
• ‘Where are the User Manuals and the Service Manual?’ on 

page 4-28
• ‘How to display or print the PDF files via a Windows PC?’ on 

page 4-28
• ‘Cleaning the Trackball’ on page 4-29
• ‘Cleaning the air filters’ on page 4-31



General procedures

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 4-5
5866796-100 English Rev.12

Power ON/Boot Up

Warnings

DANGER
 

ALWAYS CONNECT THE ULTRASOUND SYSTEM TO A 
FIXED POWER SOCKET WHICH HAS THE PROTECTIVE 
GROUNDING CONNECTOR.

DANGER
 

NEVER USE A THREE-TO-TWO PRONG ADAPTER; THIS 
DEFEATS THE SAFETY GROUND.

DANGER
 

ENSURE THAT THE POWER CORD AND PLUG ARE 
INTACT AND THAT THE POWER PLUG IS THE PROPER 
HOSPITAL-GRADE TYPE (WHERE REQUIRED).

CAUTION Ultrasound system requires all covers.

Operate this Ultrasound system only when all board covers and 
frame panels are securely in place. The covers are required for 
safe operation, good Ultrasound system performance and 
cooling purposes.
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Power ON/Boot Up(continued)

NOTE: Do not cycle the Supply Mains Switch ON-OFF-ON in less than 
five (5) seconds. When turning OFF the Supply Mains Switch, 
the Ultrasound system should de-energize completely before 
turning the Supply Mains Switch ON.

NOTE: For the new battery used for the first time, system may boot up 
failed because of the low battery power, please connect to 
power source in this case. If system boots up failed when using 
the battery, please check if the source power is connected, 
relying only on the battery with low power may cause the failed 
boot up.

CAUTION Use only power supply cords, cables and plugs provided by or 
designated by GE.

CAUTION The system will do probe check procedure during boot up.
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Connect AC (mains) Power to Versana BalanceTM/Versana BalanceTM 

Vet

Connecting AC Power to the Versana BalanceTM/Versana 
BalanceTM Vet ultrasound unit, involves preliminary checks of 
the power cord, voltage level and compliance with electrical 
safety requirements. Main switch is  an isolation means which 
used to isolate its circuits eletrically from the SUPPLY MAIN.

1. Ensure that the wall outlet is of appropriate type, and that 
the Circuit Breaker is turned off.

2. Uncoil the power cable, allowing sufficient slack so that the 
unit can be moved slightly.

3. Verify that the power cable is without any visible scratches 
or any sign of damage.

4. Verify that the on-site mains voltage is within the limits 
indicated on the rating label near the Circuit Breaker on the 
rear of the unit.

5. Connect the Power Cable’s female plug to the Power Inlet at 
the rear of the unit.

6. Lock the plug in position with the Retaining Clamp (ACC 
Clamp).

7. Verify that the Mains Power Circuit Breaker is in OFF 
position, if not, switch it OFF.

8. Connect the Power Cable’s other end (male plug) to a 
hospital grade mains power outlet with the proper rated 
voltage, and the unit is ready for Power ON/Boot Up.
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Switch ON the AC Power to Versana BalanceTM/Versana BalanceTM Vet

1. Switch ON the Mains Power Supply Mains Switch at the 
rear of the unit.
You should hear a “click” from the relays in the AC Power 
and the unit is ready to boot.

2. Press once on the On/Off key on the Operator Panel to boot 
the unit.

During a normal boot, you may observe that: 
a. The unit’s ventilation fan starts on full speed, but slows 

down after a few seconds (listen to the fan sound).
b. Power is distributed to the peripherals, Operator Panel 

(Console), Monitor, Front End Processor and Back End 
Processor.

c. Back End Processor and rest of scanner starts with the 
sequence listed in the next steps:

d. Back End Processor is turned ON and starts to load the 
software.

e. The Start Screen is displayed on the monitor.
f. A start-up bar indicating the time used for software 

loading, is displayed on the monitor.
g. The software initiates and sets up the Front End 

electronics and the rest of the instrument.
h. The backlight in the keyboard is lit.
i. As soon as the software has been loaded, either a 2D 

screen is displayed on the screen, indicating that a 
probe has been connected, or a No Mode screen is 
displayed, indicating that no probe has been connected.

NOTE: Total time used for start-up is typical one and a half 
minutes or less. If starting after a power loss or a 
lock-up, the start-up time may be up to four minutes.

NOTE: Diagnostic LEDs on the rear panel indicate the boot up 
status, refer to “Normal Status“ in Table 7-32 on 
page 7-102.

NOTE: Set up Drive D password and system password,See ‘EZ 
configuration Wizard’ on page 3-77 for more 
information.
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Power off 

When you switch off the unit, the system performs an automatic 
shutdown sequence.

The SYSTEM - EXIT menu, used when switching off the unit, 
gives you these choices:

Figure 4-1. System Exit Window

• Exit

(Only available when logged in as GE Service with Service 
Dongle)
Select this button when you want to exit to Windows.

• Standby

Use this button to turn off the backlight of LCD, freeze 
image, disable all keys (Function Keys, A/N keys, Trackball) 
except On/Off switch and turn off all backlight and active 
light of keys except On/Off switch.

NOTE: Image is still on freeze mode (Frozen Image).

• Logoff
Use this button to log off the current user. 
The system remains ON and ready for a new user to log on.
If the Logoff button is dimmed, it indicates that no user is 
logged on to the unit at the moment.
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Power off(continued)

• Shutdown
Use this button to shut down the system. The entire system 
will shut down. It is recommended to perform a full shutdown 
at least once a week.
If the Shutdown button is dimmed, use the key-combination 
<Ctrl+Alt+Delete> to shut down the unit.

NOTE: To enable the key-combination <Ctrl+Alt+Delete>, the 
dongle should be connected to the system.

• Cancel

Use this button to exit from the System-Exit menu and 
return to the previous operation.

System shutdown

Disconnect the Mains Power Cable is necessary. For example: 
Relocating the scanner.

CAUTION DO NOT unplug and/or transport the unit until after the power 
off sequence has been completed. Failure to do so may result 
in corrupted patient files.
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Check System Date and Time

A warning message "Please check the system date and time are 
correct" appears on the screen when the system is powered on. 
This warning message appears for the possible reasons:

• The system is not boot up for over 14 days.
• The system time has been changed by 24 hours earlier than 

the current system time of last boot-up.
• The BIOS time is changed by 24 hours earlier than the 

current system by resetting BIOS time, replacing BIOS 
module or changing BIOS time.

This warning message is to remind the user to check the system 
date in case the system date and time is incorrect.

 Figure 4-2. Check system date and time message

Move the cursor to OK and press Cursor key on the control 
panel to select OK. The system enters.

Check the system date and time. If it is incorrect, follow below 
steps to reset the system date and time.

• Enter Utility -> System -> General -> Date/Time.
• Reset the system date and time.
• Select Apply and then select OK.
• Select Save.
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Logging on to Versana BalanceTM/Versana BalanceTM Vet as 
“ADM”

Select Utility on the control panel, then select Admin. 

It will bring up the Operator Login dialog where you must log 
on.

Figure 4-3. Operator Login Window
1. Operator: Select the operator.
2. Password: Enter Operator’s password (optional).
3. Select the type of Login or Cancel.

• OK: Standard login.
• Cancel: Cancel login.

As default, ADM is defined.
• ADM

If you log on as ADM, you will have access to do general 
set-up, service adjustments, adjust network and connectivity 
settings.
Select the name ADM, the password as default and select 
Login.
It is possible for the administrator (ADM) to establish new 
users (USR) and set unique passwords for each user, 
including a new password for ADM. If the login as ADM fails, 
contact the responsible person in the hospital to get access. 
• USR

If you log on as USR, you will have access to do set-up 
tasks that a user may need to do during daily use. 

4. Reset Logon Accounts to Factory Default (Reboot 
needed): Plug in SSA Dongle to reset Logon accounts.
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Reset Logon Accounts to Factory Default (Reboot needed)

To reset logon account to factory default:

1. Check on “Enable Reset Logon Accounts To Factory 
Default” in Utility -> Admin -> Logon and save the setting 
before reseting logon accounts to factory default.

Figure 4-4. Enable Reset Logon Accounts To Factory Default

2. Select Reset Logon Accounts to Factory Default 
(Reboot needed).

Figure 4-5. Reset Logon Accounts to Factory Default 
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Reset Logon Accounts to Factory Default (Reboot 
needed)(continued)

3. A pop-up window appears. Press Ok and plug in the SSA 
Dongle.

Figure 4-6. Plug in SSA Dongle

4. The Checking Secure Key window pops up, click I Agree.

Figure 4-7. Checking Secure Key

5. Press Reset Logon Accounts to Factory Default again. A 
pop-up window appears and press Ok to continue.

Figure 4-8. Reboot system information

6. Reboot the system, and you will be prompted to first log into 
the Versana Balance. See ‘Logging on to Versana 
BalanceTM/Versana BalanceTM Vet as “ADM”’ on 
page 4-12 for more information.
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Service Key (SSA) 

A Service Key and a proprietary GE Service password are 
necessary for use by GE Service when performing proprietary 
level diagnostics like accessing the desktop on the BEP. The 
password used with the GE service key changes at specific 
intervals.

The SSA key provides secure access for GE service personal to 
advanced tools to service the system.

SSA is a class M key with the following characteristics:

• Access to all service features
• Access to Windows Desktop
• Key must be renewed every 30 days
• Tied to SSO
• Password locked via key pad

Please complete the course on GE Learning before using SSA:

Course name: Secure Service Access Training

Course ID: GEHC-SVCS-63061025

NOTE: Press I Agree to enter the Maintenance Access Screen when 
below Information dialogue window appears. Press OK before 
the status bar completes, otherwise the system may enter 
scanning screen.

Figure 4-9. Service Key Information
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Exit to Windows Desktop from the Versana BalanceTM/Versana 
BalanceTM Vet application software 

If you want to exit to the Windows Desktop when the application 
software is running, please refer to Proprietary Servce manual.

Removable media 

Refer to the latest revision of the User Manual to perform the 
following tasks:

• Using Removable Media
• Labeling Removable Media
• Formatting Removable Media
• Verifying Removable Media

Backup and Restore Database, Preset Configurations and Images

NOTE: Always save presets before any software reload. This ensures 
the presets loaded after the software reload are as up–to–date 
as possible.

All user presets except changes to Summary, Anatomy, and 
Biometry pages, can be saved on an DVD-R disk (or USB 
memory device) for reloading on the system.

NOTE: Presets should NOT be saved on the same USB memory device 
(or DVD-R disk) as images. The Archive Menu lists the images 
but does NOT list the presets stored on a USB memory device 
(or DVD-R disk).

EZ Settings Restore

EZ Settings Restore helps to fast backup Network, Userdefines 
and RSvP setting in local disk.

• Network: static IP address, Subnet mask and Default 
gateway of LAN adapter.

• Userdefines: Scanner software user settings of 
annotation, measure, report template and imaging 
presets.

• RSvP: Remote Service Platform settings include: Serial 
Number, CRM No, Enterprise Host and port, Software 
Download URL, Proxy Configuration.
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EZ Settings Restore(continued)

To perform EZ Settings Restore,  

1. Click Insite ExC icon at the upper right of the display screen.
2. Select EZ Settings Restore.
3. Select any options under Restore Options and then click 

Restore, those settings will be restored.

 Figure 4-10. EZ Settings Restore

If user never perform backup since software installed, there 
will be no restore options listed in EZ Settings Restore 
window. Press One Key Backup to backup first.
After restore completed, an information window pops out. 
Press OK to restart the system to make changes take effect.

Figure 4-11. Restore complete
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Formatting Media

1. Select Utility -> Connectivity -> Removable Media.
2. Select the media type from the drop down menu.
3. Enter the label for the media. It is best to use all capital 

letters with no spaces or punctuation marks. Select Format.

Figure 4-12. Format and Verify Media

4. The system displays a pop-up menu, as shown in 
Figure 4-13, select OK to continue.

Figure 4-13. Format Warning Pop-up Window

5. If desired, verify that the format was successful by returning 
to Utility-> Connectivity->Removable Media and selecting 
Verify.



General procedures

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 4-19
5866796-100 English Rev.12

Backup System Presets and Configurations

NOTE: Always backup any preset configurations before a software 
reload. This ensures that if the presets need to be reloaded, 
after the software update, they will be the same ones the 
customer was using prior service.

1. Insert a formatted media into the drive.
2. Enter enter Utility-> System-> Backup/Restore.

NOTE: If you are not logged in as GE Service or with administrator 
privileges, the Operator Login window is displayed. Log on 
with administrator privileges.

3. In the Backup list, select Patient Archive, User Defined 
Configuration and Service.

4. In the Media field, select CD/DVD (or USB memory device).
5. Select Backup.

The system performs the backup. As it proceeds, status 
information is displayed on the Backup/Restore screen.

Figure 4-14. Backup/Restore Menu
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Restore System Presets and Configurations

1. Insert the Backup/Restore CD/DVD (or USB memory 
device) into the drive.

2. Enter enter Utility-> System-> Backup/Restore.
NOTE: If you are not logged in with administrator privileges, the 

Operator Login window is displayed.Log on with 
administrator privileges.

3. In the Restore list, select Patient Archive, User Defined 
Configuration and Service.

4. In the Media field, select the Backup/Restore CD/DVD (or 
USB memory device).

5. Select Restore.
The system performs the restore. As it proceeds, status 
information is displayed on the Backup/Restore screen.

 Figure 4-15. Restore message

CAUTION The restore procedure overwrites the existing database on the 
local hard drive. Make sure to insert the correct CD (or USB 
memory device).
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Archiving Images

1. Insert the archive media.
2. To format the archive media, enter Utility-> Connectivity-> 

Removable Media.
3. Format the CD. Verify the format if desired.
4. Images will be moved from the hard drive by date. 

Therefore, the best way is to label media by date.
NOTE: Images will be moved from the hard drive by date. 

Therefore, the best way to label media is by date. When 
images are moved to the archive media, they will be deleted 
from the system hard drive. However, the patient database 
(backed up earlier) maintains pointers to the location of the 
images on the archive media.

Figure 4-16. Format Media Screen

5. Enter Utility-> System-> Backup/Restore.
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Archiving Images(continued)

6. Select “Move File Older Than in Days”.

Figure 4-17. EZBackup/Move 1
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Archiving Images(continued)

7. Press EZBackup/EZMove.

 Figure 4-18. EZBackup Wizard for Touch Panel System

 Figure 4-19. EZBackup Wizard for Non-Touch Panel System
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Archiving Images(continued)

8. Verify the information on the first page of EZBack/EZMove 
wizard, then select Next. If you want to backup all of the 
exams in the range (even if the exam was previously 
backed up), check Full backup. If you uncheck this option, 
the system only backs up exams which have not yet been 
backed up.

Figure 4-20. EZBackup Wizard 1

9. It indicates the size of the data and the storage. Select Next 
to continue.

NOTE: The calculation for the number of backup CD is only an 
estimate. Allow for one additional CD when performing an 
EZBack/EZMove.

Figure 4-21. EZBackup Wizard 2
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Archiving Images(continued)

NOTE: This message “Please insert a blank media...” appears if 
you press Next without inserting the backup media. Insert 
the media and continue.

Figure 4-22. Insert Media Message

10. The status menu appears. When the backup/move has 
been complete, press Next.

Figure 4-23. EZBackup Wizard 3

NOTE: If you need to insert the next media, a message appears 
providing you with the media label.
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Archiving Images(continued)

11. When the backup is complete, the completion wizard page 
appears. Press Finish.

Figure 4-24. EZBackup Completion Window

All databases, presets and images should now be saved to 
removable media.

NOTE: After EZBackup completed, system will eject the removable 
media automatically. No need to press F3 key to eject it.
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Data Management

Refer to the latest revision of the Versana BalanceTM/
Versana BalanceTM Vet User Manual to perform the following 
tasks:

• Configuring the Disk Management Function
• Setting the Disk Management Schedule
• Configuring Data Management Settings
• Configuring Destination Device Setting
• Running the Disk Management Function
• Starting Disk Management Manually

Backup

For more information, refer to the latest revision of the Versana 
BalanceTM/Versana BalanceTM Vet User Manual.

Restore the factory defaults

For instructions, please see “Backup and Restore” in the User 
Manual.

Installation and Setup Procedure for Peripherals

Please refer to ‘Peripherals Installation Instructions’ on 
page 3-33.

WARNING To avoid not being able to connect to Local Archive, 
connecivity.res and IPSave in 
D:\Idunn\target\resources\idunn\userdefs should not be 
deleted. If they are deleted, please rewrite the serial number.
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Where are the User Manuals and the Service Manual?

The latest version of manuals are available on the Internet at 
http://www.gehealthcare.com/DocumentationLibrary.

Online versions of the User Manuals (multi-langauge User 
Manual and Advanced Reference Manual) are available via F1 
key on the system. Please refer to Versana BalanceTM/
Versana BalanceTM Vet Electronic Instructions for Use on how 
to install the online documentation on the ultrasound scanner.

Both the User Manuals and the Service Manual are delivered as 
PDF files in an eIFU USB. Paper copies may be ordered from 
GE.

How to display or print the PDF files via a Windows PC?

1. Plug in the media into the USB port on a PC or Laptop with 
Adobe Acrobat Reader.

2. Open the media on your PC or Laptop.
3. Double click on gedocumentation.html.
4. Click the item in desired language to view the user 

documentation.
5. Before printing the complete manual, or pages from the 

manual, select File > Print.
6. Select the paper size and choose Portrait.
7. Select Print to start printing. In the pop up window, you may 

choose which pages to print and the number of copies you 
want to print (usually 1 copy).
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Cleaning the Trackball

Manpower

One person, 10 minutes,

Tools

• Antistatic brush and/or antistatic vacuum cleaner

Preparations

To get access to the trackball for cleaning, you must perform the 
following steps:

1. Power down the system.
2. Disconnect the mains power cable from the wall outlet.

Follow these links if you need more information: See ‘Power off’ 
on page 4-9 for more information.

WARNING DO NOT touch any boards with integrated circuits prior to 
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised 
ESD connection point located on the rear of the Ultrasound 
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive 
equipment.
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Clean the Trackball

Dust is often building up behind the ball, so it interferes with the 
ball rotation and for optical trackballs the light used for sensing. 
To get access for cleaning, you need to remove the ball. 

The ball is held in position by the Dust Gasket.

1. Power off the system.
2. Rotate the dust gasket counterclockwise until it can be 

removed from the keyboard.

Figure 4-25. Rotate the retainer

3. Separate the trackball and the gasket. Wipe off any oil or 
dust from the trackball, gasket and the trackball housing 
using a cleaner or cotton swab.

4. Assemble the trackball and gasket, then put it into the 
housing and rotate it clockwise until its notches are set in 
the position.

Test the Trackball

Power up the system and test that the trackball now works as 
intended.

CAUTION When cleaning, make sure not to spill or spray any liquid into 
the trackball housing (keyboard or system).
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Cleaning the air filters

Clean the system's air filters to ensure that a clogged filter does 
not cause the system to overheat and reduce system 
performance and reliability. It is recommended the filters be 
cleaned every two weeks, but the requirements will vary due to 
your system use.

Manpower

One person, 5 minutes,

Tools

• None

Preparations

To get access to the air filter for cleaning, you must perform the 
following steps:

1. Power down the system.
2. Disconnect the mains power cable from the wall outlet.

Follow these links if you need more information: See ‘Power off’ 
on page 4-9 for more information.

CAUTION Be sure to lock the wheels before cleaning the air filters to 
avoid injury by any unexpected movement of the system.

DO NOT operate the unit without the air filters in place.

Allow the air filters to dry thoroughly before re-installing them 
on the unit.
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Cleaning

1. Power off the system.
2. Remove the body left and right cover on both sides.

Figure 4-26. Remove the body right and left cover
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Cleaning(continued)

3. Remove the air filters on both side panels.

Figure 4-27. Remove the Filters

4. Dust the filters with a vacuum cleaner and/or wash it with a 
mild soapy solution.
If washed, rinse and dry the filters before re-installation.

5. Re-install the clean filter in the reverse order of removal.

NOTE: Please align the 2 Pins with the 2 holes on both side panels 
during installation.

Figure 4-28. Install the Filters
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Cleaning the gel warmer

The reservoir of the gel warmer is designed to hold the 
redundant gel temporarily. User needs to clean the reservoir in 
time to avoid reservoir being full and leaking inside of the 
system.  

Follow below steps to remove and clean the reservoir:

1. Spin the reservoir counterclockwise to remove it from the gel 
warmer.
a. Clean the reservoir.
b. If there is already gel leaked to the inside of gel warmer, 

please clean it before re-install the reservoir.

 Figure 4-29. Remove the reservoir from gel warmer

2. Re-install the reservoir to the gel warmer.

CAUTION If the gel leaked in the gel warmer always cannot be cleaned 
on time, it may cause a short circuit in the internal board.
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Monitor 

To clean the monitor face:

Use a soft, folded cloth. Gently wipe the monitor face.

DO NOT use a glass cleaner that has a hydrocarbon base (such 
as Benzene, Methyl Alcohol or Methyl Ethyl Kentone) on 
monitors with the filter (anti-glare shield). Hard rubbing will also 
damage the filer.

NOTE: When cleaning the screen, make sure not to scratch the 
monitor.

Operator Control Panel

To clean the operator control panel:

1. Moisten a soft, non-abrasive folded cloth with a mild, 
general purpose, non-abrasive soap and water solution.

2. Wipe down operator control panel.
3. Use a cotton swab to clean around keys or controls. Use a 

toothpick to remove solids from between keys and controls.

NOTE: When cleaning the operator control panel, make sure not to spill 
or spray any liquid on the controls, into the system cabinet, or in 
the probe connection receptacle.

NOTE: In case of SARS, use bleach, or Cidex in a normal diluted form 
for cleaning/disinfecting the operator panel. 

NOTE: DO NOT use T-spray or Sani Wipes on the control panel. 

NOTE: DO NOT remove AN Key film when clean the control panel. 

CAUTION Before cleaning the control panel, make sure the key cap is 
firmly in place. 
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Disk Encryption/Decryption

Overview

Disk Encryption is a function to protect the patient information on 
the device and prevent unauthorized access to PI/PHI, 
especially when the device is stolen. The encryption AES is 256 
bit.

NOTE: Disk Encryption can also protect the user data stored on 
removable device.

NOTE: The steps for Removable Media Encryption and Local Patient 
Data Drive Encryption are the same.

CAUTION The user must make backups and take care of the encryption 
password/passphrase and recover key. It is the customer’s 
responsibility for storing the data. GE will have no back door or 
any responsibility or possibility of recovering the data.
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Disk Encryption

1. Login as administrator. Press Utility -> Admin -> System 
Admin -> Disk Encryption.

 Figure 4-30. Disk Encryption 1
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Disk Encryption(continued)

2. Select Encryption.
3. Enter a password or a passphrase and re-enter to confirm. 

Press Continue.
NOTE: A valid password must be at least 8 characters long and has 

a maximum length of 256 characters.

Figure 4-31. Disk Encryption 3

4. Insert a USB and select Save Recovery Keys to save the 
recovery keys to USB device. You can press Hide recovery 
key to hide the recovery key. Press Close to exit.

User can also configure Disk Encryption by EZ Configuration 
Wizard. See ‘EZ configuration Wizard’ on page 3-77 for more 
information.

CAUTION Make sure to keep the password/passphrase, recovery key 
and any back up of these in secure place, not accessible 
for unintented audience.
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Pause Encryption

1. During encryption process for Removable Media, you can 
press Pause to stop the encryption process

Figure 4-32. Encryption Pause 1
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Resume Encryption

During Disk encryption/decryption process for Removable 
Media, press pause to stop. Follow below steps to resume the 
conversation:

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Resume to resume disk encryption/
decryption.

Figure 4-33. Encryption Resume 1
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Change Password

After the encryption process is completed, you can change the 
password as you prefer.

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Change Password.

Figure 4-34. Change Password 1
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Change Password(continued)

2. Enter new password/passphrase,  and re-enter it to confirm.

Figure 4-35. Change Password 2

3. Press Continue to complete changing password.
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Change Recovery Key

After the encryption process is completed, you can change the 
recovery key as you prefer.

1. Press Utility -> Admin -> System Admin -> Disk 
Encryption. Press Change Recovery Key.

Figure 4-36. Change Recovery Key 1

2. Insert a USB to store the new recovery key.
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Unlock with user entered key & recovery key

When the patient data is in locked status, you can unlock it with 
user entered key and recovery key.

You can insert the USB with recovery key, or you can input the 
password or recovery key manually to unlock the system.

NOTE: If you press Cancel, the system will stay in locked status and 
some of the functions will be not available.

Figure 4-37. Unlock Dialog

Emergency Scanning

1. Boot scanner.
2. Press Cancel on unlock dialog.

Figure 4-38. Cancel Unlock Process

3. Continue as before (Press Emergency in login dialog).
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Disk Decryption

1. If you want to decrypt the patient data, you can press Utility 
-> Admin -> System Admin -> Disk Encryption. Select 
Decryption.

Figure 4-39. Decryption 1

2. Enter a password or a passphrase and re-enter to confirm. 
Press Continue.

Figure 4-40. Decryption 2
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Functional checks

Overview

In this section, the functional checks for Versana BalanceTM/
Versana BalanceTM Vet are described. Functional checks are 
used to verify that the product works as intended. Functional 
checks may also be used during troubleshooting.

Contents in this Section

Preparation

Turn on power to Versana BalanceTM/Versana BalanceTM 
Vet. For detailed description, See ‘Power ON/Boot Up’ on 
page 4-5 for more information.
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Basic Controls

Control Panel 

 Figure 4-41. Control panel map

1. Power On/Off
2. Patient key
3. Probe key
4. Report key
5. End Exam key
6. Whizz key
7. Cursor key
8. M Mode/X
9. CW
10.  Clear key
11. Measure key

12. PW Mode/Y
13. PDI
14.  CF Mode/Z
15. Body Pattern key
16. Set key
17. B Mode key
18. Freeze key
19. Dual key&Quad key
20. Depth/Probe Rotation key
21. Ellipse/Zoom key
22. Utility -> Connectivity -> 

Button

23. Scan Coach key
24. Alphanumeric Keyboard
25. Utility
26. Comment key
27. CHI key
28. Trackball
29. User Configurable Keys
30. TGC
31. Combination Rotaries/

Buttons
32. Up and Down
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Primary Menu Key Tour

1. Rotary key: Rotate to adjust the menu.
2. Page Up/Down key: To turn the menu page up and down.

 Figure 4-42. Primary Menu Key Tour

Monitor Display

 Figure 4-43. Monitor Display Tour for Touch Panel System
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Monitor Display(continued)

 Figure 4-44. Monitor Display Tour for Non-Touch Panel System

1. Institution/Hospital Name, Date, Time, Operator 
Identification.

2. Patient Name, Identification.
3. Power Output Readout.
4. Probe Identifier. Exam Preset.
5. Current date and time, Caps Lock: (lit when on), 

network connection indicator (PC=connected, 
PC with X=not connected), system messages 
display, InSite status, InSite controls.     

6. Imaging Parameters by Mode.     
7. Cine Gauge. 
8. Active Images screen. 
9. Delete Image. 
10. Save As Menu.
11. Slide Show
12. Image Preview. 

13. Primary Menu (for Touch Panel system, the 
primary menu is displayed on touch panel).

14. Measurement Results Window. 
15. Gray/Color Bar.
16. Image Clipboard.
17. Probe Orientation Marker.
18. Image.
19. Measurement Calipers.
20. Region of interest.
21. Depth Scale.
22. Focal Zone Indicator.
23. Body Pattern.
24. Measurement Summary Window.
25. User Configurable Keys.
26. P1, P2, P3.
27. Follow-up tool.
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Performance Tests

Image Quality Check (IQC) preset for service

Image Quality Check (IQC) is intended to facilitate Image 
Quality checks during Quality Assurance Evaluation. Quality 
Assurance tests are used to determine whether a scanner is 
providing the same level of performance year after year.

By using the same setting year after year, this ensures that the 
data collection consistent, independently of who performs the 
test.

This preset only includes fundamental settings for 2D mode. 
Processing modes like SRI, Harmonics, etc., are turned off.

To do IQC, follow the steps below:

NOTE: The IQCforService is only visible when service dongle is 
connected to the system.

1. Activate IQC via Utility--> Admin--> System Admin. 
Check the “Enable IQC for Service” box. Select Save, then 
select Exit.

Figure 4-45. Check “Enable IQC”
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Image Quality Check (IQC) preset for service(continued)

2. Press Utility -> Imaging Preset Manager. Select IQC from 
the left column, and selece “>>” to move it to the Imaging 
Preset Selections. Then Select Exit. 

 Figure 4-46. Image Quality Check 

3. Press Probe/Preset on the control panel. Then select IQC.

Test Phantoms

The use of test phantoms is only recommended if required by 
your facility's (customer’s) QA program.
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B Mode Checks

Introduction

The B Mode is the system’s default mode.

Preparations

• Connect one of the probes. 
• Turn ON the scanner.

The B Mode is displayed (default mode).

Adjust the B mode controls

Press B Mode on the Operator Panel to access B mode.

These Image Controls are used to optimize the B Mode picture. 
Verify that all the listed controls are working as intended:

• Use Gain and TGC controls to optimize the overall image 
together with the Power control.

• Use Depth to adjust the range to be imaged.
• Use Focus to center the focal point(s) around the region of 

interest.
• Use Frequency (move to higher frequencies) or Line 

Density (move to higher line density) to increase resolution 
in image.

• Use Frequency (move to lower frequency) to increase 
penetration.

• Use the Rejection control to reduce noise in the image.
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M Mode Checks

Preparations

• Connect one of the probes to the scanner’s left-most probe 
connector.

• Turn ON the scanner. 
The 2D Mode window is displayed (default mode).

• Press M Mode on the Operator panel to bring up an 
M-Mode picture on the screen.

Use the trackball to position the cursor over the required 
area of the image.

Adjust the M Mode controls

These Image Controls are used to optimize the M mode picture. 
Verify that all the listed controls are working as intended:

• Adjust Horizontal sweep to optimize the display resolution.

Adjust Gain and TGC controls to adjust the range to be 
imaged.
Adjust Compression and Edge Enhance to further 
optimize the display.
Adjust Rejection to reduce noise while taking care not to 
eliminate significant low-level diagnostic information.
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Color Mode Checks

Introduction

Color Flow screens are 2D or M Mode screens with colors 
representing blood or tissue movement.

Color Flow may be selected both from 2D mode or from M mode 
or a combination of these.

Preparations

• Connect one of the probes to the scanner’s left-most probe 
connector.

• Turn ON the scanner.

The 2D Mode window is displayed (default mode).

Select Color 2D Mode

1. From an optimized 2D image, press CF.
2. Use the trackball to position the ROI frame over the area to 

be examined.
3. Press Set. The instruction Size should be highlighted in the 

trackball status bar. Use the trackball to adjust the 
dimension of the ROI.
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Adjust the Color Mode controls

• Adjust the Active mode gain to set the gain in the color flow 
area.

Adjust Scale to the highest setting that provides adequate 
flow detection.

NOTE: The scale value may affect FPS, Low Velocity Reject, and 
Sample Volume.

Adjust Wall Filter to remove low velocity blood flow and 
tissue movement that reduces image quality.
Adjust Sample volume (SV) to a low setting for better flow 
resolution, or a higher setting to more easily locate disturbed 
flows.
Adjust Frequency to optimize the color flow display. Higher 
settings improve resolution. Lower settings improve depth 
penetration and sensitivity. This does not affect the 
frequency used for 2D and M-Mode.

NOTE: Frequency setting may affect FPS, SV and Low Velocity 
Reject.

Adjust PowerOutput to obtain an acceptable image using 
the lowest setting possible.

NOTE: The Power setting affects all other operating modes.

Adjust the following settings to further optimize display of the 
image:

• Use Invert to reverse the color assignments in the color flow 
area of the display.

Use Threshold to emphasize either the color flow overlay, 
or the underlying grey scale tissue detail.
Use Baseline to emphasize flow either toward or away from 
the probe.
Use Spatial Filter to reduce noise in the color flow area. 
Spatial Filter smooths the image by averaging collected data 
along the same horizontal line. An increase of the spatial 
filter will reduce noise, but this will also reduce the lateral 
resolution.
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Select Color M Mode

1. Select M Mode.
2. Use the trackball to position the ROI frame over the area to 

be examined.
3. Press Set. The instruction Size should be highlighted in the 

trackball status bar. Use the trackball to adjust the 
dimension of the ROI.

Adjust the Color M Mode controls

• Adjust the Active mode gain to set the gain in the color flow 
area.

Adjust Scale to the highest setting that provides adequate 
flow detection.

NOTE: The scale value may affect FPS, Low Velocity Reject, and 
Sample Volume.

Adjust Wall Filter to remove low velocity blood flow and 
tissue movement that reduces image quality.
Adjust Sample volume (SV) to a low setting for better flow 
resolution, or a higher setting to more easily locate disturbed 
flows
Adjust Frequency to optimize the color flow display. Higher 
settings improve resolution. Lower settings improve depth 
penetration and sensitivity. This does not affect the 
frequency used for 2D and M-Mode.

NOTE: NOTE: Frequency setting may affect FPS, SV and Low 
Velocity Reject.

Adjust PowerOutput to obtain an acceptable image using 
the lowest setting possible.

NOTE: The Power setting affects all other operating modes.

Adjust the following settings to further optimize display of the 
image:

• Use Invert to reverse the color assignments in the color flow 
area of the display.

Use Threshold to emphasize either the color flow overlay, 
or the underlying grey scale tissue detail.
Use Baseline to emphasize flow either toward or away from 
the probe.
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PW Doppler Mode Checks

Introduction

PW Doppler are used to measure velocity (most often in blood).

Doppler mode can be done with a special pencil probe or with 
an ordinary probe. By using an ordinary probe, you can first 
bring up a 2D picture for navigation purpose and then add PW 
Doppler.

Preparations

• Connect one of the probes to the scanner. 
• See ‘Probe/Connectors Check’ on page 4-62 for info about 

connecting the probes.
For available probes, see ‘Probe’ on page 9-6: 

• Turn ON the scanner.
The 2D Mode window is displayed (default mode).

• If needed, adjust the Display’s Brightness and Contrast 
setting. 

Press PW to start Pulsed Wave Doppler (PW).
Use the trackball to select the Area of Interest (Sample 
Volume) in PW.
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Adjust the PW Doppler Mode controls

Adjust the Active mode gain to set the gain in the spectral 
Doppler area.

• Adjust Wall Filter to reduce unwanted low velocity blood 
flow and tissue movement.

In PW mode, adjust Sample volume to low setting for better 
resolution, or higher setting to more easily locate the 
disturbed flows.
Adjust the Compression setting to balance the effect of 
stronger and weaker echoes and obtain the desired intensity 
display.
Adjust Frequency to optimize flow display. Higher setting 
will improve resolution and the lower setting will increase the 
depth penetration.
Adjust Frame rate to a higher setting to improve motion 
detection, or to a lower setting to improve resolution.

NOTE: Frequency and Frame rate settings may affect the Low 
Velocity Reject.

Adjust Power Output to obtain an acceptable image using 
the lowest setting possible. This is particularly important in 
CW mode, as the energy duty cycle is 100% (constant).

NOTE: The Doppler Power setting affects only Doppler operating 
modes.

Adjust the following settings to further optimize the display 
of the image.
Use the Sweep Speed to optimize the sweep speed. 
To view signal detail, adjust Scale to enlarge the vertical 
spectral Doppler trace.
Use Invert to reverse the vertical component of the spectral 
Doppler area of the display.
Use Angle Correct to steer the ultrasound beam to the 
blood flow to be measured.
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Tissue Velocity Imaging (TVI) Checks

Introduction

TVI calculates and color codes the velocities in tissue. The 
tissue velocity information is acquired by sampling of tissue 
Doppler velocity values at discrete points. The information is 
stored in a combined format with grey scale imaging during one 
or several cardiac cycles with high temporal resolution.

Preparations

• Connect one of the probes, to the scanner’s left-most probe 
connector. 

• See ‘Probe/Connectors Check’ on page 4-62 for info about 
connecting the probes.
For available probes, see ‘Probe’ on page 9-6: 

• Turn ON the scanner.
The 2D Mode window is displayed (default mode).

• If needed, adjust the Display’s Brightness and Contrast 
setting. 

Press TVI.
Use the trackball (assigned function: Pos) to position the 
ROI frame over the area to be examined.
Press Set. The instruction Size should be highlighted in the 
trackball status bar.

NOTE: If the trackball control pointer is selected, press trackball to 
be able to select between Position and Size controls.

Use the trackball to adjust the dimension of the ROI.
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Adjust the TVI Controls

• To reduce quantification noise (variance), the Nyquist limit 
should be as low as possible, without creating aliasing. To 
reduce the Nyquist limit: Reduce the Scale value.

NOTE: The Scale value also affects the frame rate. There is a trade 
off between the frame rate and quantification noise.

TVI provides velocity information only in the beam direction. 
The apical view typically provides the best window since the 
beams are then approximately aligned to the longitudinal 
direction of the myocardium (except near the apex). To 
obtain radial or circumferential tissue velocities, a 
parasternal view must be used. However, from this window 
the beam cannot be aligned to the muscle for all the parts of 
the ventricle.

NOTE: PW will be optimized for Tissue Velocities when activated 
from inside TVI.
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Basic Measurements

NOTE: The following instructions assume that you first scan the patient 
and then press Freeze.

Check Distance and Tissue Depth Measurement

1. Press Measure once to display an active caliper.
2. Move the trackball to position the active caliper at the start 

point (distance) or the most anterior point (tissue depth).
3. Press Set to fix the start point.
4. The system fixed the first caliper and displays a second 

active caliper.
5. Move the trackball to position the second active caliper at 

the end point (distance) or the most posterior point (tissue 
depth).

6. Press Set to complete the measurement. The system 
displays the distance or tissue depth value in the 
measurement results window.

Before you complete a measurement:

To toggle between active calipers, rotate Cursor Select button.

To erase the second caliper and the current data measured and 
start the measurement again, press Clear.

NOTE: To rotate through and activate previously fixed calipers, rotate 
Cursor Select button.

NOTE: After you complete the measurement, to erase all data that has 
been measured to this point, but not data entered onto 
worksheets, press Clear.
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Probe/Connectors Check

NOTE: Probes can be connected at any time, whether the unit is ON or 
OFF.

To connect a Probe

1. Place the probe’s carrying case on a stable surface and 
open the case.

2. Carefully remove the probe and unwrap the probe cable.
3. Put the porbe in the probe holder.

4. Hold the probe connector vertically with the cable pointing 
upward.

5. Slide  the connector lock to the left (unlocked position).
6. Align the connector with the probe port and carefully push 

into place.
7. Slide the connector lock to the right position to secure the 

probe connector.
8. Carefully position the probe cable in the probe cord holder 

spot so it is free to move, but not resting on the floor.

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage.

CAUTION TAKE THE FOLLOWING PRECAUTIONS WITH THE PROBE 
CABELS:

-KEEP AWAY FROM THE WHEELS

-DO NOT BEND

-DO NOT CROSS CABLES BETWEEN PROBES

Table 4-1:  Probe and Connectors Checks

Step Task Expected Results

1 Select the appropriate connected probe from the 
probe indicators.

The probe activates in the currently-selected 
operating mode. The probe’s default settings 
for the mode and selected exam are used 
automatically.

2 Launch the application. To change application, 
press Probe key on the Control Panel.

The selected application starts.

3 Verify there’s no EMI/RFI or artifacts specific to the 
probe.

No EMI/RFI or artifacts.
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Activating the probe

The probe activates in the currently-selected operating mode. 
The probe’s default settings for the mode and selected exam are 
used automatically.

Deactivating the probe

1. Press the Freeze key.
2. Gently wipe the excess gel from the face of the probe. 

(Refer to the User Guide for complete probe cleaning 
instructions.)

3. Carefully slide the probe around the right side of the 
keyboard, toward the probe holder. Ensure that the probe is 
placed gently in the probe holder.

Disconnecting the probe

Probes can be disconnected at any time. However, the probe 
should not be selected as the active

1. Unlock the probe.
2. Pull the probe and connector straight out of the probe port.
3. Carefully slide the probe and connector away from the 

probe port and around the right side of the keyboard.
4. Ensure the cable is free.
5. Be sure that the probe head is clean before placing the 

probe in its storage box.

4 Test the probe in each active connector slot. It will display pictorial data each time.

5 Do a leakage test on the probe, See ‘Electrical 
safety tests’ on page 10-20 for more information.

It passes the test.

6 Repeat this procedure for all available probes.

Table 4-1:  Probe and Connectors Checks

Step Task Expected Results

WARNING Take the following precautions with the probe cables: Do not 
bend, be sure to keep probe cables free from the wheels.
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ECG Check

Introduction

The ECG capability on this unit, is intended as use as a trigger 
for measurements, but can also be viewed on the screen.

Parts needed

• ECG Module 

Preparations

None

ECG Check

Table 4-2:  ECG Checks

Step Task Expected Result(s)

1 Connect the ECG harness to the connector 
under the control panel.

The unit displays a straight curve along the 
bottom edge of the image sector on the screen.

2 Connect the three leads to an ECG simulator,
or
Fasten the three ECG Pads to your body and 
connect the three leads to respective ECG 
Pad.

When connecting, the signal on the screen will 
be noisy.
When the connection is completed, a typical 
clean ECG signal is displayed.



Functional checks

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 4-65
5866796-100 English Rev.12

Cineloop Check

Introduction

A cineloop is a sequence of images recorded over a certain time 
frame. When using ECG the time frame can be adjusted to 
cover one or more heart cycles. When frozen, the System 
automatically displays the cineloop boundary markers on either 
side of the last detected heart cycle.

Preparation

• Connect one of the probes to the scanner. 
• See ‘Probe/Connectors Check’ on page 4-62 for info about 

connecting the probes
For available probes, see ‘Probe’ on page 9-6: 

• Turn ON the scanner. The 2D Mode is displayed (default 
mode).

Adjust the Cineloop controls

• Press Freeze.
The left and right markers are displayed on either side of the 
last detected heart cycle on the ECG trace.

• Press Freeze.
The selected heart beat is played back.

• Press Freeze to freeze the cineloop.
Use the trackball to scroll through the acquisition and find 
the sequence of interest.

• Adjust Cycle select to move from heart beat to heart beat 
and select the heart cycle of interest.

Adjust Num cycles to increase or decrease the number of 
heart beats to be played back.
Adjust Left marker and Right marker to trim or expand the 
cineloop boundaries.
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Back End Processor checks

• If all the previous tests have been passed successfully, the 
Back End Processor is most likely OK.

If the system seems to be operating erratically, please refer 
to ‘Diagnostics/Troubleshooting’ on page 7-1.

Operator Panel Test

• The Operator Panel is tested when the Versana 
BalanceTM/Versana BalanceTM Vet is powered up as part 
of the start-up scripts, run at every start-up. 

For more info, please refer to ‘Diagnostics/Troubleshooting’ 
on page 7-1.

Peripheral checks

Check that peripherals work as described below:

Printer checks

The internal printer is controlled from the assigned Print and 
Store keys on the Versana BalanceTM/Versana BalanceTM 
Vet’s Operator Panel. 

The factory default is:

• Print for the standard printer

Store for the screen capture to clipboard

Table 4-3:  Peripheral Checks

Step Task to do Expected Result(s)

1. Press FREEZE Stop image acquisition.

2. Press PRINT on the 
Control Panel

The image displayed on the screen is 
printed on B&W printer.

3. Connect with Foot 
Switch on USB port 
and press once.

To start image acquisition (the same 
function as FREEZE key).
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Turn OFF Power to Versana BalanceTM/Versana BalanceTM Vet

See ‘Power off’ on page 4-9 for more information.

Mechanical Functions Checks

Operator Panel Movement

Please refer to:

• ‘Monitor Adjustments’ on page 6-6

Casters (Wheels) and Brakes Checks

Examine the wheels frequently for defects to avoid breaking or 
jamming.

Table 4-4:  Wheel Characteristics

Wheel Characteristics

Front and Rear Swivel and Brake
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Power supply test & adjustments

Power Supply Test Procedure

There is no need to do any special tests on the Power Supplies 
if there don’t seems to be a problem that may be related to the 
Power Supply. 

Refer to ‘System Doesn’t Boot (Hang-up)’ on page 7-102, if you 
appear to have a problem that may be related to the Power 
Supplies. 

Power Supply Adjustment

There are no adjustments on the power supply. The DC Power 
is self-regulated. If a voltage is outside the specified range, it 
means that something is wrong, either with the power supply 
itself or with a unit connected to that specific power outlet. When 
an error occur, the power will be turned off immediately.

Refer to ‘System Doesn’t Boot (Hang-up)’ on page 7-102, if you 
appear to have a problem that may be related to the Power 
Supplies. 
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Application Turnover Check List

Complete these checks before returning the scanner to 
customer for use:

Software Configuration Checks

Table 4-5:  Software Configuration Checks

Step Task to do Notes

1 Verify Date and Time is correct.

2 Verify that Location (Hospital Name) is correct.

3 Verify Language settings are correct.

4 Verify assignment of Print Keys.

5 Verify all of the customer’s options are set up 
correctly.

Demo Option strings turn on 
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Site Log

Table 4-6:  Site Log

DATE SRVICE PERSON PROBLEM COMMENTS
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My Trainer

Overview

My Trainer provides a quick guide to operate the system.

To access My Trainer,

1. Press Alt + H to enter My Trainer.
Or,
Press Utility -> System -> User Configurable Key.  Check 
Enable Keyboard Key, then set My Trainer in the Keyboard 
Key or User Defined Key.

Figure 4-47. Set My Trainer

2. Press defined key to access My Trainer.
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Overview(continued)

There are five sections in My Trainer. The five sections are 
displayed on the left side of the My Trainer interface. 

Figure 4-48. Sections display

1. Getting Started: Circuit Breaker, Probe Connection, Control 
Panel Up/Down, Touch Panel, Whizz Label, Multi-Touch, 
Simplified Workflow

2. System Settings: EZ-Configuration Wizard, Enable Option 
Checks, Option key activations, Numeral key Configuration, 
User Defined key Configuration, Preset Creation, My Preset 
Archival and restore, Patient Archive and Restore, Image 
archival, My Preset Configuration, Backup/Restore the 
Patient Preset, System Software Update, Standby Mode, 
Software Version, Cyber Security

3. Peripheral Connection: Back Panel Ports, Wired 
Connectivity, Wireless Connectivity, Bluetooth Connectivity, 
Thermal Printer Connection, Network printer connection, 
DICOM Worklist Setting, DICOM Image Storage

4. MaIntenance: Contact GE service, Connect to Insite, Log 
export, Isolation USB connection, Trackball Cleaning, Air 
Filter Replacement, AN Key Film, Keycaps, Probe And Gel 
holder, Gel warmer

5. New Feature: TI-RADS® ACR, LI-RADS® ACR, e-Delivery, 
EZ Setting Restore
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Overview(continued)

Figure 4-49. Interface Illustration

The interface of the My Trainer includes below information:

1. The product name of the system.
2. Sections. Select the button to expand the section to show 

the list of subsections.
3. Subsections.
4. The highlighted subsection shows this subsection is 

currently opened and displayed on the right side.
5. Exit. Press this button to exit this interface.
6. The left number shows the current page of the subsection. 

The right number shows the total pages of the subsection.
7. Illustration with graphic.
8. Previous, Next Home, End icons.

9. Step Description.

Table 4-7:  Page turning

Select the arrow to go to the previous page.

Select the arrow to move to the next page.

Select the arrow to go to the home page.

Select the arrow to go to the end page.
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Chapter 5

Components and Functions
(Theory)

This chapter explains Versana BalanceTM/Versana 
BalanceTM Vet’s system concepts, component 
arrangement, and subsystem functions. 

It also describes the power distribution and the 
Common Service Desktop interface.
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Overview

Contents in this chapter

• ‘Overview’ on page 5-2
• ‘Block Diagram and Theory’ on page 5-3
• ‘Common Service Desktop’ on page 5-5
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Block Diagram and Theory

General Information

Versana BalanceTM/Versana BalanceTM Vet is an 
ultrasound imaging scanner.

The system can be used for:

• 2D Gray Scale 
• 2D Color Flow imaging
• M-Mode Gray Scale imaging
• Color M-Mode
• Doppler
• Different combinations of the above

Signal flow from the Probe Connector Panel to the Front End, to 
the Mid Processors and Back End Processor and finally to the 
monitor and peripherals.

System configuration is stored on a hard disk drive and all 
necessary software is loaded from the hard disk drive on power 
up.
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Block Diagram

System Diagram

 Figure 5-1. Versana BalanceTM/Versana BalanceTM Vet System Block Diagram

System Diagram Introduction

The system is composed with top modules, Internal cage and 
power box which is located at the bottom side of the machine.

The top modules include Keyboard, Speaker, 21.5 inch Monitor 
and optional peripherals (AC/DC printer, ECG, DVD, Gel warmer 
and Touch panel).

The Internal cage has 4 PWAs: CWI, MST, RLY board and 
CWD( optional). System FANs are assembled in the Box.  
IODKG board is fixed on the mechanical frame, this is the power 
and I/O signals connection of Internal cage. 
4D module is mounted on Internal cage.

The power box includes power switch and ACDC module which 
provides DC19V power to system. 
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Common Service Desktop

Introduction

The Service Desktop is an interface that provides access to 
system information, status and diagnostics.

The Service Desktop has different content or views depending 
on the access level. The access level is determined by the user 
profile as well as the service options enabled on the Versana 
BalanceTM/Versana BalanceTM Vet.

• Basic view is the standard view, restricted only by the user 
through the user profile settings. Administrator default user 
has access to the Service Desktop. Any user with "local 
Service access" in their user profile can have access to this 
view.

• Class C view is the view enabled by the service options 
purchased.

• Service Advanced
• Service Expert (requires Service Advanced)
• Service Pro (requires Service Advanced)
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Chapter 6

Service Adjustments

This chapter describes how to test and make 
adjustments to the Versana BalanceTM/Versana 
BalanceTM Vet. You can use these to test the system 
for errors. 
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Overview

Contents in this chapter

• ‘Overview’ on page 6-2
• ‘Preset Region’ on page 6-3
• ‘Monitor Adjustments’ on page 6-6
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Preset Region

Only factory default presets are supported. User is allowed to 
select region presets according to where the system is used with 
service support.

Table 6-1:  Preset Region

Region Preset Region

USA, Canda and Latin America USA_LA Preset

Europe EU Preset

China China Preset

APAC Asia Preset

South Asia India Preset

Middle East, Africa and other countries EAGM Preset
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Region presetting procedure

The Region Presetting procedure:

• In Utility--> System--> General, select the correct region 
from Preset Region (restart needed), refer to Figure 6-1 on 
page 6-4.

Figure 6-1. Region Preset

• The window below will display after the region being 
selected. Select "Ok", refer to Figure 6-2 on page 6-4.

Figure 6-2. Quesiton
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Region presetting procedure(continued)

• After "Ok" is selected, the window below will display. Select 
"Ok" and then restart the system.

Figure 6-3. Restart the system
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Monitor Adjustments

Purpose of this section

This section describes how to test and adjust the scanner. 
These tests are optional. You may use them to check the 
system for errors.

Monitor Adjustments

Please refer to User Manual for how to adjust the Monitor 
Position, Brightness and Contrast.

To adjust the brightness and volume:

1. On the alphanumeric keyboard,
• adjust brightness with Fn +Up/Down keys;
• adjust volume with Fn +Left/Right keys.

Figure 6-4. Monitor Adjustment
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Brightness and Contrast

1. Press Cursor key on the control panel. Move the trackball to 
position the cursor over the adjustment icon, then press Set 
to display the setting menu.

Figure 6-5. Setting Menu Icon

2. Follow the procedure below to adjust the Color 
Temperature, Contrast, Brightness and LED Light:
• To adjust the color temperature: press Standard, 

Brown, or Blue to choose the color temperature. The 
chosen color temperature displays in the Color Temp 
area.

Figure 6-6. Color Temperature

• To adjust the Contrast: Press Set to choose the 
adjustment button, hold down the Set key and move the 
trackball to move the adjustment button. Move the 
adjustment button to the left to decrease the  contrast or 
move the adjustment button to the right to increase the 
contrast.

Figure 6-7. Contrast
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Brightness and Contrast(continued)

• To adjust the Brightness: Press Set to choose the 
adjustment button, hold down the Set key and move the 
trackball to move the adjustment button. Move the 
adjustment button to the left to decrease the brightness 
or move the adjustment button to the right to increase 
the brightness.

Figure 6-8. Brightness

• To adjust the LED Light (at the bottom of the Monitor): 
Press Set to choose the adjustment button, hold down 
the Set key and move the trackball to move the 
adjustment button. Move the adjustment button to the 
left to decrease the LED brightness or move the 
adjustment button to the right to increase the LED 
brightness.

Figure 6-9. LED Brightness

3. Press Reset to return to the default setting; Press Exit to 
exit the setting menu.

NOTE: Press Reset button and the three color temperature settings 
will return to the default settings.
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Chapter 7

Diagnostics/Troubleshooting

This chapter describes how to setup Versana 
BalanceTM/Versana BalanceTM Vet and run the tools 
and software that help maintain image quality and 
system operation. Very basic host, system and board 
levels are run whenever power is applied. Some 
Service Tools may be run at the application level. 
However most software tests are required.
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Overview

Contents in this chapter

• ‘Overview’ on page 7-2
• ‘Gathering Trouble Data’ on page 7-3
• ‘Screen Capture’ on page 7-5
• ‘System Warning/Error and Logs’ on page 7-11
• ‘Common Service Desktop’ on page 7-14
• ‘Network and Common Diagnostics’ on page 7-80
• ‘Troubleshooting’ on page 7-102
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Gathering Trouble Data

Overview

There may be a time when it would be advantageous to capture 
trouble images and system data (logs) for acquisition to be sent 
back to the manufacturer for analysis. There are different 
options to acquire this data that would give different results.

Collect Vital System Information

The following information is necessary in order to properly 
analyze data or images being reported as a malfunction or being 
returned to the manufacturer:

Product Name = Versana BalanceTM/Versana BalanceTM 
Vet

From the Utility>System>About screen:

Applications Software

• Software Version
• Software Part Number

System Image Software

• Image Date
• Image Part Number

Additional Information
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Collect a Trouble Image with Logs

If the system should malfunction, press the Alt+D keys 
simultaneously. This will collect a screen capture of the image 
monitor, system presets and several log files in a date and time 
stamped “.zip” file.

NOTE: This function may also be used to make a Print Screen.

This Alt+D function is available at all times.

When Alt+D is pressed, a menu box appears that allows for:

• a place to enter a description of the issue
• a checkbox to indicate a System lockup
• a choice to Export a pre-formated CD-R/DVD-R or save to 

the Export directory D: drive (for remote viewing through 
FFA)

Figure 7-1. Alt+D Dialog Box
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Screen Capture

There may be times when the customer or field engineer will 
want to capture a presentation on the screen. This is 
accomplished by first saving the image(s) to the clipboard using 
a Print Key. 
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Capturing a Screen

Set the P1 key to screen capture:

1. Press Utility -> Connectivity -> Button.
2. Select Print1. Then select Copy to Dataflow and press >> 

button to add it to Printflow View, press Save. Now when 
you press the P1 key, the image will be saved to the 
clipboard.

The following is a generic process to capture any screen from 
the scanner:

1. Navigate to and display the image/screen to be captured.
2. Press P1 key. This will place a snapshot of the screen on 

the “clipboard” displayed at the left side of the scan image 
display.

 Figure 7-2. Select Image to Capture

3. Select and highlight the snapshot to be stored.
4. Select Save As Icon on the lower left of the image screen.

Figure 7-3. Menu > Save As
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Capturing a Screen(continued)

5. A Save dialog box will be opened. Choose the archive 
location to save image on the USB Drive or CD/DVD.

Figure 7-4. Save Dialog Box

NOTE: Click Save -> Transfer To CD/DVD, if the archive location is  
DVD/CD; Click Save, if the archive location is USB.

NOTE: It is better to save the image in Jpeg format. Image of this 
format can be easily reviewed in the computer.
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Capturing a Screen with Service Key

The following is a generic process to capture the whole screen 
(including the Touch Panel screen if needed) from the scanner:

1. Insert the Service Key in the system’s USB port.
2. Press Prtsc key on the control panel, the whole screen is 

captured.
3. Press Ctrl+Alt+Delete, the Start Task Manager dialog is 

displayed.
NOTE: It is also available to Exit to Windows and save the image on 

the system or removal media. For how to Exit to Windows, 
please refer to Proprietary Service Manual.

4. In Windows Task Manager, select File-> New Task 
(Run...).

Figure 7-5. Windows Task Manager

5. Type in the program name: mspaint.

Figure 7-6. Create New Task
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Capturing a Screen with Service Key(continued)

6. The paint screen is displayed, press Ctrl+V to paste the 
captured screen. And then save the image in the 
appropriate destination.

 Figure 7-7. Save Image
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Capturing a Screen by physical print buttons

The following is a generic process to capture the whole screen 
(not including the Touch Panel screen) from the scanner:

1. Press Utility -> Connectivity -> Button to configure 
Physical Print Buttons for the button to capture screens.

2. Select any key from Print1, Print2 or Print3 from Physical 
Print Buttons.

3. Select Secondary Capture Screen from Format.
4. Select USB Quick Save, press >> to move to right column. 

Press Save and Exit.

 Figure 7-8. Windows Task Manager

5. After Print key configuration complete, press the configured 
Print key, the captured screen will be saved to the USB 
directly. 
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System Warning/Error and Logs

Temperature warning

Figure 7-9. Temperature Warning

• Cause: CPU temperature exceeds threshold (95 degrees)
• What to do: shut down the system and clean the filter.

Temperature exceeds threshold

Figure 7-10. Temperature exceeds threshold

• Cause: CPU temperature exceeds threshold (100 degrees) 
and therefore, system must be shutdown immediately.

• What to do: shut down the system and clean the filter.
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System voltage failure

Figure 7-11. System voltage failure

• Cause: Hardware and/or voltage error detected.
• What to do

1. Press OK and reboot the system.
2. if the problem persists, shut down the system, turn OFF the 

Supply Mains Switch and then reboot the system.

Hardware configuration error

Figure 7-12. Hardware configuration error

• Cause: Hardware(s) is not detected as valid system. 
System is able to boot up but not able to scan.

• What to do

1. Press OK and reboot the system.
2. If the problem persists, shut down the system, turn OFF the 

Supply Mains Switch and then reboot the system.
3. if the problem persists, shut down the system and analyze 

the log files in Technical Support Mode.
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System error

Figure 7-13. System error

• Cause: Hardware(s) is not detected as valid system. 
System is able to boot up but not able to scan.

• What to do

1. Press OK, turn off the system and then reboot it.
2. If the problem persists, shut down the system and analyze 

the log files.
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Common Service Desktop

Purpose of this section

This section describes the features of the Service desktop. 
These are the different levels of access to the Service desktop:

• Service Basic access (Class A) - a user locally logged into 
the machine with Local Service Access privilege. This level 
provides limited access to Service desktop widgets and 
utilities.

• Service Expert, Pro, and Advanced access (Class C) Local - 
Depending on the purchase level,includes an option string 
to control access.

• GE Service access (Class M) and an SSA key. For users 
with local Service Access privileges, this level provides 
unrestricted access to all Service desktop widgets and 
utilities.

• Remote access - a user remotely accessing the Versana 
BalanceTM/Versana BalanceTM Vet. This level provides 
unrestricted access to all Service desktop widgets and 
utilities. Disruptive mode is limited to the user access 
privileges to Remote Service Access.
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Disruptive mode

Disruptive mode is a way to control interruptions to operation of 
the Versana Balance. Disruptive mode is required whenever 
service performs a function that may disrupt a normal scan. 
Activating Disruptive mode results in a red message displayed 
on the task bar. This message indicates that the Versana 
Balance needs to be restarted once the service activity is 
complete. The message remains until the Versana BalanceTM/
Versana BalanceTM Vet is restarted. This prevents patient 
scanning while the Versana BalanceTM/Versana BalanceTM 
Vet is not operating at an optimal status. For example, running a 
diagnostic may leave the Versana Balance. in a state that is not 
good for imaging.

Specifically, Disruptive mode is required to run diagnostics, 
clean presets, and reset the patient database, and turn on 
Virtual Console Observation (VCO).

• When Disruptive mode is On, all service functionality on the 
Service desktop is allowed but user operation of the 
Versana Balance may be limited.

• When Disruptive mode is Off, some service functionality on 
the Service desktop is not available and user operation of 
the Versana Balance is normal.

Additionally, the ability to enable Disruptive mode depends on 
the logged in user.

• Local user - a user locally logged into the machine will be 
able to set the Versana Balance to Disruptive mode or allow 
a Disruptive mode request from a remote user through the 
Service desktop. The local user must have Authorize 
Remote Service Access to allow Disruptive mode. If the 
local user does not have this right, the remote user’s 
request will be automatically denied

• Remote user - a user remotely accessing the Versana 
BalanceTM/Versana BalanceTM Vet will not be able to 
automatically switch Disruptive mode to On. The logged in 
user (user actually logged on to the Versana Balance) 
needs to have the ability to grant remote access. The 
logged in user will be notified through a dialog box and 
asked to allow Disruptive mode.

NOTE: Change Password and Disk Defragment are not available 
for the remote user whether Disruptive mode is On or Off.

For more information, see:‘Disruptive mode’ on page 7-15
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Color statuses
Throughout the Service desktop, colors indicate the following:

• Green - Status is normal
• Orange - Status is a warning
• Red - Status is an error

Licenses
With Service Basic Access (Class A), these are the available 
options:

• HOME
• Utilities

• Change Password
• Data Transfer
• Delete Files
• Gather Logs
• Network Capture
• SSA License
• Thirty Party Licenses

• Options
• Agent Configuration

With Service Advanced (Class C), these are the available 
options:

NOTE: With a Class C license, options display according to these 
purchased level of access.

• HOME
• Diags

• Run Diags
• Diag History

• Utilities
• Change Password
• Checkpoints
• Delete Files
• Disk Defragment
• Data Transfer
• Gather Logs
• Network Capture
• SSA License
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Licenses(continued)

• System Shutdown
• Thirty Party Licenses

• Options
• Agent Configuration

With Service Advanced plus Service Expert (Class C), the Clean 
Userdefs, Reset Patient Database,and Software Reload utilities 
are added to the Service Advanced options listed.

With Service Advanced and Service Expert plus Service PRO 
(Class C), the probe assessment tool (ePAT) diagnostic is 
added to the Service Advanced and Service Expert options 
listed.

With GE Service access (Class M) and an SSA key, these are 
the available options:

• HOME
• Diags

• Run Diags
• Diag History

• Utilities
• Change Password (not available through a remote 

connection)
• Checkpoints
• Clean Userdefs
• Data Transfer
• Delete Files
• Disk Defragment (not available through a remote 

connection)
• Disruptive Mode Utility
• Gather Logs
• Network Capture
• Reset Patient Database
• Software Reload
• SSA License
• SSH
• Thirty Party Licenses
• Virtual Console Observation

• Options
• Agent Configuration
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Licenses(continued)

If CSD is not responding to Service Class C or Class M key, try 
to restart SSA service program manually:

1. Press Ctrl+Shift+Esc to activate “Task Manager”;
2. Go to “Services” tab, select and right click the 

“SSAWrapperService”;

3. Click “Restart” to restart the service.

Figure 7-14. Restart SSA
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Home

Home configurations vary depending upon the purchased 
service level.

 Figure 7-15. Home with Class C and Class M Access

For more information, see:

• ‘System Information’ on page 7-20
• ‘Software Status’ on page 7-22
• ‘System Status’ on page 7-23
• ‘Disk Drive Space’ on page 7-32
• ‘Network Configuration’ on page 7-34
• ‘Connected Probes’ on page 7-36
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System Information

System Information displays general information about the 
Versana Balance. When the Versana Balance has been 
successfully configured with the back office, these elements will 
have the corresponding values:

• Agent Registered will be Yes
• Agent Quarantine will be No
• Agent CRM Verified will be Yes

The information on System Information is available to all 
service class licenses.

To access System Information, navigate to Utility > Service > 
Home.

Figure 7-16. System Information
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System Information(continued)

This table shows all the elements available on System 
Information with descriptions.

For more information, see:‘Home’ on page 7-19

Table 7-1:  System Information

Element DESCRIPTION

CRM Number Customer Relationship Management (CRM) number. System 
identifier assigned to the customer unit by the region service team.

Agent Registered Registered status of the agent. Valid values are:
• Yes - The agent is registered in the back office.
• No - The agent is not registered in the back office.
• Not Available - The agent is not running or has not been configured.

Agent Quarantine Quarantine status of the agent. Valid values are:
•  Yes - The agent has more than one device registered with the same 

CRM Number in the back office.
• No - The agent has one device registered with the listed CRM Num-

ber in the back office.
• Not Available - The agent is not running or has not been configured.

Agent CRM Verified CRM verified status of the agent. Valid values are:
•  Yes - The agent is verified in the back office.
• No - The agent is not verified in the back office.
• Not Available - The agent is not running or has not been configured.

Model Number GE part number for the Versana Balance. The same number as listed 
on the rating plate.

Serial Number Serial number of the Versana Balance. The same number as listed on 
the rating plate.

System Type Product name of the Versana Balance.

Facility Name of the hospital or facility where the Versana Balance is installed
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Software Status
Use Software Status to view general information about the 
software installed on the Versana Balance.
The information on Software Status is available to all service 
class licenses.
To access Software Status, navigate to Utility > Service > 
Home.

Figure 7-17. Software Status
This table shows all the elements available on Software Status 
with descriptions.

For more information, see:
• ‘Home’ on page 7-19
• ‘Software Reload’ on page 7-56

Table 7-2:  Software Status

Element DESCRIPTION

System Date Current date in the format <day>, <month> <date> <year>.

System Time Local time based on the last time the system desktop was 
refreshed in the format <hh:mm:ss>.

Application Installation Date Date the application software was built. The application software 
includes the Versana Balanceproduct-specific software.

Base Image Installation Date Date the base image software was built. The base image software 
includes the Windows operating system and other supporting 
software.

Base Image Version Version number of the base image software

Application Software Version Version number of the application software

Application Status Status of the application. Valid values are
• Running
• Stopped
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System Status

Use System Status to view status information on the Versana 
Balance. Specifically, do the following:

• View the hardware configuration file
• View temperatures for FRUs, fans, and a graphical 

representation of the monitored temperatures
• View voltages for FRUs and AC
• View the amount of time the Versana Balance has been 

running
• View the amount of time since the Versana Balance has last 

been rebooted

The information on System Status is available to Class C and 
Class M licenses.

To access System Status, navigate to Utility > Service > Home.

Figure 7-18. System Status
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System Status(continued)

This table shows all the elements available on System Status 
with descriptions.

Table 7-3:  System Status

Element DESCRIPTION

Hardware Configuration Displays the contents of the hardware configuration file.

Temperature Displays the temperature monitoring of the Versana Balance as normal, 
warning, or error using the standard colors and icons. Includes temperature 
out-of-spec events including an overall count of event warnings and errors for 
the last 30 days or the last status checkpoint whichever is sooner. Temperature 
displays temperature a graph for the configured monitoring points.

Voltage Displays the voltage monitoring of the Versana Balance as normal, warning or 
error using the standard colors and icons. Includes voltage out-of-spec events 
including an overall count of the event warnings and errors for the last 30 days 
or last status checkpoint whichever is sooner.

System On Time Displays the time the Versana Balance was turned on.

Time Since Last Reboot Displays the time the Versana Balance was last rebooted.
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Hardware Configuration

Hardware Configuration displays the contents of the hardware 
configuration file which includes all the vital product data (VPD).

To access Hardware Configuration, navigate to Utility > 
Service > Home, and then under System Status, select 
Hardware Configuration.

 Figure 7-19. Hardware Configuration

This table shows all the elements available on Hardware 
Configuration with descriptions.

For more information, see:

• ‘System Status’ on page 7-23
• ‘Home’ on page 7-19

Table 7-4:  Hardware Configuration

Element DESCRIPTION

Component Hardware component.

Item Parameter with the vital product data (VPD).

Value Actual value of the Item.
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Temperature

Use Temperature to troubleshoot problems with monitored 
FRUs and the fans. Specifically, use these pages:

• FRU Status
• Graphs

To access Temperature, navigate to Utility > Service > Home, 
and then under System Status, select Temperature.

For more information, see:

• ‘FRU Status’ on page 7-27
• ‘Graphs’ on page 7-28
• ‘System Status’ on page 7-23
• ‘Home’ on page 7-19
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FRU Status
FRU Status displays a summary of the FRUs being monitored 
and the details for each FRU.
To access this page, under System Status, select Temperature 
and then select FRU Status.

 Figure 7-20. FRU Status
This table shows all the elements available on FRU Status with 
descriptions.

For more information, see:

• ‘Temperature’ on page 7-26
• ‘Home’ on page 7-19

Table 7-5:  FRU Status

Element DESCRIPTION

FRU Status Summary Number of the FRUs being monitored.

FRU Status Details

Name Name of the FRU.
• ETX3 - Represents the ETX 64 transmitter board.
• ETX4 - Represents the ETX 128 transmitter board.

Status Status of the FRU. Valid values are:
• Normal - Indicates that the FRU is operating within the allowable range.
• Warning - Indicates that the FRU is operating close to the limit of the allow-

able range.
• Error - Indicates that the FRU is operating outside the allowable range.

Low Level Warning Number of low temperature warnings.

High Level Warning Number of high temperature warnings.

Low Level Errors Number of low temperature errors.

High Level Errors Number of high temperature errors.
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Graphs

Graphs displays trend graphs for selected elements which have 
been selected as key indicators of overall temperature status 
inside the card rack.

To access this page, under System Status, select Temperature 
and then select Graphs.

 Figure 7-21. Graphs

For more information, see:

• ‘Temperature’ on page 7-26
• ‘Home’ on page 7-19
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Voltage

Use Voltage to troubleshoot problems with monitored FRUs and 
the AC voltage of the Versana Balance.

Specifically, use these pages:

• FRU Status
• AC Voltage

To access Voltage, navigate to Utility > Service > Home, and 
then under System Status, select Voltage.

For more information, see:

• ‘FRU Status’ on page 7-27
• ‘AC Voltage’ on page 7-31
• ‘System Status’ on page 7-23
• ‘Home’ on page 7-19
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FRU Status

FRU Status displays a summary of the voltages for the FRUs 
being monitored and the details for each FRU.

To access this page, under System Status, select Voltage and 
then select FRU Status.

 Figure 7-22. FRU Status

This table shows all the elements available on FRU Status with 
descriptions.

For more information, see:

• ‘Voltage’ on page 7-29
• ‘Home’ on page 7-19

Table 7-6:  FRU Status

Element DESCRIPTION

Name Name of the FRU.

Status Status of the voltage for the FRU. Valid values are:
• Normal - Indicates that the fan is  within the allowable range.
• Warning - Indicates that the voltage is close to the limit of the 

allowable range.
• Error - Indicates that the voltage is outside the allowable range.

Lower Limit Warnings Number of low limit voltage warnings.

Upper Limit Warnings Number of high limit voltage warnings

Lower Limit Errors Number of low limit voltage errors

Upper Limit Errors Number of high limit voltage errors
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AC Voltage

AC Voltage graphically displays the voltage input over a period 
of time to help identify instabilities,or fault conditions, over time.

To access this page, under System Status, select Voltage and 
then select AC Voltage.

 Figure 7-23. AC Voltage

For more information, see:

• ‘Voltage’ on page 7-29
• ‘Home’ on page 7-19
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Disk Drive Space

Use Disk Drive Space to view the hard drive partitions including 
total size and available free space in GB. Includes the overall 
health of the drive in one of these colors:

• Red - Available free space is less than 10% of the total size.
• Orange - Available free space is more than 10% and less 

than 20% of the total size.
• Green - Available free space is more than 20% of the total 

size.

The information on Disk Drive Space is available to Class C 
and Class M licenses.

To access Disk Drive Space, navigate to Utility > Service > 
Home.

Figure 7-24. Disk Drive Space
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Disk Drive Space(continued)

This table shows all the elements available on Disk Drive 
Space with descriptions.

For more information, see:

• ‘Home’ on page 7-19

Table 7-7:  Disk Drive Space

Element DESCRIPTION

C: Drive C: partition shows the graphical representation of the following:
• Used space in GB
• Available free space in GB

D: Drive D: partition shows the graphical representation of the following:
• Service
• Logs.
• Temp
• Export
• Service configuration
• Misc
• Available free space in GB

E: Drive E: partition shows the graphical representation of the following:
• Printer spooler
• Clipboard
• Dicom spooler
• Misc
• Available free space in GB

F: Drive F: partition shows the graphical representation of the following:
• Serial Number
• Available free space in MB

Z: Drive Z: partition shows the graphical representation of the following:
• Package repository
• Misc
• Available free space in GB
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Network Configuration

Use Network Configuration to view network (wired and 
wireless) information (the full ipconfig details)for the network 
configured with the Versana Balance.

The information on Network Configuration is available to Class 
C and Class M licenses.

To access Network Configuration, navigate to Utility > 
Service > Home.

Figure 7-25. Network Configuration

Figure 7-26. Network Configuration with More Details
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Network Configuration(continued)

This table shows all the elements available on Network 
Configuration with descriptions.

For more information, see:

• ‘Home’ on page 7-19

Table 7-8:  Network Configuration

Element DESCRIPTION

Host Name Name of the local host for the Versana Balance.

More Details Displays the ipconfig details

Wired Connection

lpV4 Address Local IP address for the wired network connection.

lpV6 Address Local IP address for the wired network connection.

Subnet Mask Local subnet mask for the wired network.

Default Gateway Default gateway for the wired network.

MAC Address Address for the MAC for the wired network.

Speed (Mbps) Speed of the wireless connection.

Wireless Connection

IP Address IP address for the wireless network connection.

Subnet Mask Subnet mask for the wireless connection.

Default Gateway Default gateway for the wireless connection.

MAC Address Address for the MAC for the wireless connection.

Speed (Mbps) Speed of the wireless connection

Status Current status of the wireless connection.
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Connected Probes

Connected Probes shows probes connected to the Versana 
Balance. The order on the user interface is top down matching 
the left-to-right order on the Versana Balance.

The information on Connected Probes is available to all service 
class licenses.

To access Connected Probes, navigate to Utility > Service > 
Home.

Figure 7-27. Connected Probes

This table shows all the elements available on Connected 
Probes with descriptions.

For more information, see:‘Home’ on page 7-19

Table 7-9:  Connected Probes

Element DESCRIPTION

Active Probe Temperature (Celsius) When available, temperature of the active probe.
Not all probes report temperature. The most common probe 
to report temperature is the TEE probe.

Probe Name Name of the probe connected to the Versana Balance.

Probe ID Identifier of the probe connected to the Versana Balance.

Status Statuses of the probe connected to the Versana Balance. 
Valid values are:
• Active
• Non Active
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Diags

Use Diags to troubleshoot functionality with hardware 
components. With an active Service PRO license, probe 
diagnostics will be available. Specifically, use these pages:

• Run Diags - Run diagnostics on hardware components.
• Diag History - View a history of the diagnostics you have 

run and the results.

NOTE: Reboot the system after performing any diagnostics before 
returning the Versana Balance to customer use.

For more information, see:

• ‘Run Diags’ on page 7-38
• ‘Diags History’ on page 7-41
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Run Diags
With Disruptive mode set to On, use Run Diags to run 
diagnostics on hardware components with the                         
Versana Balance. For information on disruptive mode, see 
‘Disruptive mode’ on page 7-15.

The information on Run Diags is available to Class C and Class 
M licenses.

To access Run Diags, navigate to Utility > Service > Diags > 
Run Diags.

 Figure 7-28. Run Diags(1)

This table shows all the elements available on Run Diags with 
descriptions.

Table 7-10:  Run Diags

Element DESCRIPTION

Menu Available service diagnostics in a diagnostics tree.

Selected Diagnostics Diagnostics that have been selected.

Diagnostic Detail

Maximum Execution Time Maximum amount of time allowed to run the diagnostic.

Instruction Instruction Special instructions needed in order to perform 
the diagnostic.

Diagnostic Controls
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To run a diagnostic:

1. Navigate to Utility (second page) > Service > Utilities > 
Disruptive Mode Utility and set Disruptive mode to On.

2. Navigate to Utility (second page) > Service > Diags > 
Run Diags.

3. From the Service Menu tab, select the diagnostic (for 
example, GRLY with Probes). The Selected Diagnostics  
and Diagnostic Detail areas populate with information 
specific to the selected diagnostic.

4. In Execution Mode, select the desired mode.
5. In Loop Count, select the number of times to run the 

diagnostic.

Execution Mode Way the diagnostic behaves when a failure occurs. Valid 
values are:
• Continue on Failure
• Finish Loop and Stop on Failure
• Stop on Failure

Loop Count Number of times to run the selected diagnostic.

Start Starts the selected diagnostic.

Stop Stops the selected diagnostic.

Reset Resets the selections within the diagnostics tree.

Total Progress

Current Progress Progress the current diagnostic.

Total Progress Progress for all of the selected diagnostics.

Diagnostic Results Summary

Diag Name Name of the diagnostic.

Date/Time Date and time of the diagnostic run.

Diag Run Time Amount of time taken to run the diagnostic.

Overall Status Current status of the diagnostic.

Pass/Fail Whether the selected diagnostic passed or failed.
• Green - Diagnostic passed
• Red - Diagnostic failed

Table 7-10:  Run Diags
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Run Diags(continued)

6. Click Start.

 Figure 7-29. Run Diags(2)

7. View progress in the Total Progress area.
8. View the results (Passed or Failed) in the Diagnostic 

Results Summary area.

Figure 7-30. Results Summary

9. To view details about the diagnostics run, see.
For more information, see:

• ‘Diags’ on page 7-37
• ‘Diags History’ on page 7-41
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Diags History
Use Diags History to view a history of the diagnostics run on 
the Versana Balance and the results.

The information on Diags History is available to Class C and 
Class M licenses.

To access Diags History, navigate to Utility > Service > Diags 
> Diags History.

 Figure 7-31. Diags History

This table shows all the elements available on Diags History 
with descriptions.

Table 7-11:  Diag History

Element DESCRIPTION

Checkpoints

Select All Selects all of the available checkpoints in the list.

Controls

All Filters results to show all of the diagnostics.

Failed Filters results to show failed diagnostics.

Get History Select to display a history of the run diagnostics.

Runs

List of diagnostics run on the Versana Balance.

Diagnostic Results History

Details about the diagnostics run.
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Diags History(continued)

To view a history of diagnostics:

1. Navigate to Utility (second page) > Service > Diags > 
Diag History.

2. Select the options that you want to view.
3. Click Get History.
4. View the results of your query.
• To view specific details, click Details.

 Figure 7-32. Details

For more information, see:

• ‘Diags’ on page 7-37
• ‘Diags History’ on page 7-41
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Utilities

Utilities configurations vary depending upon the service class.

For more information, see:

• ‘Change Password for Auto File Transfer’ on page 7-54
• ‘Checkpoints’ on page 7-68
• ‘Clean Userdefs’ on page 7-61
• ‘Delete Files’ on page 7-48
• ‘Disk Defragment’ on page 7-44
• ‘Disruptive Mode’ on page 7-70
• ‘Gather Logs’ on page 7-46
• ‘Network Capture’ on page 7-73
• ‘Reset Patient Database’ on page 7-59
• ‘SSA License’ on page 7-64
• ‘SSA License’ on page 7-64
• ‘Software Reload’ on page 7-56
• ‘System Shutdown’ on page 7-66
• ‘Third Party Software Licenses’ on page 7-63
• ‘Virtual Console Observation’ on page 7-51
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Disk Defragment
Disk Defragment provides a way to launch the Windows Disk 
Defragmenter tool to use to defragment the disks. Disk 
fragmentation can reduce the amount of disk space available, 
and slow computing speed. Use the disk defragmenter to 
restore optimum disk space and speed performance. If Versana 
Balance performance would be significantly reduced when the 
disk is being defragmented, a warning message displays. It is 
not possible to analyze the SSH drives.

The information on Disk Defragment is available to Class C 
(Service Advanced and Service Expert)and Class M licenses. 
Disk Defragment is not available through a remote connection.

To access Disk Defragment, select Utility (second page) > 
Service > Utilities > Disk Defragment.

Figure 7-33. Disk Defragment

To analyze, optimize, or schedule optimization for a disk:

1. Navigate to Utility (second page) > Service > Utilities > 
Disk Defragment.

2. Click Launch Disk Defragmenter.
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Disk Defragment(continued)

3. In the Optimize Drives dialog box, select the drive.

Figure 7-34. Optimized Drives

4. To analyze the selected drive, click Analyze.
5. To optimize the selected drive, click Optimize.
6. To set up a schedule, click Change settings and select the 

schedule
For more information, see:

• ‘Utilities’ on page 7-43
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Gather Logs
Gather Logs provides a way to collect system logs and place 
the log files in the D:\Service directory for retrieval by the online 
center. These log files do not include protected data such as 
crash dumps and keyboard shadow logs. The customer can 
collect logs (including protected data) using Alt+D when 
Protected Data is checked. Log files are compressed into a .zip 
file and the file path and name display.If the application software 
is not running, use the Gather Logs shortcut on the Windows 
desktop.

The information on Gather Logs is available to all service class 
licenses.

To access Gather Logs, select Utility (second page) > 
Service > Utilities > Gather Logs.

 Figure 7-35. Gather Logs

This table shows all the elements available on Gather Logs with 
descriptions.

Table 7-12:  Gather Logs

Element DESCRIPTION

1 Day Logs When selected, gathers log files for one day.

1 Week Logs When selected, gathers log files for one week.

Complete Logs When selected, gathers all available log files.

Service Logs When selected, gathers service log files.
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Gather Logs(continued)

To gather log files:

1. Navigate to select Utility (second page) > Service > 
Utilities > Gather Logs.

2. Select one of the following:
• 1 Day Logs
• 1 Week Logs
• Complete Logs
• Service Logs

3. Click Gather Logs. In the resulting dialog box, record the 
location of the log files and click OK.

• When the gather log operation is complete, click the 
notification icon in the banner to view the location of the log 
files.

For more information, see:

• ‘Utilities’ on page 7-43
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Delete Files
Delete Files displays all the files and folders present in the 
D:\Service folder and allows for their deletion. Deleting 
unneeded files improves performance and reduces the need to 
defragment the disk drive.

The information on Delete Files is available to all service class 
licenses.

To access Delete Files,  select Utility (second page) > Service 
> Utilities > Delete Files.

 Figure 7-36. Delete Files

This table shows all the elements available on Delete Files with 
descriptions

To delete files:

1. Navigate to select Utility (second page) > Service > 
Utilities > Delete Files.

2. Under Delete Files, select the available folders and files 
that you want to delete.

3. Click Delete. 
4. In the resulting dialog box, click Delete and then click OK.
For more information, see:

• ‘Utilities’ on page 7-43

Table 7-13:  Delete Files

Element DESCRIPTION

Delete Files Displays the files that are available for deletion.

Delete Deletes the selected files.



Common Service Desktop

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 7-49
5866796-100 English Rev.12

Data Transfer
Data Transfer provides a way to do the following:

• View information about past transfers of (APM) information.
• Set up automatic/scheduled transfer of allowed data files 

from the Versana Balance to the server.
• Manually transfer allowed data files from the Versana 

Balance to the server.

The information on Data Transfer is available to all service 
class licenses.

To access Delete Files,  select Utility (second page) > Service 
> Utilities > Data Transfer.

 Figure 7-37. Data Transfer

This table shows all the elements available on Data Transfer 
with descriptions

Table 7-14:  Data Transfer

Element DESCRIPTION

Type of Upload Type of log file. For example, Incremental Logs or Full Logs. 
Monitoring Logs,
System Logs, and Windows Logs are incrementally transferred 
when automatic
transfer is enabled. To enable automatic transfer, navigate to 
System Admin and,
under Service, check Enable Automatic Request for Service.

Upload Permission Whether the permission to upload the log file is allowed or not.

Last Upload Status Whether the last log file upload was successful or not.

Last Upload Attempt Date and time the last log file upload was attempted.

Last Successful Upload Date and time the last log file was successfully uploaded.
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To configure automatic data transfers (Auto File Transfer / 
AFT):

1. Navigate to Utility (second page) > Service > Utilities > 
Data Transfer.

2. On Data Transfer, select Scheduler, and then select the 
days to perform the data transfer.

3. Click Save Settings
4. To manually perform a data transfer, click Send All.

For more information, see:

• ‘Utilities’ on page 7-43

Scheduler When selected, enables the related day selections. For example, 
All Days,
Monday, and Tuesday.

Save Save the settings information.

Send All Manually send the selected log files to the server.

Table 7-14:  Data Transfer
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Virtual Console Observation
Virtual Console Observation displays the status of the VNC 
server. Virtual console observation (VCO) is normally used to 
remotely access and modify settings and programs.

The information on Virtual Console Observation is available to 
Class M licenses. Virtual Console Observation is not available 
through a remote connection.

To access Virtual Console Observation, select Utility (second 
page) > Service > Utilities > Virtual Console Observation.

Figure 7-38. Virtual Console Observation
This table shows all the elements available on Virtual Console 
Observation with descriptions.

Table 7-15:  Virtual Console Observation

Element DESCRIPTION

Status When Disruptive mode is on, displays the status of the VNC server. Valid values are:
• VCO is stopped
• VCO is running

Start When Disruptive mode is ON, starts the VNC server.

Stop When Disruptive mode is ON and the VNC server is running, stops the VNC server.



Diagnostics/Troubleshooting

7-52 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Virtual Console Observation(continued)

To start virtual console observation:

1. Navigate to Utility (second page) > Service > Utilities > 
Disruptive Mode Utility and set Disruptive mode to On.

2. Or move the trackball to         , press Set key, then select 
Disruptive and VCO from Service Menu.

Select Enable to turn on Disruptive mode and press Exit.

Figure 7-39. Select Enable

Here is the explaination for current design on “Disruptive 
mode and VCO” button function:
a. The button is designed to Enable VCO in quick way, so 

when clicking “Enable”, it will enable both “Disruptive 
mode” and “VCO” (Disruptive mode ON is the 
prerequisites for VCO ON).

b. When clicking “Disable”, it can only disable “VCO”, but 
will not disable the Disruptive mode.

c. The user has to enter CSD to disable the Disruptive 
mode if he/she wants to do that, refer to ‘Disruptive 
Mode’ on page 7-70.
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Virtual Console Observation(continued)

3. Navigate to Utility (second page) > Service > Utilities > 
Virtual Console Observation.

4. Select Start. When VCO starts, the Windows task bar and 
Windows desktop display.

5. Modify settings and programs as needed.
6. To stop virtual console observation, click Stop. When VCO 

is stopped, the Windows desktop is hidden.
7. Restart the Versana Balance.
For more information, see:

• ‘Utilities’ on page 7-43
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 Change Password for Auto File Transfer
Change Password for Auto File Transfer allows you to 
change the password for a specified user type.

The information on Change Password for AFT is available to 
all service class licenses. Change Password for AFT is not 
available through a remote connection.

To access Change Password for AFT, select Utility > Service 
> Utilities > Change Password for Auto File Transfer.

 Figure 7-40. Change Password for Auto File Transfer

This table shows all the elements available on Change 
Password for AFT with descriptions.

CAUTION IF THE PASSWORD IS LOST, GE WILL NOT BE ABLE TO 
RECOVER OR RESET IT.LOSS OF A PASSWORD MAY 
RESULT IN THE LOSS OF PATIENT DATA.

Table 7-16:  Change Password for AFT

Element DESCRIPTION

User Type Type of user for the password reset.

New Password Password.

Confirm Password Password.

Update Password Select to update the password.

Reset Select to reset the information.
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Change Password for Auto File Transfer(continued)

To change the password:

1. Navigate to select Utility > Service > Utilities > Change 
Password for Auto File Transfer.

2. Under User Type, select the user.
NOTE: Before changing the GEService password (the default is 

SvcForward123$), make sure the Versana Balance is 
connected to the network and the agent is configured. The 
GEService password is used to perform portions of remote 
service. If the password is changed and the system 
information is not updated, it may slow down remote 
service. Both file transfer and SSH depend on the 
GEService password.

3. In New Password and Confirm Password, enter the new 
password.

4. Click Update Password.
5. When a SVCService user password has been changed, 

reboot the Versana Balance to reflect the password change.
For more information, see:

• ‘Utilities’ on page 7-43

CAUTION GE WILL NOT BE ABLE TO RECOVER OR RESET 
CHANGED PASSWORDS.SECURELY RECORD THE 
NEW PASSWORD.
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Software Reload
Software Reload displays versions of the base image, 
application software, base patch, service platform, and 
documentation packages currently installed on the Versana 
Balance. Software Reload reimages the C:\ drive and installs 
the base image.

• If the drives are encrypted, Software Reload will have a 
catastrophic effect if the customer does not have the 
recovery key. All patient data will be lost.

• If the drives are not encrypted, software can be reloaded 
without a recovery key.

With Disruptive mode set to On, reload these software versions 
from repository partition on the hard drive. The software reload 
is automatic without any loss of presets, patient data, or 
connectivity settings.

The information on Software Reload is available to Class C 
(Service Expert) and Class M licenses.

To access Software Reload, select Utility > Service (second 
page) > Utilities > Software Reload.

Figure 7-41. Software Reload
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Software Reload(continued)
This table shows all the elements available on Software Reload 
with descriptions.

To reload software:

1. If the drives are encrypted, obtain the recovery key.
2. Navigate to Utility (second page) > Service > Utilities > 

Disruptive Mode Utility and set Disruptive mode to On.
3. Navigate to Utility (second page) > Service > Utilities > 

Software Reload.
4. View the current version numbers.
5. Click Software Reload.

Table 7-17:  Software Reload

Element DESCRIPTION

Base Image Version Displays the version number of the base image software.

Base Patch Version Displays the version number of the base patch.

Application Software Version Displays the version number of the application software.

Service Platform Version Displays the version number of the service platform.

Documentation Version Displays the version number for the documentation.

Software Reload Reloads the versions listed.

CAUTION RELOADING SOFTWARE WITHOUT A RECOVERY KEY 
WILL RESULT IN THE LOSS OF PATIENT DATA.
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Software Reload(continued)

6. If you have a recovery key, select I have a recovery key 
and then click Continue.

 Figure 7-42. Software Reload (1)

7. If you have a recovery key, select I Agree and then click 
Continue Reload.

 Figure 7-43. Software Reload (2)

For more information, see:

• ‘Utilities’ on page 7-43
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Reset Patient Database
Reset Patient Database resets the Versana BalanceTM/
Versana BalanceTM Vet patient database. This operation 
automatically shuts down the application before cleaning the 
patient database. Once the operation is complete, the Versana 
BalanceTM/Versana BalanceTM Vet reboots with an empty 
database. Disruptive mode must be On to reset the patient 
database. If Disruptive mode is Off, a warning message displays 
asking to turn on Disruptive mode.

Reset Patient Database deletes the contents of the following 
folders:

• E:\Scanner\GEMS_IMG
• E:\Scanner\GEMS_REP
• E:\Scanner\GEMS_DB

After deleting all the contents of the folders, the folder 
E:\Scanner\GEMS_DB will be reset to factory setup.

The information on Reset Patient Database is available to 
Class C (Service Expert) and Class M licenses.

To access Reset Patient Database, select Utility (second 
page) > Service > Utilities > Reset Patient Database.

 Figure 7-44. Reset Patient Database
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Reset Patient Database(continued)
This table shows all the elements available on Reset Patient 
Database with descriptions.

Reset Patient Database(continued)
To reset the patient database:

1. Back up the patient database.
2. Navigate to Utility (second page) > Service > Utilities > 

Disruptive Mode Utility and set Disruptive mode to On.
3. Navigate to Utility (second page) > Service > Utilities > 

Reset Patient Database.
4. Click Reset Patient Database.
5. Confirm the patient database has been emptied.
For more information, see:

• ‘Utilities’ on page 7-43

Table 7-18:  Reset Patient Database

Element DESCRIPTION

Instruction Information about the database reset.

Reset Patient Database When Disruptive mode is ON, resets the Versana 
BalanceTM/Versana BalanceTM Vet patient database.
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Clean Userdefs
Clean Userdefs provides a way to delete user-defined data 
when user presets may be inhibiting proper operation. 
User-defined data returns the user-defined settings to the 
factory default values. Clean Userdefs provides information to 
backup the current settings if you want to use them later. 
Disruptive mode must be On to clean user-defined data. If 
Disruptive mode is Off, a warning message displays asking to 
turn on Disruptive mode.

Before cleaning user-defined data, the Versana BalanceTM/
Versana BalanceTM Vet application software automatically 
shuts down.Once the operation is complete, the system reboots.

Clean Userdefs provides a way to selectively delete the 
following user-defined data:

• Connectivity - Deletes this file: 
%TEST_ROOT%\resources\userdefs\connectivity.res

• Imaging - Deletes this folder: 
%TEST_ROOT%\resources\userdefs\ImagingPresets\

• Measurement - Delete this folder: 
%TEST_ROOT%\resources\userdefs\EchoMeasure\

• Annotation/Bodymark - Deletes the folder: 
%TEST_ROOT%\resources\userdefs\EchoAnnotation\

The information on Clean Userdefs is available to Class C 
(Service Expert) and Class M licenses.

To access Clean Userdefs, select Utility (second page) > 
Service > Utilities > Clean Userdefs.

 Figure 7-45. Clean Userdefs
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Clean Userdefs(continued)

This table shows all the elements available on Clean Userdefs 
with descriptions.

To clean user-defined data:

1. If you want to use the current settings later, back them up 
now.

2. Navigate to Utility (second page) > Service > Utilities > 
Disruptive Mode Utility and set Disruptive mode to On.

3. Navigate to Utility (second page) > Service > Utilities > 
Clean Userdefs.

4. Select the data you want to set to the default settings.
5. Click Clean Userdefs.
For more information, see:

• ‘Utilities’ on page 7-43

Table 7-19:  Clean Userdefs

Element DESCRIPTION

Connectivity When Selective Delete is selected, deletes this file: 
%TEST_ROOT%\resources\userdefs\connectivity.res

Imaging When Selective Delete is selected, deletes this folder: 
%TEST_ROOT%\resources\userdefs\ImagingPresets\

Measurement When Selective Delete is selected, delete this folder: 
%TEST_ROOT%\resources\userdefs\EchoMeasure\

Annotation/Body Patterns When Selective Delete is selected, deletes this folder: 
%TEST_ROOT%\resources\userdefs\EchoAnnotation\
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Third Party Software Licenses
Third Party Software Licenses displays the third-party 
software licenses used as part of the service platform

The information on Third Party Software Licenses is available 
to all service class licenses.

To access Third Party Software Licenses, select Utility 
(second page) > Service > Utilities > Third Party Software 
Licenses.

 Figure 7-46. Third Party Software Licenses

For more information, see:

• ‘Utilities’ on page 7-43
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SSA License
SSA License provides a way to do the following:

• When inserted, view the details of an SSA key.
• View the status of the service class options.
• Restore an SSA license when the SSA key is not validating 

or when a remote log in shows as a Class A user.

The information on SSA License is available to all service class 
licenses.

To access SSA License, select Utility (second page) > 
Service > Utilities > SSA License.

 Figure 7-47. SSA License

This table shows all the elements available on SSA License 
with descriptions.

Table 7-20:  SSA License

Element DESCRIPTION

Class M Key Details

Class M Key Status Status of the SSA key. Valid values are:
•  Not Plugged In
•  Plugged In

Drive Letter Drive where the SSA key is plugged into the Versana 
Balance

Expire Date Date the SSA key is set to expire.

SSO ID Identifier for the user assigned to the SSA key.

Key Counter Value Number of times the SSA key has been used.

Max Key Counter Value Number of remaining times the SSA key can be used.

Service Option Keys

Name Name of the service class option.
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To view the Class M license information:

1. Insert the SSA key.
2. Navigate to Utility (second page) > Service > Utilities > 

SSA License.
3. Under Class M key Details, view the values. For example, 

the SSO ID for the user assigned to the SSA key.
If Not Available displays for all of these values, the SSA key 
is not validating.

To  restore an SSA key that is not validating:

1. Remove the SSA key from the Versana Balance.
2. If open, close the Service desktop.
3. Restart the Versana BalanceTM/Versana BalanceTM Vet.
4. Once the Versana Balance has restarted, plug in the SSA 

key.
5. Navigate to Utility (second page) > Service > Utilities > 

SSA License.
6. Click Restore SSA.
7. Check to see if the SSA key validates.
For more information, see:

• ‘Utilities’ on page 7-43

Status Status of the access to the associated service class option. 
Valid values are:
• True
• False

Restore SSA Restores the SSA license to the SSA key.

Table 7-20:  SSA License
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System Shutdown
With remote access, System Shutdown provides a way to shut 
down or restart the Versana BalanceTM/Versana BalanceTM 
Vet. Disruptive mode must be On to shut down or restart the 
Versana BalanceTM/Versana BalanceTM Vet. If Disruptive 
mode is Off, a warning message displays.

The information on System Shutdown is available to Class M 
licenses.

To access System Shutdown, select Utility (second page) > 
Service > Utilities > System Shutdown.

 Figure 7-48. System Shutdown

This table shows all the elements available on System 
Shutdown with descriptions.

Table 7-21:  System Shutdown

Element DESCRIPTION

Select Operation

Shutdown 
System

When Disruptive mode is On, shuts down the Versana BalanceTM/Versana 
BalanceTM Vet when Submit Request is pressed.

Restart System When Disruptive mode is On, restarts the Versana BalanceTM/Versana BalanceTM 
Vet when Submit Request is pressed.

Shutdown 
Application

When Disruptive mode is On, shuts down the application software when Submit 
Request is pressed.

Disruptive Mode

Retain 
Disruptive Mode

Determines whether Disruptive mode is retained after an operation has been performed. 
Generally used by the remote engineer to regain access to disruptive functions after a 
reboot without having to request Disruptive mode be enabled again.

Submit Request Performs the operation selected under Select Operation.
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System Shutdown(continued)
To remotely start, restart, or shut down the Versana 
BalanceTM/Versana BalanceTM Vet:

• Navigate to Utility (second page) > Service > Utilities > 
Disruptive Mode Utility and set Disruptive mode to On.

8. Navigate to Utility (second page) > Service > Utilities > 
System Shutdown and then select an operation:
- To shut down the Versana BalanceTM/Versana 
BalanceTM Vet, select Shutdown System.
- To restart the Versana BalanceTM/Versana BalanceTM 
Vet, select Restart System.
- To shut down the application software, select Shutdown 
Application.

9. To retain the current setting for Disruptive mode, select 
Retain Disruptive Mode.

10. Click Submit Request.
For more information, see:

• ‘Utilities’ on page 7-43
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Checkpoints
Checkpoints allows for the creation of checkpoints and displays 
the history of those checkpoints. Checkpoints are used to 
indicate when the Versana BalanceTM/Versana BalanceTM 
Vet has been serviced, status has been reset, and information 
related to the service performed has been added.

The information on Checkpoints is available to Class C 
(Service Advanced and Service Expert) and Class M licenses.

To access Checkpoints, select Utility (second page) > 
Service > Utilities > Checkpoints.

 Figure 7-49. Checkpoints

This table shows all the elements available on Checkpoints 
with descriptions.

Table 7-22:  Checkpoints

Element DESCRIPTION

Checkpoints History

Checkpoint Displays the name of the checkpoint.

Service Personnel Displays the ID for the logged in user.

Action Displays the service action.

Comment Displays comment text entered when the checkpoint was 
created.

Service Checkpoint Displays whether the checkpoint is a service checkpoint or not.

Create Checkpoint
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To create a check point:

• Navigate to Utility (second page) > Service > Utilities > 
Checkpoints.

11. Under Create Checkpoints, from Action, select the action.
12. In Comment, enter notes for the checkpoint.
13. If this is a checkpoint for service, select Service 

Checkpoint.
14. Click Save.
For more information, see:

• ‘Utilities’ on page 7-43

Action Selects the service action. Value values are
• Scheduled Maintenance
• Unscheduled Maintenance
• Upgrade
• FMI

Service Personnel ID for the logged in user. Value values are:
• SSO ID: When a Class M key is plugged in, the SSO ID for 

the logged in user.
• Remote user ID: If there is a remote connection, the remote 

user ID.
• User ID: If the SSO ID and remote user ID are not available, 

the user ID for the logged in user.
• Unknown: The logged in user ID is not available.

Comment Enter comments for creating a checkpoint.

Service Checkpoint Select whether to mark a service checkpoint or not.

Save Saves the information.

Table 7-22:  Checkpoints
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Disruptive Mode
Disruptive Mode provides a way to enable and disable Disruptive 
mode. When enabled, Disruptive mode allows a remote user to 
access the Versana BalanceTM/Versana BalanceTM Vet 
which can disrupt normal operation of the Versana BalanceTM/
Versana BalanceTM Vet. Disruptive mode can be remotely 
turned on when the logged-in user has Authorize Remote Service 
Access privilege. If the logged-in user does not have remote service 
privilege, displays this error message: “You do not have the 
required permission to perform this operation.”

When initiating Disruptive mode from a remote location, a message 
displays on the Versana BalanceTM/Versana BalanceTM Vet 
asking whether the user will allow Disruptive mode and notifying 
them that normal operation might be disturbed.

• If Yes is selected, then Disruptive mode is turned on.
• If No is selected, then Disruptive mode is not turned on and an 

error message displays saying that permission to change the 
mode was denied.

When Disruptive mode is On, the GE icon in the status bar changes 
to red and displays this message:"Due to Service testing restart 
needed."

When Disruptive mode is changed to Off, the GE icon turns white 
and displays this message: "Due to Service testing restart needed." 
In addition, VCO and SSH stop if running.

The information on Disruptive Mode is available to Class C 
(Service Advanced and Service Expert) and Class M licenses.

To access Disruptive Mode, select Utility (second page) > 
Service > Utilities > Disruptive Mode Utility.

Figure 7-50. Disruptive Mode

For more information, see:

• ‘Utilities’ on page 7-43
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SSH
SSH displays the status of the Secure Shell (SSH) server. SSH 
is a cryptographic network protocol for operating network 
services securely over an unsecured network. This protocol is 
used for remote login to the operational system. SSH allows 
remote login to the Versana BalanceTM/Versana BalanceTM 
Vet and remote file transfer from the Versana BalanceTM/
Versana BalanceTM Vet. Remotely log into the Versana 
BalanceTM/Versana BalanceTM Vet using the username 
“GEService” and its password.

The information on SSH is available to Class M licenses.

To access SSH, select Utility > Service > Utilities > SSH.

 Figure 7-51. SSH

This table shows all the elements available on SSH with 
descriptions.

To start the SSH server:

1. Navigate to Utility > Service > Utilities > Disruptive Mode 
Utility and set Disruptive mode to On.

2. Navigate to Utility > Service > Utilities > SSH.
3. Click Start.
4. To stop the SSH server, select Stop.
For more information, see:

• ‘Utilities’ on page 7-43

Table 7-23:  SSH

Element DESCRIPTION

Status When Disruptive mode is on, displays the status of the SSH server. Valid values are:
• SSH is stopped
• SSH is running

Start When Disruptive mode is ON, start the SSHD service.

Stop When Disruptive mode is ON and the SSHD service is running, stops the SSHD service.
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SSH(continued)
Remote File transfer through SSH

1. After start SSH server, enter Agent Configuration to register 
system to back office, refer to 7-51.

2. Connect to FFA, refer to 7-6-2 step 1 and step 2.
3. In connect page, click the Connect button to connect to FFA 

(Field Force Automation).

 Figure 7-52. Connect to back office

4. Choose the file in File Transfer, click the button (4) to send 
the file to back office.

 Figure 7-53. File Transfer

5. In back office page, click button (5) in Figure 7-53 to 
download the file to PC.
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Network Capture 
Network Capture displays network traffic between the Versana 
Balance and configured devices. A network capture outputs two 
log files: one for main logging with no protected information and 
another including protected information. These log files are 
useful when debugging connectivity issues. Because these log 
files can be large, they are only kept for one week.

The information on Network Capture is available to all service 
class licenses.

To access Network Capture, select Utility > Service > Utilities 
> Network Capture.

 Figure 7-54. Network Capture

This table shows all the elements available on Network 
Capture with descriptions.

Table 7-24:  Network Capture

Element DESCRIPTION

Network Capture Parameters

Maximum Size Allowed size of the generated log file. Valid value are:
•  256MB
•  512MB
•  1024MB

Devices DICOM-configured devices for which you want to capture 
information. If no additional devices are configured, only All will 
be available.

Start Network Capture Select to start the process. This causes the network capture to 
start, enables the Stop button, and updates the Network 
Capture Status pane and changes the Status to Running.

Stop Network Capture Select to stop the process..

Network Capture Status
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To  perform a network capture:

1. Navigate to Utility > Service > Utilities > Network 
Capture.

2. From Network Capture, do the following:
• Under Maximum Size, select the allowed size of the 

generated log file.
• Under Devices, select the DICOM-configured device for 

which you want to capture information. If no additional 
devices are configured, only All will be available.

3. Select Start Network Capture to start the process. This 
causes the network capture to start,enables the Stop 
button, and updates the Network Capture Status panel 
and changes the Status to Running.

4. Click the Stop button to end data collection. Stopping is a 
two-step process:
• Stops the data collection and immediately closes the .etl 

file.
• Collects additional diagnostic data that may help 

diagnose network issues. When the file is closed, you 
see “There is no trace session currently in progress”. 
When the remaining data is collected and the .cab file is 
closed, you are notified in the banner.

For more information, see:

• ‘Utilities’ on page 7-43

Displays information about the status of the network capture. The language setting for this information is set 
in Windows and not through the Service desktop or Versana Balance application software.

Displays the current status of the network capture. Valid values are:
•  Not Running
•  Running

Table 7-24:  Network Capture
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Options

Use Options to:

• View software options
• View software option details.
• Add (or delete) a valid option key, add a duplicate option 

key, not add an invalid option key, and ask for confirmation 
before deleting an option key.

• View software option key details. Key details are a list of 
options that are enabled by a particular key. Under 
Available Keys, highlight the option string, select Details 
and then view the options on the left side of the screen. 
Press Show All to view all of the activated options.

The information on Options is available to all service class 
licenses.

To access Options, navigate to Utility > Service > Options.

 Figure 7-55. Options

This table shows all the elements available on Options with 
descriptions.

Table 7-25:  Options

Element DESCRIPTION

Software Options

Option Software options on the Versana Balance.

Status Status of the options on the Versana Balance.
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Software Option Details

Product Name of the product.

Hardware Number Number for the hardware. The hardware number is the 
hash of the serial number that is used to generate the 
option key.

Serial Number Serial number of the Versana Balance.

Software Option Keys

Available Keys List of the option keys installed on the Versana Balance.

Table 7-25:  Options
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Agent Configuration

Use Agent Configuration to:

• Edit and configure the following:
• Enterprise host name in the agent
• Enterprise port number in the agent
• Proxy server in the agent
• Proxy port in the agent
• CRM number in the agent
• Display name in the agent

• Set the serial number in the agent
• Enter the username and password for the proxy
• Reset the edited unsaved value
• Update contact details

The information on Agent Configuration is available to all 
service class licenses.

To access Agent Configuration, navigate to Utility > Service > 
Agent Configuration.

 Figure 7-56. Agent Configuration
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Agent Configuration(continued)

This table shows all the elements available on Agent 
Configuration with descriptions.

Table 7-26:  Agent Configuration

Element DESCRIPTION

Agent Configuration

Contact Details Phone number for the person at the customer site a GE 
remote service engineer would contact. The phone number 
is entered during installation and reviewed at every service 
call to make sure the information is correct.

Agent Status Status for the agent. Valid values are:
• Running
• Not Running

Agent Registered Registered status of the agent. Valid values are:
• Yes - The agent is registered in the back office.
•  No - The agent is not registered in the back office.
• Not Available - The agent is not configured or running.

 Agent Quarantine Quarantine status of the agent. Valid values are:
• Yes - The agent has more than one device registered with 

the same CRM Number in the back office. This scanner 
cannot send data back to GE or be remotely accessed.

• No  - The agent has one device registered with the listed 
CRM Number in the back office.

• Not Available - The agent is not configured or running.

Agent CRM Verified CRM verified status of the agent. Valid values are:
• Yes - The agent is verified in the back office.
• No - The agent is not verified in the back office.
• Not Available - The agent is not configured or running.

Agent Model Number GE part number for the Versana Balance. The same number 
as listed on the rating plate.

Serial Number Serial number of the agent (read-only). If the agent is not 
registered with a serial number, this field is populated with 
the serial number of the Versana Balance. The serial number 
of the agent is tied to the serial number of the Versana 
Balance.

CRM No Customer Relationship Management (CRM) number. 
System identifier assigned to the customer unit by the 
service region. CRM is pre-populated by adding Versana 
Balance to the CRM number. The CRM number of the 
Versana Balance is editable.

Display Name Displayed name of the agent.

Advanced Configuration

Enterprise Server Name of the enterprise server.
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Enterprise Host Number of the enterprise host.

Enterprise Port Number of the enterprise port.

Proxy Configuration

Enable Proxy Enables the proxy server.

Proxy Server When Enable Proxy is selected, name of the proxy server IP.

Proxy Port When Enable Proxy is selected, number of the proxy server 
port.

Credentials

Enable Proxy Credentials Enables the proxy credentials.

Username When Enable Proxy Credentials is selected, name of the 
user.

Password When Enable Proxy Credentials is selected, password for 
the user.

Table 7-26:  Agent Configuration
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Network and Common Diagnostics

Network Configuration

Wire-LAN Network

1. Connect system with network.
2. Enter Utility-> Connectivity-> TCP/IP, in IP settings 

window, check Enable DHCP, and select the proper 
network speed in Network Speed.

 Figure 7-57. Enable DHCP
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Network Configuration(continued)

NOTE: If user wants to setup static IP address, uncheck Enable 
DHCP option, input static address in IP-Address box, 
Subnet Mask and Default Gateway box. In Network 
Speed, choose the proper speed available.

Figure 7-58. Network Settings

3. Select Save, and a popup window displays. Select Restart 
Now to restart the system and activate the changes.

Figure 7-59. System Restart inquiry dialog

4. After the system restarts, the network icon on the right top of 
the screen shows that the network is available.

Figure 7-60. Network icon



Diagnostics/Troubleshooting

7-82 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Wireless-LAN Network

NOTE: To configure the Wireless-LAN network, the operator must login 
as administrator.

1. Connect the wireless adapter in the USB port.
2. Enter Utility-> Connectivity-> TCP/IP, press 

Configuration.
3. Double click Wireless network. you chosen, or click the 

Connect at the left bottom of screen. 

 Figure 7-61. Wireless Network Conection
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Wire-LAN Network(continued)

4. Enter Internet Wireless Network Properties, select Security 
type and Encryption type. Then input Network security key 
and click OK.

Figure 7-62. Connection Status

5. The network icon at the left bottom of screen shows that the 
wireless network is available.

Figure 7-63. Wireless-LAN Connection
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Remote Access

Remote Access is a feature designed to enable OLE’s access to 
customer’s desktop remotely, service engineers don’t have to be 
on site to connect the physical dongle to exit to desktop, it’s 
doable remotely by using this feature.

1. In the server side, type the CRM No. of the system which 
the OLE would remotely connect to, and select Get Started.

NOTE: Remote FFA link:https://stg-ffa.am.health.ge.com/#/di/
home.

Figure 7-64. Input System ID
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Remote Access(continued)

2. Select Connect. Then the Connect page is displayed.

 Figure 7-65. Connect Page

3. Select HTTPS to Connect. Then the OLE is remotely 
connected to the system.

 Figure 7-66. Select HTTPS to Connect

NOTE: RDP is not available in Versana Balance.
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Remote Access(continued)

4. Enter Otpions to add service option key.
NOTE: Please delete the added service option key when your 

service work is done.

 Figure 7-67. Add Service Option Key

5. Enter Utility-> Disruptive Mode Utility, select Enable.

Figure 7-68. Enable Disruptive Mode

6. If we want to see the Scan screen or have control of the unit, 
we have to go to Virtual Console Observation and start it. 
Enter Utility-> Virtual Console Observation, select Start.

Figure 7-69. Start VCO
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Remote Access(continued)

7. Select Desktop to Connect. Then the OLE is remotely 
connected to the system.

 Figure 7-70. Select Desktop to Connect

NOTE: You need to reboot the system before clinical scanning is 
resumed. 
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Service Diagnostics

MST board

• MST Swept Demodulator Test performs a signal path test of 
the swept demodulator FPGA on the MST.

• MST Front End Interface Test tests that the MST can access 
Front-End boards.

• MST Analog Test.
• MST Memory Access Test tests that MST can access to the 

internal, external, external cache memory spaces.
• Front End Interface FPGA Test reads the version of the GFE 

FPGA.
• MST Fixed Demodulator Test: MST Fixed Demodulator 

signal path test.
• DSP Master Clock Check checks  DSP Master Clock.
• MST Swept Demodulator Long Test.
• MST Temperature Test.
• MST Voltage.
• FPGA Internal Memory Test.

NOTE: The FPGA Internal Memory test may fail if it is performed 
with other tests at the same time. 

• FPGA Version.

CWI board

• HV STOP Test tests HV-STOP mechanism and checks each 
board is able to assert HV_STOP using its HV_STOP 
source.

• CWI Voltage.
• Other Voltage test point.
• Memory tests the memory on the mother board.
• Network Interface.
• Network Interface Reliability Test.
• CPU Temperature Test.
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Front End Path

• AFE IF Test checks digital path between AFE chips and 
FPGA.

• Complex Mixer Test checks the Mixer process chain of 
FPGA.

• CE Decoder Test checks the Code Excitation Decoder 
process chain of FPGA.

• Analog CW checks I-Q symmetry of pedof CW beamformer 
receiving signal.

• When AFE IF Test/Complex Mixer Test/CE Decoder Test 
fail, please try to replace MST. If it doesn’t work, please try 
other PWA. When aCW IQ Symmetry Test fail, please try to 
replace MST. If it doesn’t work, please try CWD or other 
PWA.

PC Test

• Hard Drive Test Long tests functionality of the hard drive.
• Hard Drive Test Short tests functionality of the hard drive.
• RTC clock: 
• AVI playback tests playing back an AVI file.

• Click “Play” to run the test. If the test is successful, you 
will see a brief video clipo with audio. For more 
information about the test, click “More Information”.

• Click “Pass” if the test successfully reproduces the 
video clip.

• Click “Fail” if the test is unable to successfully reproduce 
the video clip.

• Click “Cancel” button to quit the test without recording a 
test result.

• Keyboard 
• Press each key on the keyboard and it will be added to 

the History. Hold down a key to test the repeat of that 
key. To cancel, click Cancel or press Alt-X.

• Special purpose keys like volume control or Internet 
access keys may not be detected. To test the Fn key of 
a notebook computer, hold down the Fn key while 
pressing another key.

• Note: This diagnostic is intended to verify keyboard 
keys are in good working order. It is not intended to 
veriy that keyboards produce desired characters.
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PC Test(continued)

• Monitor Test Patterns
• This test is composed of various elements that verify a 

monitor functions correctly. To test a monitor feature, 
click the appropriate button. You can return to this dalog 
by clicking the mouse button or pressing any key.

• The Combination Test helps you verify your monitor is 
properly aligned, and set at the correct color depth and 
resolution. Use the crosshair pattern in each corner of 
the screen to visually determine if the monitor aligns 
correctly. If the crosshairs appear distored or out of 
focus, a problem may exist with the monitor alignment. 
Use the color spectrum array for visually verifying the 
monitor color depth capacity. If the colors in the color 
spectrum do no blend smoothly together, a problem 
may exist with the monitor color depth. Use the 
graduated horizontal and vertical alignment bars to 
determine the monitor resolution capabilities. The better 
you can discern individual lines as they move closer 
together, the higher the resolution capabilities of the 
monitor.

• The Solid Color Test helps point out malfunctioning or 
dysfunctional pixels using five basic colors: red, green, 
blue, black, and white. Fill the screen with an 
appropriate color by clicking the associated button. If a 
pixedl is malfunctioning, the pixel color will contrast with 
the color of all other pixels.

• The VESA Test Patterns allow you to test the monitor for 
proper luminance, geometry and focus. Click the 
appropriate button to fill the screen with the associated 
test pattern. You can return to this dalog by clicking the 
mouse button or pressing any key.
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PC Test(continued)

• Trackball
• The Mouse Status Test verifies the cursor position and 

mouse button state. When a mouse button is pressed, 
the corresponding button on the picture will change 
color. If the mouse is a wheel or scroll mouse, an arrow 
will indcate the direction the wheel is being rotated. 
Clicking the wheel will flash the picture of the mouse in 
the Mouse Status Test area.

• The Drag and Drop Test verifies a mouse can 
successfully perform drag and drop operations. Left 
click the picture of the CD and drag is onto the picture of 
the drive. If successful, the picture will change.

• The Double Click Test verifies a mouse can successfully 
perform double-click operations. Double-click on the 
picture of the monitor. If successful, the picture will 
change.

• Sound Test generates sounds for testing the speakers.
• USB Ports Test lists USB Devices.
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Battery Test

Battery pack has a test function about the remaining fuel gauge. 
User can press TEST button, and then Fuel Gauge LEDs shall 
display below pattern for 5 seconds.

NOTE: New battery shall be activated by starting system, or the LED 
lights is off while the user presses Test.

Table 7-27:  Fuel gauge LED indication

SOC LED1 LED2 LED3 LED4

0-25% ON OFF OFF OFF

26-50% ON ON OFF OFF

51-75% ON ON ON OFF

76-100% ON ON ON ON
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Assessment Utility

Probe Assessment

NOTE: The probe assessment is only available for the probe connected 
in the first probe port. 

Figure 7-71. The first probe port
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Assessment Utility(continued)

1. Place the probe’s carrying case on a stable surface and 
open the case.

2. Carefully remove the probe and unwrap the probe cord.
3. Put the probe in the probe holder.

4. Prior to inserting the probe, ensure that the connector 
locking handle is positioned to the left.

5. Align the connector with the probe port and carefully push 
into the left-most probe port.

6. Turn the connector locking handle to the right to secure the 
probe connector.

7. Carefully position the probe cord so it is free to move and is 
not resting on the floor.

8. Press Probe button on the control panel and select the first 
probe from the probe indicators.

9. Enter global service user interface as GE service.
10. In the Diags-> Run Diags-> ProbeAssessment to check 

the probe.
If there is no broken element and the probe is acceptable for 
diagnostic, the following result window displays.

 Figure 7-72. Probe Assessment Pass

CAUTION DO NOT allow the probe head to hang free. Impact to the 
probe head could result in irreparable damage.
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Assessment Utility(continued)

11. In the Diags-> Run Diags->Diags History to check the 
probe diagnostic results.

 Figure 7-73. Probe Assessment Result

Probe Pass/Fail Criteria
Pass

• No dead element
• Dead elements on the edge (#0, #1 or #end-1, #end)

Fail

• Max 2 weak elemets on the scan line: -3dB<elements<-2dB 
• Any one of the elements in one scan line: element<-3dB

CAUTION Reboot the system after the probe assessment.
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Temperature Monitoring

The Versana Balance has monitoring function for CPU and MST 
temperature.

When the system is higher than warning temperature, a warning 
message will appear in the screen to remind the user to clean 
the air filter. And when the system is higher than limit 
temperature, a dialog will pop up to warn the overheat and the 
system will shut down automatically in 10 senconds.

Figure 7-74. Temperature Alarm

Warning Temperature and Limit Temperature

Table 7-28:  Temperature Value

Product CPU/MST Monitor Item
Warning 

Temperature
Limit 

Temperature

Supra
Console

CPU BEP_CHIPSET_TEMPERATURE 95 98

MST MST_AFE_TEMPERATURE 70 77

MST_BF0_TEMPERATURE 75 82

MST_MVP_TEMPERATURE 75 82
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Temperature Monitoring Point

Figure 7-75. Temperature Monitoring Point - MST

Figure 7-76. Temperature Monitoring Point - CWI
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Voltage Monitoring

Voltage Monitoring Point - MST

Figure 7-77. Voltage Monitoring Point - MST (1)

Table 7-29:  Voltage Monitoring Point - MST

Voltage Function

MST_D3V3 For MVP, CPLD,DSP, CLK, Driver, etc

MST_AFE_3V3_0 For AFE 

MST_AFE_3V3_1 For AFE 

MST_AFE_1V8 For AFE Core

MST_2V5V_CLK For Clock

MST_D2V5 For BF0, MVP, CPLD, etc

MST_D1V8 For MVP, DSP

MST_D1V1_0 For BF0

MST_D1V1_2 For MVP

MST_D1V5_XIO For PCIe Bridge

MST_D1V2_DSP For DSP
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Voltage Monitoring Point - MST(continued)

Figure 7-78. Voltage Monitoring Point - MST (2)

Figure 7-79. Voltage Monitoring Point - MST (3)

Figure 7-80. Voltage Monitoring Point - MST (4)
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Voltage Monitoring Point - CWI

Figure 7-81. Voltage Monitoring Point - CWI

Table 7-30:  Voltage Monitoring Point - CWI

Voltage Function

CPS_D5V For DSP, FPGA

CPS_D12V For CPU

CPS_A3V5 For Analog Front End: Pluser, AFE, etc

CPS_A5V4 For Analog Front End: Pluser, AFE, etc

CPS_N5V For Analog Front End: Pluser, AFE, etc

CPS_CWDP For CWD

CPS_SHVP For Analog Front End: Pluser, AFE, Probe, etc

CPS_SHVN For Analog Front End: Pluser, AFE, Probe, etc

CPS_HVP0 THV+; For Analog Front End: Pluser, AFE, Probe, etc

CPS_HVM0 THV-; For Analog Front End: Pluser, AFE, Probe, etc

CPS_A2V For Analog Front End: Pluser, AFE, etc
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Temperature and Voltage Range

Table 7-31:  Temperature and Voltage Range

Item Upper Limit Upper Normal Lower Normal Lower Limit

MST_MVP_TEMPERATURE 85 80 0 -10

MST_BF0_TEMPERATURE 85 80 0 -10

MST_AFE_TEMPERATURE 75 70 0 -10

MST_D3V3 3.63 3.53 3.07 2.97

MST_D2V5 2.8 2.65 2.35 2.25

MST_D1V8 2 1.9 1.7 1.6

MST_D1V5_XIO 1.7 1.6 1.4 1.3

MST_D1V2_DSP 1.4 1.3 1.1 1

MST_D1V1_2 1.2 1.15 1.05 1

MST_D1V1_0 1.2 1.15 1.05 1

MST_AFE_3V3_0 3.63 3.53 3.07 2.97

MST_AFE_1V8 2 1.9 1.7 1.6

MST_2V5V_CLK 2.8 2.65 2.35 2.24

BEP_CPU_TEMPERATURE 150 130 0 -10

CPS_SHVP 93.5 92 78 76.5

CPS_SHVN 93.5 92 78 76.5

CPS_N5V 5.8 5.7 4.84 4.74

CPS_HVP0 77 74 0 0

CPS_HVM0 77 74 0 0

CPS_D5V 5.6 5.5 4.7 4.6

CPS_D12V 13.53 13.43 11.17 11.07

CPS_CWDP 14 13 0 0

CPS_A5V4 5.9 5.8 4.92 4.82

CPS_A3V5 4.07 3.97 3.4 3.3

CPS_A2V 2.46 2.36 2.03 1.98
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Troubleshooting

Console Troubleshooting

System Doesn’t Boot (Hang-up)

Table 7-32:  Hang-up black screen diagnostic table

ON/OFF 
button

LED1 
(HDD) LED2 LED3 Failure module

Power 
connected
.  Power 
on button 

not 
pressed

White On OFF Blink “high” some issue of power on/off button on 
Keyboard

White On Not Blink Not blink CWI PWA failure

No 
anylight OFF  OFF

1. ACDCor its related cable failure.
2. Charger module (if exist) failure or its 

related cable fail.
3. CWI PWA failure.

No any 
light Blink “low” Blink “low”

1. KBD Cable Connection failure
2. IDOKG PWA failure
3. KBD PWA failure

Power on 
button 

pressed

Green ON

NA

Blink “low” ON This is correct status

White Blink “low” Blink “low”

1. KBD Cable Connection failure
2. IODKG PWA failure.
3. KBD PWA failure.
4. CWI PWA failure.

NA Blink “high” Blink “high” CWI PWA failure - CWI power have fatal 
issue.

NA Blink “mid” Blink “mid”

1. Docking PWA failure -Docking power 
have fatal issue.

2. Peripheral failure - please remove 
LCD/ speaker/KBD/DC printer/Gel 
Warmer connection to docking, 
remove and re-connect AC power 
supply, then try to power on system 
with the power button on docking 
board.

Green ON Blink “low” Blink “low” CWI PWA failure - CPU issue

Green ON    Blink “low”   OFF CWI PWA failure - BIOS self test error.
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Chapter 8

Replacement Procedures

This chapter describes how to remove and install, or 
replace, modules and subsystems in the Versana 
BalanceTM/Versana BalanceTM Vet. It also includes 
instructions for installing and re-installing the software.
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Overview

Contents in this chapter

• ‘Overview’ on page 8-2
• ‘Warnings and important information’ on page 8-3
• ‘Disassembly/Re-assembly’ on page 8-5
• ‘Loading the software’ on page 8-10
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Warnings and important information

Warnings

WARNING Energy Control and Power Lockout for Versana BalanceTM/
Versana BalanceTM Vet.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   
6. Remove/disconnect the battery, if present. 

Ultrasound System components may be energized. 

WARNING Because of the limited access to cabinets and equipment in the 
field, placing people in awkward positions, GE has limited the 
lifting weight for one person in the field to 16 KG (35 LBS). 
Anything over 16 KG (35 LBS) requires 2 people.

WARNING DO NOT touch any boards with integrated circuits prior to 
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised 
ESD connection point located on the rear of the Ultrasound 
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive 
equipment.
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Warnings(continued)

NOTE: Use an ESD compatible work space or the ESD-kit during parts 
replacement.

Returning/shipping probes and repair parts

Equipment being returned must be clean and free of blood and 
other infectious substances.

GE policy states that body fluids must be properly removed from 
any part or equipment prior to shipment. GE employees, as well 
as customers, are responsible for ensuring that parts/equipment 
have been properly decontaminated prior to shipment. Under no 
circumstance should a part or equipment with visible body fluids 
be taken or shipped from a clinic or site (for example, body coils 
or an ultrasound probe). The purpose of the regulation is to 
protect employees in the transportation industry, as well as the 
people who will receive or open this package.

NOTE: The US Department of Transportation (DOT) has ruled that 
“items that were saturated and/or dripping with human blood 
that are now caked with dried blood; or which were used or 
intended for use in patient care” are “regulated medical waste” 
for transportation purposes and must be transported as a 
hazardous material.

NOTE: Please remove the battery before system shipment to avoid any 
potential danger.

WARNING The waste of electrical and electronic equipment must not be 
disposed as unsorted municipal waste and must be collected 
separately.

Please contact the manufacturer or other authorized disposal 
company to decommission your equipment.
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Disassembly/Re-assembly

Warning and Caution

WARNING For FRU (Field Replaceable Unit), only qualified service 
personnel should remove any covers or panels. Electrical 
hazards exists at several points inside. Become thoroughly 
familiar with all hazardous voltages and high current levels to 
avoid accidental contact.

CRU (Customer Replaceable Unit) can be replaced by 
customers, as these parts are not related to any electrical 
hazards, no tool is needed for the replacement.

CAUTION Do wear the ESD wrist strap when you work on circuits. 
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Tools needed for servicing Versana BalanceTM/Versana 
BalanceTM Vet

NOTE: Please use the correct Screwdrivers listed in Table 8-1.

Table 8-1:  Standard tools list for Versana BalanceTM/Versana BalanceTM Vet

No
Part 

Name Part No. QTY Screw Description Screwdriver Description

1 screw   2327766 4 D2 SCREW M3X5 
NYLOK

Common Phillips Screwdriver

2 screw 2327793 100 Screw-M3X8 Common Phillips Screwdriver

3 screw 5477579 4 DScrew_DIN 912 M6_20 Common Phillips Screwdriver

4 screw 5477414 8 Screw DIN 965A M4x10 Common Phillips Screwdriver

5 screw 5439265 51 Screw-M4X10 Common Phillips Screwdriver

6 screw 5495588 3 Screw M3X6 CSK Common Phillips Screwdriver

7 screw 5138465 3 Screw FH M2.5X5-NL Common Phillips Screwdriver

8 screw 5495588 7 Screw M3X6 CSK Common Phillips Screwdriver

9 screw 5477414 5 Screw DIN 965A M4X10         Common Phillips Screwdriver

10 screw 2327785 3 D2 SCREW 
M2X4,NYLOK

Common Phillips Screwdriver

11 screw 5478161 48 Taping SCREW M3X6 Common Phillips Screwdriver

12 screw 5490719 4 PM_SW 4X8 Screw    Common Phillips Screwdriver

13 screw 1041-M10
C010-37

2 Magna M10 screw Common Phillips Screwdriver

14 screw 5495592 7 Captive SCREW M4X16 Common Phillips Screwdriver
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Overview of Versana BalanceTM/Versana BalanceTM Vet

 Figure 8-1. System Overview for Touch Panel System

1. Monitor Assy
2. Keyboard Assy
3. Body Assy
4. Base Assy

5. Speaker Assy
6. Probe and Gel Holder - CRU
7. Gel Warmer Assy
8. Body Back Cover Kit
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Overview of Versana BalanceTM/Versana BalanceTM Vet(continued)

 Figure 8-2. System Overview for Non-Touch Panel System

1. Monitor Assy
2. Keyboard Assy
3. Body Assy
4. Base Assy

5. Speaker Assy
6. Probe and Gel Holder - CRU
7. Gel Warmer Assy
8. Body Back Cover Kit
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Overview of Versana BalanceTM/Versana BalanceTM Vet(continued)

 Figure 8-3. System Overview example

1. Monitor Assy
2. Keyboard Assy
3. Body Assy
4. Base Assy
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Loading the software

Purpose of this section

This section describes how to reinstall software on Versana 
BalanceTM/Versana BalanceTM Vet.

Customer provided prerequisite

• Formatted and labelled media for Images storage.
• Formatted and labelled media for Patient Archive and 

Presets (User Defined Settings).
• Password for the user ADM. 

Software version compatibility

Versana Balance R2 software is R2.0.x. User only need to 
update software if user needs to switch between any software 
versions of Versana Balance R2.

The patient data and user defines are compatible on all R2.x.x 
version, which means the patient data and the user defines can 
be backup/export, and then restore/import between any 
versions of Versana Balance R2.  
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Backing up the Patient Archive and System Configurations

• Backup the Patient Archive and System Configurations. 

For instructions, please see “Backup and Restore” in the 
User Manual.

Backing up the Patient Archive and System Configurations

• Backup the Patient Archive and System Configurations. 

For instructions, please see “Data Backup and Restore” in 
the User Manual.

CAUTION An error, or a power loss may occur. 

Always backup the Patient Archive and the Presets (System 
Configurations) before loading the software!, refer to 
Table 8-2: ‘Checklist for reference before software reload’ on 
page 8-12.

In order to complete a successful restore of the Patient 
Database, as needed after a hard disk replacement, or if all the 
content on the hard disk has been erased, the images must be 
moved away from Versana BalanceTM/Versana BalanceTM 
Vet before doing backup of the Patient Database. 

Depending on the location set-up, either move the images to a 
remote server or to removable media like DVD or CD discs.

CAUTION An error, or a power loss may occur. 

Always backup the Patient Archive and the Presets (System 
Configurations) before loading the software!

In order to complete a successful restore of the Patient 
Database, as needed after a hard disk replacement, or if all the 
content on the hard disk has been erased, the images must be 
moved away from Versana BalanceTM/Versana BalanceTM 
Vet before doing backup of the Patient Database. 

Depending on the location set-up, either move the images to a 
remote server or to removable media like DVD or CD discs.
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Restoring up the Patient Archive and System Configurations

Below is the checklist for reference before software reload:

NOTE: It is not suggested to manually delete the files in 
D:\Scanner\target\resources\userdefs.

Table 8-2:  Checklist for reference before software reload

No. Items Backup solution

1. Patient data Backup/Restore
Export/Import (Recommended)

2. Preset Backup/Restore

3. Static IP address Backup/Restore

4. Hospital name/time format Backup/Restore

5. CRM ID/Port/Proxy Backup/Restore

6. Station name/AE title/port No./
Workflow

Backup/Restore

7. DNS/subnet mask/default gateway Please manually record this information and configure it 
back after the software reload as needed.

8. Network printer IP address Please manually record this information and configure it 
back after the software reload as needed.

9. Date and time/default century Please manually record this information and configure it 
back after the software reload as needed.

10. UI language/manual language/
Unites/Keyboard setting

Please manually record this information and configure it 
back after the software reload as needed.

11. User group settings/option keys Please manually record this information and configure it 
back after the software reload as needed.

WARNING To avoid not being able to connect to Local Archive, 
connecivity.res and IPSave in 
“D:\Scanner\target\resources\userdefs” should not be deleted. 
If they are deleted, please rewrite the serial number.
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Recording important settings and parameters

Overview

Always keep a record of the settings for the Versana 
BalanceTM/Versana BalanceTM Vet on paper. Verify if it is 
current before starting a software loading! If needed, record the 
settings.

Data Backup

NOTE: The screen graphics in this manual are only for illustrational 
purposes. Actual screen output may differ with different users' 
systems.

 Figure 8-4.

NOTE: For the upgrade option Load the complete disk or Load the 
bootable C: partition only, the information for Computer name 
and IP setting will be lost. Before upgrade, backup these 
information.

CAUTION An error, or a power loss may occur. 

It is considered to be best practice to always keep a record on 
paper of the settings for the Versana BalanceTM/Versana 
BalanceTM Vet. Verify if it is current before you start to load 
software!

CAUTION An error, or a power loss may occur. 

Always backup the Patient Archive and the Presets (System 
Configurations) before loading the software, refer to 
Table 8-2: ‘Checklist for reference before software reload’ on 
page 8-12.



Replacement Procedures

8-14 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Data Backup(continued)

1. Record the information for Computer name and IP setting in 
Utility -> Connectivity -> TCP/IP. Refer to Table 8-3 on 
page 8-14.
• If “Enable DHCP” is not selected, record all the 

information about IP setting. Refer to a) in Figure 8-5 on 
page 8-14.

• If “Enable DHCP” is selected, only record Computer 
name and Network Speed. Refer to b) in Figure 8-5 on 
page 8-14.

Figure 8-5. Record IP Setting

Table 8-3:  Record Table

Item Name Setting

Computer Name

IP-Address

Subnet Mask

Default Gateway

Network Speed
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Data Backup(continued)

2. Record the installed option keys in Utility -> Admin -> 
System Admin.

 Figure 8-6. Option Key

3. Insert the backup media. Go to Utility -> System -> 
Backup/Restore -> Media to select the media.

 Figure 8-7. Media Menu
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Data Backup(continued)

4. Go to Utility -> System -> Backup/Restore, select Patient 
Archive, User Defined Configuration and Service under 
Backup by placing a check mark in front of them. Then 
select Backup to backup the information.

 Figure 8-8. Backup Menu
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Data Backup(continued)

5. Select OK to backup the system information when the 
following pop-up warning windows display.

NOTE: After Patient Archive, User Defined Configuration and 
Service backup, remove all the external USB devices.

Figure 8-9. Backup Confirmation message

6. Go to Utility -> System -> General, record the Preset 
Region and the Language. Then select Regional Options.

Figure 8-10. Preset region
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Data Backup(continued)

7. In Format tab, record the Format. And in the 
Administrative -> Change system locale..., record current 
system locale.

 Figure 8-11. Region and Language
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Data Backup(continued)

8. Press Patient key on the control panel, and then select 
Data Transfer. Select the task as Export and specify the 
destination to backup the patient information and images.

Figure 8-12. Data Transfer

9. Select Select All, and then select Transfer to backup all the 
patient information and images. 

Figure 8-13. Export Patient Information
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Loading the System Software

NOTE: Before loading the system software, please ensure that the 
power can be continuously supplied and there is no risk of 
power cut off during loading procedure.

NOTE: Before loading/reload the system software, please change 
system language to English refer to Figure 3-76 on page 3-83. 
Otherwise, there will be garbage on the system after software 
reload/loading.

There is one method to load the system software:

• Load the system software with USB memory stick.

NOTE: Finding the system software USB memory stick by removing the 
body left cover.

Figure 8-14. Software USB memory stick positon

WARNING While the software install procedure is designed to 
preserved data, you should save any patient data, 
images, system setups and customer presets to CD, 
DVD, USB Flash Drive, or USB Hard Disk before doing a 
software upgrade.
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Loading the System Software with USB memory stick

NOTE: Please ensure AC adapter is connected during system software 
update.

This section describes how to upgrade the software.

1. Insert the Upgrade USB memory stick labeled “System & 
Application Software” to the USB port of the system.

2. Properly turn off the system by momentarily pressing the 
Power On/Off Switch. Then select Shutdown in the System 
Exit Window.

NOTE: If the system does not shutdown normally, hold down the 
Power On/Off Switch until the light turns off.

3. Power on the system and it will detect the USB memory 
stick automatically.

NOTE: A window will pop out. Do not close the window, or the 
upgrade process will be terminated.

4. Select the option Load the complete disk, Load the 
bootable C: partition only or Only reload/Upgrade 
Application Software for software upgrade. Or select Exit 
to exit the upgrade process.

Figure 8-15. Upgrade instruction



Replacement Procedures

8-22 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Loading the System Software with USB memory stick(continued)

• Load the complete disk: the complete disk will be 
loaded. This option is recommended for application 
software upgrade.

NOTE: If an extended SSD (disk Y) is installed, all patient data 
will be erased as well.

NOTE: This option is used by service engineer only.

• Load the bootable C: partition only: this option is 
intended for recovery of a system that will not boot up. 
All patient data is preserved. Only disk C & Z will be 
formatted and reloaded.

NOTE: If the patient data is encrypted, please go to Utility 
->Admin -> System Admin -> Disk Encryption page and 
press Suspend button before selecting Load the 
bootable C: partition only and Only Reload/Upgrade 
Application Software.If can’t be suspended, select 
Execute to continue. But user needs to manually unlock 
the patient data in next booting up.

WARNING If selecting Load the complete disk, all existing software and 
data will be erased. If backup has not been performed, all data 
like Patient Data, System Configuration and User 
Configurations (Customer Presets) will be lost. Please ensure 
that any patient data on the disk has been backed up before 
updating the system.
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Loading the System Software with USB memory stick(continued)

NOTE: Please refer to below diagram to understand the 
software reload process in different encryption situation. 
The green blocks stands for steps that requires operator 
action.

 Figure 8-16. Diagram
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Loading the System Software with USB memory stick(continued)

• Only Reload/Upgrade Application Software: the 
application software will be loaded/updated only. This 
option is recommended for application software load or 
reload. The software update kit will automatically detect 
if the system compatible with this function and complete 
software loading.

NOTE: If the current system base image does not support the 
application version of the software load USB disk, a 
message will be displayed on the screen and cancelled 
upgrading automatically.

NOTE: Please refer to below diagram to understand the 
software reload process in different encryption situation. 
The green blocks stands for steps that requires operator 
action.

 Figure 8-17. Diagram
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Loading the System Software with USB memory stick(continued)

5. If Load the complete disk is selected, a confirmation 
window will pop out, then select Execute to continue.

Figure 8-18. Confirmation Window

NOTE: Before loading the complete disk, please ensure that any 
patient data on the disk has been backed up.

If Load the bootable C: partition only or Only Reload/
Upgrade Application Software is selected, system will 
check if current disk needs to be suspended. 
• If no, a confirmation window for continuing will pop out, 

press Execute by using Touch Panel or Cursor key to 
continue.

Figure 8-19. Confirmation Window 2



Replacement Procedures

8-26 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Loading the System Software with USB memory stick(continued)

• If the disk needs to be suspended, a confirmation 
window will pop out as Figure 8-20.

Figure 8-20. Confirmation Window 3

a. If you select Shutdown, system will shutdown to let you 
suspend by Utility -> Admin -> System Admin -> Disk 
Encryption page.

b. If the system cannot boot up, you can select Execute to 
continue. But user needs to provide recovery key or 
password to patient data later.   

Figure 8-21. Unlock Patient Data

NOTE: If user lost password or recovery key, please do the 
complete disk installation. Patient data will be lost.
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Loading the System Software with USB memory stick(continued)

6. System USB memory stick will be loading. Wait for the 
software installation to complete. Status bar on the screen 
indicates the progress (about 30 minutes).

 Figure 8-22. Loading Process

WARNING

D

Do not interrupt the software loading at any time.
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Loading the System Software with USB memory stick(continued)

7. The system will display upgrading result and shutdown 
automatically within 30 seconds. Or click the Shutdown in 
the screen to shut down the system immediately.

 Figure 8-23. System upgrade complete

If the upgrade fails, select Exit to exit the upgrade process, 
then remove the USB memory stick. Insert the USB memory 
stick again and repeat the upgrade process from step 2 on 
page 8-21.

 Figure 8-24. System upgrade fail
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Loading the System Software with USB memory stick(continued)

8. Remove USB memory stick. Then press Power On/Off 
switch to power on the system.

NOTE: Remove the USB memory stick before the system restarts. 
If you do not remove the USB memory stick, the software 
system upgrading process repeats when the system boots 
up.

NOTE: Ensure the USB memory stick is properly and securely 
connected. Once the USB memory stick is accidentally 
disconnected from the system during the upgrading 
process, the error message will pop up: “The volume for a 
file has been externally altered so that the opened file is no 
longer vaild.” Insert the USB memory stick again and restart 
the system to run the upgrading process from step 3 of 
‘Loading the System Software with USB memory stick’ on 
page 8-21.

Rewrite the Serial Number

If selected to load the complete disk during the software loading 
process, when powering the system, the system will indicate to 
rewrite the serial number.
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Set Password

After the serial number is reset, the system will shutdown 
automatically. Power on the system and complete the password 
setting for use.

NOTE: Disk Encryption password and system password setting is 
required when turning on the system for the first time or after the 
software installation.

NOTE: Software upgrade will cause password reset, see Table 8-4  for 
more information.

NOTE: Please save the system password properly. User is required to 
provide the system password to back office for remote 
connection.

Table 8-4:  Password Reset Policy

System 
Upgrade

Disk Encryption 
password

 System 
password

ADM User 
password

Database 
password

Whole disks Yes Yes Yes Yes

Only C disk No Yes No No

Reload Apps No No No No
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Secure Wipe

Secure wipe is intended to erase all the patient data with the 
software on the system before the system will be shipped for 
service. 

NOTE: This tool is not BAM approved.

NOTE: Before starting this procedure, remove all probes and 
peripherals and remove them from the system.

NOTE: While it is believed to be unnecessary, it would not hurt to 
disconnect the system from the network and remove all 
transducer.

NOTE: Please ensure AC adapter is connected during system upgrade!

1. Insert the USB memory stick labeled “System & Application 
Software” to the system.

2. Properly turn off the scanner by momentarily pressing the 
Power On/Off Switch. In System-Exit window, select 
Shutdown to shutdown the system.

NOTE: If the system will not shutdown normally, hold down the 
Power On/Off Switch until the light turns off.

3. Power on the system. The system will detect the USB 
memory stick automatically.
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Secure Wipe(continued)

4. Select Secure Wipe. Or select Exit to exit the process.

Figure 8-25. Upgrade message

5. The system indicates all data will be erased, select Execute 
to continue.

Figure 8-26. Confirm Dialog

NOTE: All the patient data cannot be recovered after wipe process.
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Secure Wipe(continued)

6. The process may take twenty minutes or more.

 Figure 8-27. Wiping Process

7. The system will shutdown automatically when the wiping 
progress completes.

NOTE: As the SSD is empty after secure wipe, the system cannot 
boot up. The software should be loaded first after the wipe 
process.
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System Software Version check out

Functional Check-out
1. Power on Versana BalanceTM/Versana BalanceTM Vet 

system and wait until system booting to scanning screen.
NOTE: If selected to load C Disk only when loading the system 

software, the system will display a screen to restore 
Computer name before entering the scanning screen. 

2. Press Utility on the control panel.
3. Select the System -> About and check whether the system 

software version is right.

 Figure 8-28. System Software version
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Option Strings Check

NOTE: After the system software loading completion, please check the 
option strings to ensure that the options are activated and 
working.

1. Reboot the system.
2. Press Utility -> Admin, the following dialog is displayed. 

Select Acknowledge to continue. 

Figure 8-29. Notification Window

3. Login to the Versana Balance for the first time. Refer to 
‘Logging on to Versana BalanceTM/Versana BalanceTM Vet 
as “ADM”’ on page 4-12.
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Option Strings Check(continued)

4. Enter Utility -> Admin-> System Admin, ensure that all the 
installed option keys are displayed and the status of Options 
are valid.

• The status “Permanent” means the option keys are 
activated and working.

 Figure 8-30. SoftwareOption
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Reload the Correct Preset Region

NOTE: After the software upgrade process, the system language and 
region preset will be set as the default. Change the settings if 
needed.

NOTE: Refer to step 6 on 8-17 and step 7 on 8-18 for the system 
Region Preset and Language settings.

1. When the system is powered on, go to Utility -> System -> 
General. Select Regional Options.

Figure 8-31. Preset Region

2. Under Formats select the desired language. 

Figure 8-32. Formats selection
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Reload the Correct Preset Region(continued)

3. Under Administrative, select Change system locale.... 

Figure 8-33. Location selection

4. Select Apply when below message displays.

Figure 8-34. Change Regional Options
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Reload the Correct Preset Region(continued)

5. Select the language under Current system locale, then 
select OK.

Figure 8-35. Set Language

6. Select Cancel not to restart the system. 

Figure 8-36. Restart request
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Reload the Correct Preset Region(continued)

7. Select Close to close the window.

Figure 8-37. Installed service

8. Select Cancel to return to system setting. 

Figure 8-38. Installed service
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Reload the Correct Preset Region(continued)

9. In Utility -> System -> General, select the language as 
desired, and then select Save. 

Figure 8-39. Language

NOTE: Keep Input Language the same as system language, 
otherwise corrupted characters will be incurred.

10. Select Restart now to restart the system.

Figure 8-40. Add Input Language

11. When the system boots up, the system appears in the 
selected language.

NOTE: To have the settings take effect, you MUST restart the 
system.

NOTE: Press Alt+Shift to change the input language.
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Configuration Restore

1. When the system is powered on, go to Utility -> 
Connectivity -> TCP/IP. 
• If the original selection is that the "Enable DHCP" is 

selected, the selection is restored by default and the 
system will automatically get the IP address.

 Figure 8-41. Enable DHCP

• If the original selection is that the "Enable DHCP" is not 
selected, please uncheck “Enable DHCP”. Input the 
information about IP setting which have been recorded. 

 Figure 8-42. Disable DHCP
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Configuration Restore(continued)

2. Select Save, then the following pop-up window will display. 
Select Restart later.

Figure 8-43. Question Window

3. If Load the complete disk is selected for software upgrade, 
the user is required to restore the Patient Archive and 
System Configurations. 
Insert the media which is used to back-up.

4. Select System, then select Backup/Restore.
5. In the Media field, select the media. Refer to Figure 8-7 on 

page 8-15.
6. Restore user defined configuration. There are 2 options.

• If the user would restore all user defined configuration, 
in the Restore field, select User Defined 
Configuration.Then select Restore button in the 
Restore field. 

NOTE: If the user requires to restore all the User Defined 
Configuration, there is no need to select all the items of 
the Detailed Restore of User Defined to restore.

 Figure 8-44. Restore all user defined configuration
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Configuration Restore(continued)

Then the following pop-up Warning message will 
display, then select OK to continue.

Figure 8-45. Question Message

• If the user would not restore all user defined 
configuration, in the Detailed Restore of User Defined 
field , select the items the user would like to 
restore.Then select Restore button in the Detailed 
Restore of User Defined field. 

NOTE: According to the requirements from the User, restore 
the items in Detailed Restore of User Defined.

 Figure 8-46. Detailed Restore of User Defined
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Configuration Restore(continued)

During the restore process, the following pop-up 
message will display. Press OK to continue. Refer to 
Figure 8-57 on page 8-51  as an example.

NOTE: How many warning message windows show up 
depends on how many items of Detailed Restore of 
User Defined are selected to restore.

Figure 8-47. Restore Warning Message

7. After restoring the User Defined Configuration, the System 
will restart.

8. After the system is powered on, go to Utility -> System -> 
Backup/Restore. Select Patient Archive, User Defined 
Configuration and Service under Restore field.

NOTE: Select Patient Archive to restore the patient information. But 
the exam images will be damaged thus unable to read.

NOTE: If the user already restores the detailed User Defined 
Configuration in step 6 on 8-43, DO NOT select User 
Defined Configuration in this step.

 Figure 8-48. Restore Menu
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Configuration Restore(continued)

9. Select Restore. The the following pop-up Warning message 
will display, then select OK to continue. 

Figure 8-49. Warning Message

10. Then the following pop-up Warning message will display, 
then select OK to continue.

Figure 8-50. Question Message
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Configuration Restore(continued)

11. During the restoring process, the following pop-up message 
will display. Press Ok to continue. 

Figure 8-51. Warning Message

NOTE: If User Defined Configuration is not selected to restore in 
step 8 on 8-45, the warning message (b) in Figure 8-51 on 
page 8-47 will not display.
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Configuration Restore(continued)

12. Press Patient key on the control panel, and then select 
Data Transfer. Select the task as Import and select the 
source as where the patient information is exported to.

Figure 8-52. Data Import

13. Select Select All, and then select Transfer to restore all the 
patient information and images.

 Figure 8-53. Data Transfer
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Configuration Restore(continued)

14. Then the following pop-up question message will display, 
select YesToAll to continue. 

Figure 8-54. Overwrite Question Message

15. Then the following pop-up warning will display, select Ok to 
continue. 

Figure 8-55. Overwrite Warning
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Configuration Restore(continued)

16. The overwrite process is completed. 

 Figure 8-56. Overwrite Process
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Probe Recognition Check

NOTE: After the system software loading completion, please check to 
ensure that the system can recognize the probes.

Plug in the probe. In scanning mode, the probe information is 
displayed on the right top location of the screen. About the 
probe specification for intended use on Versana BalanceTM/
Versana BalanceTM Vet.

Plug in at least one of each type of the probes and check if each 
of the probes is recognized and the probe information is 
displayed correctly.

 Figure 8-57. Probe identification
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Peripheral Device Check

Check to ensure that all the peripheral devices work properly.

For instruction of peripheral device check, See ‘Peripheral 
checks’ on page 4-66 for more information.

Reinstall DICOM Devices

Reinstall any DICOM devices used by the customers and check 
to ensure these DICOM devices work properly.

The instruction about installing DICOM devices is not 
incorporated in this manual. To access the instruction about 
installing DICOM devices please refer to another manual User 
Manual. Please use the latest revision of this document.
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e-Delivery - Software update

Introduction

The user can update to the latest software two ways:

As part of the product lifecycle management, GE regularly 
analyzes and integrates software updates from our third party 
vendors into our products. These are typically released as part 
of regular updates or software releases.

• This requires Insite Remote Service Platform, see ‘Software 
update via Insite Remote Service Platform’ on page 8-53.

• Through software downloads from an end-user portal to a 
local storage location and install it on the ultrasound system. 
See ‘Software update via End-User Portal’ on page 8-59.

Software update via Insite Remote Service Platform

Software update for the system may become available for 
download and installation through the GE Service platform. 

If software updates are sent remotely from server, the user will 
see the notification icon highlighted in the Service Menu.

Users are required to be logged into the system as 
administrators (ADM) in order be granted access to initiate the 
installation.

NOTE: Be sure to end exam before software update.

NOTE: Please allow approximately half an hour for complete software 
download (the download time may vary due to network 
connection speed).

NOTE: Please allow approximately half an hour for complete 
installation.

NOTE: Software upgrade through the GE service platform may not be 
available in all markets.

CAUTION Please backup presets and database before installation of the 
software (see “Backup and Restore” in the User Manual).

Remote software download should not change user presets or 
affect customer database; however, it is always best practice to 
ensure patient data and preset are backed up before 
proceeding with any software installation.
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Software download and installation
1. Press the service menu, and click Download from the menu 

to check the updates.

Figure 8-58. Service Notification

2. Available software updates are displayed in the list. If you 
want to refresh the query for available updates, press 
Refresh.

Figure 8-59. Refresh
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Software download and installation(continued)

3. Select the desired software update and press Download to 
begin downloading the update package, or press Exit to exit 
the window.

Figure 8-60. Download or Exit

4. During the software download process, the status will be 
displayed as “Downloading”.  You can press Pause to 
suspend the download or press Cancel to abort the 
download. 

Figure 8-61. Downloading
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Software download and installation(continued)

Figure 8-62. Cancled

NOTE: While the software is downloading, the Exit button is 
disabled. If you want to go back to scanning page, please 
press Pause to suspend the download process first and 
then press the Exit button.

• When the download is in progress, press the Pause 
button to suspend the download process.

• When the download process is suspended, press the 
Resume button to recover the download process from 
the point where it is stopped.

• If there is an error during the downloading process, 
press the Retry button to recover the download process 
from the beginning.

NOTE: Before installation, user should log on the ADM account, 
otherwise there will be pop-up message for reminding it. 
Only after log onto the ADM account, user has access 
to installation.

Figure 8-63. Access Denied
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Software download and installation(continued)

5. When the download process finishes, the software is ready 
to be installed in the ultrasound system. Click Yes to start 
the installation.

Figure 8-64. Start Installation

Figure 8-65. Install

NOTE: Please allow enough time for ultrasound device to reboot 
automatically to complete the installation process.
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Software download and installation(continued)
6. The system will reboot several times to complete the 

installation. 
NOTE: Do not power off the system during the software installation.  

NOTE: A typical full installation may take up to 30 minutes.
NOTE: A typical software application installation may take up to 10 

minutes. 

7. After software installation is complete and the system is 
rebooted, a Reminder after Installation window will 
appear. This is to remind the user to manually restore 
configurations if the system has related settings backed up 
before the software update. Contact your on-site IT staff if 
available.

Figure 8-66. Reminder after Installation

8. Click OK to confirm the installation is complete. 
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Software update via End-User Portal

Customers entitled to eDelivery updates receive a customer 
account to download software within the End-User Portal.

Users are created for the account based on e-mail addresses 
provided by the customer at the point of sale. These e-mail 
addresses are the log-in credential for the End-User Portal along 
with a temporary password provided to the user through e-mail. 
When logging into the End-User Portal the first time, the user is 
prompted to change the password and enter a secret question 
and answer for password retrieval.

Follow the below instructions to download software from the 
portal:

1. Log onto the portal website which is provided to end user via 
a welcome email: 
https://gehealthcare.flexnetoperations.com/flexnet/
operationsportal

2. Log in using the user name (e-mail) and password.

Figure 8-67. Login Window
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Software update via End-User Portal(continued)

3. The License & Delivery Portal dashboard is displayed. 
Multiple downloadable packages will be displayed as a link 
under Your Downloads.

Figure 8-68. Your Downloads

4. Click the link to enter the Download Packages page. 
Downloadable packages with links will be listed. Click on the 
desired link to enter the Downloads page.

Figure 8-69. Select link
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Software update via End-User Portal(continued)

5. Right click on the “File Name” link, select “save link as” to 
download the file to your storage device (a readable and 
writeable USB flash driver with enough capacity).

NOTE: Multiple files may be downloaded on one device.

Figure 8-70. Save link

6. Load the downloaded software on the ultrasound system 
from the selected storage location. Refer to See ‘Loading 
the Software’ on page 8-62 for more information.
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Loading the Software

To load a software onto the Versana BalanceTM/Versana 
BalanceTM Vet,

1. Power off the Versana BalanceTM/Versana BalanceTM 
Vet and insert the USB Flash Drive into a USB port.

NOTE: Ensure that the system is USB Device Enabled.

2. Power on the Versana BalanceTM/Versana BalanceTM 
Vet. The software program files will be recognized 
automatically, select Install SW... on the Start Application 
screen.

NOTE: If by accident you try to load a software that is not 
compatible with the software on the Versana BalanceTM/
Versana BalanceTM Vet, error messages will indicate “The 
package present in media is not compatible. Please contact 
GE Service” and “Software installation is not started”.

 Figure 8-71. Select Install SW...
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Loading the Software(continued)

3. Click OK, then select the package you want to install, click 
INSTALL to start installation.

 Figure 8-72. Click Ok

 Figure 8-73. Select package
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Loading the Software(continued)

 Figure 8-74. Installing - Phase 1

4. When the installation phase 1 is complete, the syetem will 
reboot automatically to start installation phase 2. User can 
remove the USB stick from the ultrasound device at this 
time.

Figure 8-75. Reboot

5. The whole installation is complete once system reboots after 
installation phase 2 completed.

NOTE: Installation time depends on the type of update. No 
action is needed until the installation is complete.
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Reload the Software

Reload Software provides specific software versions for users to 
reload.

NOTE: Users are required to be logged into the system as 
administrators (ADM) in order be granted access. 

To reload the software onto the Versana BalanceTM/Versana 
BalanceTM Vet:

1. Press Utility -> System -> About, click Reload Software to 
enter the operation page. 

 Figure 8-76. Select Reload Software

2. Select the software version needed, then click OK.
• By default, current installed software version will be 

displayed, user can reload current software version to 
rollback software changes to the initial installed state.

• After a new full software package is installed, current 
version will be displayed as previous version, user can 
select to reload current version or previous version.

NOTE: After rollback to pervious software version, the "Current/
Previous" reload options will alternate.
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Reload the Software(continued)

Figure 8-77. Select the current version

Figure 8-78. Select the previous version

3. A pop-up message will appear to remind user to continue or 
cancel the reload process. Click Yes to start reloading 
software or No to cancel.

Figure 8-79. Pop-up message
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Chapter 9

Renewal Parts

This chapter lists the renewal parts available for the 
Versana BalanceTM/Versana BalanceTM Vet.
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Overview

Contents in this chapter 

• List of Abbreviations
• Renewal Parts Lists
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List of Abbreviations

Table 9-1:  List of Abbreviations

ABBREVIATION DESCRIPTION

3D THREE DIMENSIONAL

Assy ASSEMBLY

FRU Field Replaceable Unit

CRU Customer Replaceable Unit

KBD Keyboard Assy

BnV Brightness and Volume

MST Master Board

CWI CPU / WDC / IO Board. WDC is DC Power Board for 
Wukong Platform.

PIB Probe Interface Board, also name as Relay PIB

3PP 3 Probe Port

4PP 4 Probe Port

SSA Secure Service Access
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Renewal Parts Lists

Operator Console Assy

The following figure illustrates what is the body front cover (1), 
body right cover (2), body back cover (3), body left cover (4) of 
the system.

Figure 9-1. Operator Console Assy Example
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Operator Console Assy(continued)

Figure 9-2. Console Assy for Touch Panel System

Figure 9-3. Console Assy for Non-Touch Panel System
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Probe

NOTE:  LK760-RS probe is for Veterinary Use.

Table 9-2:  Probes for Versana BalanceTM/Versana BalanceTM Vet

Item Part Name
Service Part 

Number

Commercial 
Part 

Number
Center Image 

Frequency (MHz)
Replaced 

By

700 4C-RS 5488477 H4000SR 3.10 ± 10%

701 8C-RS 5499508 H40402LS 6.5 ± 20%

702 E8C-RS 5499516 H40402LN 6.5 ± 20%

703 E8Cs-RS 5670375 H48062AF 2.75 ± 20%

704 3Sc-RS 5433833 H45041DL 2.75 ± 20%

705 6S-RS 5499316 H45021RP 4.5 ± 20%

706 12S-RS 5499321 H44901AB 7.75 ± 20%

707 12L-RS 5499501 H40402LY 7.5 ± 20%

708 LK760-RS 5548914 H44901AF 7.15 ± 20%

709 RAB2-6-RS KTZ303982 H48681WR 3.3 ± 10%

710 L6-12-RS 5454332 H48062AC 7.75 ± 20%

711 L8-18i-RS 5499609 H40462LF 9.5 ± 20%
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Peripheral

Table 9-3:  Peripherals for Versana Balance

Item Part Number
Commercial 
Part Number Description

Footswitch

1. 5151236 H41642LS Footswitch MKF 2-MED USB GP26

2. 5338419 H41882LD 1-Peadl type Footswitch “Whanam FSU-1000”

USB Stick

3. 5831001 H48392BB 32G USB MEMORY STICK 

4. 5863937 NA USB3.0 stick for Storage(NEW FW) 

Printer

5. 5133107-2 H48542LZ SONY UPD25 Color Printer USA Kit

6. 5133108-2 H48552LA SONY UPD25 Color Printer EUP Kit

7. 5133106-2 H48542LY SONY UPD25 Color Printer CHN Kit 

8. 5133109-2 H48552LB SONY UPD25 Color Printer JPN Kit 

9. 5491253 H48312AN SONY UPD25 Color Printer Brazil kit

10. 5151259-2 H48492AF SONY UP-D898MD BW Printer USA Kit

11. 5151261-2 NA SONY UP-D898MD BW Printer Europe Kit

12. 5151262-2 NA SONY UP-D898MD BW Printer China Kit

13. 5151263-2 NA SONY UP-D898MD BW Printer Japan Kit

14. 5495509-2 H48492AK SONY UP-D898MD BW Printer Brazil Kit

15. 5543406 H48492AZ BW PRINTER (UP-D898MD)

16. 5778615 H48052BG UP-D898DC Printer

17. 5825601 H48342BP VSN B Cable for UP-D898DC Printer

18. NA H48532AM SONY UPD25 Color Printer kit

19. 5877349-S H48392BD VSN B R2 Printer shelf

20. NA H41402LS 898 printer paper

  ECG

21. 5146056 H48502AR USB ECG Module (IEC)-MFG Germany 

22. 5146739 H41852LK USB ECG Module (AHA)-MFG Israel

23. 5129487 H41852LL USB ECG Module (IEC)-MFG Israel

24. 5149641 H41852LM ECG Assy with Chinese label 
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System and Application Software Update USB

For the latest revision of system and application software update 
USB, please contact your service partner for detail information.

25. 5146055 NA USB Cable for ECG

Others

26. 5728576 H48832AC Wireless Adaptor

27. 5933000-S H48962CG NetGear Wireless USB Adapter A8000 for Service (Only for 
software version R2.0.8 and above)

28. 5877024 H48122BT Bluetooth Adaptor

29. 5449275-4 H48312BJ Transcend TS8XDVDS-K DVDRW kit 

30. 5434317-4 H48492AB 1TB mobile USB HDD-CRU

31. 5780913-S NA EMI filter-CRU

32. 5792464-S NA Isolation USB kit-CRU

33. NA E8390AA Digital Expert Hardware Kit (includes Microsoft Surface Tablet)

34. NA E8390AC Digital Expert Cables and Video Grabber

35. NA HG11VCL Digital Expert Connect – License Term

Table 9-3:  Peripherals for Versana Balance

Item Part Number
Commercial 
Part Number Description



Renewal Parts Lists

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 9-9
5866796-100 English Rev.12

Power Cord

NOTE: Cable clip for Table 9-4 power cord should be installed in the 
hole 1, refer to Figure 9-4.

Figure 9-4. Cable clip installation

Table 9-4:  Power Cords for Versana BalanceTM/Versana BalanceTM Vet

Item Part Number
Commercial 
Part Number Description

1. 5177123-2 H48482AF AC Power Cord Europe-CRU

2. 5176304-2 H48482AK AC Power Cord China-CRU

3. 5176773-2 H48482AH AC Power Cord India-CRU

4. 5177195-2 H48482AC AC Power Cord Argentina-CRU

5. 5176907-2 H48482AG AC Power Cord UK-CRU

6. 5177153-2 H48482AM AC Power Cord Denmark-CRU

7. 5177154-2 H48482AD AC Power Cord Switzerland-CRU

8. 5177187-2 H48482AE AC Power Cord Australia-CRU

9. 5177146-2 H48482AL AC Power Cord USA-CRU

10. 5400868-2 H48482AN AC Power Cord Brazil-CRU

11. 5176753-2 H48482AJ AC Power Cord Israel-CRU

12. 5177126-2 H48482AB AC Power Cord Japan-CRU

Table 9-5:  Power Cords for Versana BalanceTM/Versana BalanceTM Vet

Item
Part 

Number
Commercial 
Part Number Description

13. 6736103-2 H48502AT PWR SPLY CRD BRAZIL 10A 250V STRAIGHT 2.5M
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NOTE: Cable clip for Table 9-5 power cord should be installed in the 
hole 1, refer to Figure 9-5.

Figure 9-5. Cable clip installation

14. 6736105-2 H48502AW PWR SPLY CRD EUROPE KOREA 10A 250V STRAIGHT 
2.5M

15. 6736106-2 H48502AY PWR SPLY CRD DENMARK 10A 250V STRAIGHT 2.5M

16. 6736115-2 H48532AY Power Cord Denmark Hospital Grade

17. 6736109-2 H48502AZ PWR SPLY CRD ISRAEL 10A 250V STRAIGHT 2.5M

18. 6736111-2 H48512AA PWR SPLY CRD JAPAN 12A 125V STRAIGHT 2.5M

19. 6736101-2 H48512AC PWR SPLY CRD ARGENTINA 10A 250V STRAIGHT 2.5M

20. 6736102-2 H48512AD PWR SPLY CRD ANZ 10A 250V STRAIGHT 2.5M

21. 6736104-2 H48512AE PWR SPLY CRD CHINA 10A 250V STRAIGHT 2.5M

22. 5736107-2 H48512AF PWR SPLY CRD UK IRELAND 10A 250V STRAIGHT 2.5M

23. 6736108-2 H48512AG PWR SPLY CRD INDIA 10A 250V STRAIGHT 2.5M

24. 6736113-2 H48512AJ PWR SPLY CRD SWITZERLAND 10A 250V STRAIGHT 
2.5M

25. 6736114-2 H48512AK PWR SPLY CRD UNITED STATES - CANADA 10A 125V 
STRAIGHT 2.5M

Table 9-5:  Power Cords for Versana BalanceTM/Versana BalanceTM Vet

Item
Part 

Number
Commercial 
Part Number Description
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Manuals

Table 9-6:  Manuals for Versana BalanceTM/Versana BalanceTM Vet

Item Part Number Description Qty FRU

1. 5866800 Versana Balance R2 e-manual USB flash drive 1 N

2. 5866783-100 Versana Balance R2 Advanced Reference Manual English 
Version

1 N

3. 5866783-101 Versana Balance R2 Advanced Reference Manual French 
Version

1 N

4. 5866796-100 Versana BalanceTM/Versana BalanceTM Vet R2 Basic 
Service Manual

1 N

5. 5866744-100 Versana Balance R2 User Manual English version 1 N

6. 5866744-101 Versana Balance R2 User Manual French version 1 N

7. 5866744-106 Versana Balance R2 User Manual Spanish version 1 N

8. 5866744-108 Versana Balance R2 User Manual German version 1 N

9. 5866744-111 Versana Balance R2 User Manual Italian version 1 N

10. 5866744-121 Versana Balance R2 User Manual Dutch version 1 N

11. 5866744-127 Versana Balance R2 User Manual Brazilian Portuguese 
version

1 N

12. 5866744-129 Versana Balance R2 User Manual Estonian version 1 N

13. 5866744-131 Versana Balance R2 User Manual Slovenian version 1 N

14. 5866744-140 Versana Balance R2 User Manual Japanese version 1 N

15. 5866744-141 Versana Balance R2 User Manual Chinese version 1 N

16. 5866744-142 Versana Balance R2 User Manual Swedish version 1 N

17. 5866744-144 Versana Balance R2 User Manual Korean version 1 N

18. 5866744-145 Versana Balance R2 User Manual Russian version 1 N

19. 5866744-150 Versana Balance R2 User Manual Polish version 1 N

20. 5866744-151 Versana Balance R2 User Manual Greek version 1 N

21. 5866744-153 Versana Balance R2 User Manual Hungarian version 1 N

22. 5866744-154 Versana Balance R2 User Manual Slovakian version 1 N

23. 5866744-155 Versana Balance R2 User Manual Czech version 1 N

24. 5866744-159 Versana Balance R2 User Manual Turkish version 1 N

25. 5866744-160 Versana Balance R2 User Manual Danish version 1 N

26. 5866744-161 Versana Balance R2 User Manual Norwegian version 1 N
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27. 5866744-162 Versana Balance R2 User Manual Finnish version 1 N

28. 5866744-165 Versana Balance R2 User Manual Bulgarian version 1 N

29. 5866744-167 Versana Balance R2 User Manual Romanian version 1 N

30. 5866744-168 Versana Balance R2 User Manual Croatian version 1 N

31. 5866744-174 Versana Balance R2 User Manual Lithuanian version 1 N

32. 5866744-175 Versana Balance R2 User Manual Latvian version 1 N

33. 5866744-176 Versana Balance R2 User Manual Serbian version 1 N

34. 5866744-177 Versana Balance R2 User Manual European Portuguese 
version

1 N

35. 5866744-180 Versana Balance R2 User Manual Ukrainian version 1 N

36. 5866744-181 Versana Balance R2 User Manual Indonesian version 1 N

37. 5866744-183 Versana Balance R2 User Manual Vietnamese version 1 N

38. 5866744-184 Versana Balance R2 User Manual Kazakh version 1 N

39. 5866780-100 Versana Balance R2 Release Notes English version 1 N

40. 5866780-101 Versana Balance R2 Release Notes French version 1 N

41. 5866780-106 Versana Balance R2 Release Notes Spanish version 1 N

42. 5866780-108 Versana Balance R2 Release Notes German version 1 N

43. 5866780-111 Versana Balance R2 Release Notes Italian version 1 N

44. 5866780-121 Versana Balance R2 Release Notes Dutch version 1 N

45. 5866780-127 Versana Balance R2 Release Notes Brazilian Portuguese 
version

1 N

46. 5866780-129 Versana Balance R2 Release Notes Estonian version 1 N

47. 5866780-131 Versana Balance R2 Release Notes Slovenian version 1 N

48. 5866780-140 Versana Balance R2 Release Notes Japanese version 1 N

49. 5866780-141 Versana Balance R2 Release Notes Chinese version 1 N

50. 5866780-142 Versana Balance R2 Release Notes Swedish version 1 N

51. 5866780-144 Versana Balance R2 Release Notes Korean version 1 N

52. 5866780-145 Versana Balance R2 Release Notes Russian version 1 N

53. 5866780-150 Versana Balance R2 Release Notes Polish version 1 N

54. 5866780-151 Versana Balance R2 Release Notes Greek version 1 N

55. 5866780-153 Versana Balance R2 Release Notes Hungarian version 1 N

Table 9-6:  Manuals for Versana BalanceTM/Versana BalanceTM Vet

Item Part Number Description Qty FRU
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56. 5866780-154 Versana Balance R2 Release Notes Slovakian version 1 N

57. 5866780-155 Versana Balance R2 Release Notes Czech version 1 N

58. 5866780-159 Versana Balance R2 Release Notes Turkish version 1 N

59. 5866780-160 Versana Balance R2 Release Notes Danish version 1 N

60. 5866780-161 Versana Balance R2 Release Notes Norwegian version 1 N

61. 5866780-162 Versana Balance R2 Release Notes Finnish version 1 N

62. 5866780-165 Versana Balance R2 Release Notes Bulgarian version 1 N

63. 5866780-167 Versana Balance R2 Release Notes Romanian version 1 N

64. 5866780-168 Versana Balance R2 Release Notes Croatian version 1 N

65. 5866780-174 Versana Balance R2 Release Notes Lithuanian version 1 N

66. 5866780-175 Versana Balance R2 Release Notes Latvian version 1 N

67. 5866780-176 Versana Balance R2 Release Notes Serbian version 1 N

68. 5866780-177 Versana Balance R2 Release Notes European Portuguese 
version

1 N

69. 5866780-180 Versana Balance R2 Release Notes Ukrainian version 1 N

70. 5866780-181 Versana Balance R2 Release Notes Indonesian version 1 N

71. 5866780-183 Versana Balance R2 Release Notes Vietnamese version 1 N

72. 5866780-184 Versana Balance R2 Release Notes Kazakh version 1 N

73. 5866780-184 Versana Balance R2 Vet Advanced Reference Manual 1 N

74. 5932993 Versana Balance R2 Vet e-manual USB Flash Drive 1 N

75. 5926972-100 Versana Balance R2 Vet User Manual English Version 1 N

76. 5926972-101 Versana Balance R2 Vet User Manual French Version 1 N

77. 5926972-106 Versana Balance R2 Vet User Manual Spanish Version 1 N

78. 5926972-108 Versana Balance R2 Vet User Manual German Version 1 N

79. 5926972-111 Versana Balance R2 Vet User Manual Italian Version 1 N

80. 5926972-121 Versana Balance R2 Vet User Manual Dutch Version 1 N

81. 5926972-127 Versana Balance R2 Vet User Manual Brazilian Portuguese 
Version

1 N

82. 5926972-129 Versana Balance R2 Vet User Manual Estonian Version 1 N

83. 5926972-131 Versana Balance R2 Vet User Manual Slovenian Version 1 N

84. 5926972-140 Versana Balance R2 Vet User Manual Japanese Version 1 N

Table 9-6:  Manuals for Versana BalanceTM/Versana BalanceTM Vet

Item Part Number Description Qty FRU
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85. 5926972-141 Versana Balance R2 Vet User Manual Chinese Version 1 N

86. 5926972-142 Versana Balance R2 Vet User Manual Swedish Version 1 N

87. 5926972-144 Versana Balance R2 Vet User Manual Korean Version 1 N

88. 5926972-145 Versana Balance R2 Vet User Manual Russian Version 1 N

89. 5926972-150 Versana Balance R2 Vet User Manual Polish Version 1 N

90. 5926972-151 Versana Balance R2 Vet User Manual Greek Version 1 N

91. 5926972-153 Versana Balance R2 Vet User Manual Hungarian Version 1 N

92. 5926972-154 Versana Balance R2 Vet User Manual Slovakian Version 1 N

93. 5926972-155 Versana Balance R2 Vet User Manual Czech Version 1 N

94. 5926972-159 Versana Balance R2 Vet User Manual Turkish Version 1 N

95. 5926972-160 Versana Balance R2 Vet User Manual Danish Version 1 N

96. 5926972-161 Versana Balance R2 Vet User Manual Norwegian Version 1 N

97. 5926972-162 Versana Balance R2 Vet User Manual Finnish Version 1 N

98. 5926972-165 Versana Balance R2 Vet User Manual Bulgarian Version 1 N

99. 5926972-167 Versana Balance R2 Vet User Manual Romanian Version 1 N

100. 5926972-168 Versana Balance R2 Vet User Manual Croatian Version 1 N

101. 5926972-174 Versana Balance R2 Vet User Manual Lithuanian Version 1 N

102. 5926972-175 Versana Balance R2 Vet User Manual Latvian Version 1 N

103. 5926972-176 Versana Balance R2 Vet User Manual Serbian Version 1 N

104. 5926972-177 Versana Balance R2 Vet User Manual European Portuguese 
Version

1 N

105. 5926972-180 Versana Balance R2 Vet User Manual Ukrainian Version 1 N

106. 5926972-181 Versana Balance R2 Vet User Manual Indonesian Version 1 N

107. 5926972-183 Versana Balance R2 Vet User Manual Vietnamese Version 1 N

108. 5926972-184 Versana Balance R2 Vet User Manual Kazakh Version 1 N

Table 9-6:  Manuals for Versana BalanceTM/Versana BalanceTM Vet

Item Part Number Description Qty FRU
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Chapter 10

Care and Maintenance

This chapter describes Care and Maintenance on the 
Ultrasound system and peripherals. These procedures 
are intended to maintain the quality of the Ultrasound 
system’s performance. Read this chapter completely 
and familiarize yourself with the procedures before 
performing a task.
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Overview

Contents in this chapter

• ‘Overview’ on page 10-2
• ‘Warnings’ on page 10-3
• ‘Why do maintenance’ on page 10-4
• ‘Maintenance task schedule’ on page 10-5
• ‘Tools required’ on page 10-7
• ‘System maintenance’ on page 10-11
• ‘Electrical safety tests’ on page 10-20
• ‘When there's too much leakage current …’ on page 10-31
• ‘Inspection Paperwork’ on page 10-33
• ‘Electrical Safety Tests Log’ on page 10-35
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Warnings

DANGER
 

BE SURE TO DISCONNECT THE ULTRASOUND SYSTEM 
POWER PLUG AND OPEN THE MAIN CIRCUIT BREAKER 
BEFORE YOU REMOVE ANY PARTS. BE CAUTIOUS 
WHENEVER POWER IS STILL ON AND COVERS ARE 
REMOVED.

CAUTION Practice good ESD prevention. Wear an anti–static strap when 
handling electronic parts and even when disconnecting/
connecting cables.

CAUTION Do not pull out or insert circuit boards while power is on.

CAUTION Do not operate this Ultrasound system unless all board covers 
and frame panels are securely in place. System performance 
and cooling require this.
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Why do maintenance

Preventive maintenance inspections

It has been determined by engineering that your Versana 
BalanceTM/Versana BalanceTM Vet does not have any high 
wear components that fail with use, therefore no Preventive 
Maintenance inspections are mandatory. 

However, some customers’ Quality Assurance Programs may 
require additional tasks and or inspections at a different 
frequency than listed in this manual.

Quality assurance

In order to gain accreditation from organizations such as the 
American College of Radiology (USA), it is the customer’s 
responsibility to have a quality assurance program in place for 
each Ultrasound system. The program must be directed by a 
medical physicists, the supervising radiologist/physician or 
appropriate designee.

Routine quality control testing must occur regularly. The same 
tests are performed during each period so that changes can be 
monitored over time and effective corrective action can be 
taken.

Testing results, corrective action and the effects of corrective 
action must be documented and maintained on the site.

Your GE service representative can help you with establishing, 
performing and maintaining records for a quality assurance 
program. Contact GE for coverage and/or price for service.



Maintenance task schedule

Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual 10-5
5866796-100 English Rev.12

Maintenance task schedule

How often should maintenance tasks be performed?

The Care and Maintenance task schedule (provided in 
Table 10-1 on page 10-5) specifies how often your Versana 
BalanceTM/Versana BalanceTM Vet should be serviced and 
outlines items requiring special attention.

NOTE: It is the customer’s responsibility to ensure the Versana 
BalanceTM/Versana BalanceTM Vet care and maintenance is 
performed as scheduled in order to retain its high level of safety, 
dependability and performance.

Your GE Service Representative has an in-depth knowledge of 
your Versana BalanceTM/Versana BalanceTM Vet and can 
best provide competent, efficient service. Contact GE for 
coverage information and/or price for service.

The service procedures and recommended intervals shown in 
the Care and Maintenance Task Schedule assumes that you 
use your Versana BalanceTM/Versana BalanceTM Vet for an 
average patient load (15 per day) and not use it as a primary 
mobile Ultrasound system which is transported between 
diagnostic facilities.

NOTE: If conditions exist which exceed typical usage and patient load, 
then it is recommended to increase the care and maintenance 
frequencies.

Table 10-1:  Customer Care Schedule 

Service at Indicated 
Time Daily Weekly Monthly

Per 
Facilities 

QA 
Program Notes

Clean Probes •* * or before each use

Inspect AC Mains Cable •

Inspect Cables and 
Connectors

•

Clean Console •

Clean Monitor •
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NOTE: The maintenance may require specialized equipment to 
complete.

NOTE: The care and maintenances are not mandatory. The table above 
is for reference only.

Clean Filters •

Console Leakage Current 
Checks

See Notes Twice Annually

Peripheral Leakage 
Current Checks

See Notes Twice Annually

Surface Probe Leakage 
Current Checks

See Notes Twice Annually

Endocavity Probe Leakage 
Current Checks

See Notes Quarterly Annually

Surgical Probe Leakage 
Current Checks

See Notes Quarterly Annually

Measurement Accuracy 
Checks

See Notes Twice Annually

Functional Checks See Notes also after corrective 
maintenance

Table 10-1:  Customer Care Schedule  (Continued)

Service at Indicated 
Time Daily Weekly Monthly

Per 
Facilities 

QA 
Program Notes
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Tools required

NOTE: For a list of required tools for servicing the Versana 
BalanceTM/Versana BalanceTM Vet, refer to chapter 8.

Standard GE tool kit

The following is a description of the “Standard” GE tool kit in the 
USA. Not all tools are required.

Table 10-2:  Overview of GE-1 tool kit contents 

Tool ID Description Tool ID Description

9-45358 Pliers Retaining Ring 9-XL9971MM Xcelite-hex Blade 1.27mm

9-4078 Scribe 9-XL9972MM Xcelite-hex Blade 1.5mm

9-44572 Wrench Open End 3/8 - 7/16 9-XL9973MM Xcelite-hex Blade 2 mm

9-44579 Wrench Open End 1/2 - 9/16 9-XL9974MM Xcelite-hex Blade 2.5mm

9-44579 Wrench Open End 1/2 - 9/16 9-XL9975MM Xcelite-hex Blade 3mm

9-45385 Pliers, Arc Joint 7 inch 9-XL9976MM Xcelite-hex Blade 4mm

9-45378 Pliers, Slip Joint 9-XL9977MM Xcelite-hex Blade 5mm

9-4518 Pliers, Long Nose, Miniature 9-XL991CM Handle

9-4518 Pliers, Long Nose, Miniature C2356E Screw starter - Kedman 
Quick Wedge

9-44776 Ignition Wrench Set, 10 pc. BLBO Box - 18 Compartment 

9-44601 Wrench, Adj., 4 inch DWL4283T Box - 5 Compartment

9-4151 Screwdriver, Blade, Stubby 9-41322 Pickup Tool, Claw type

9-41421 Screwdriver, Blade, Pocket clip 9-6757 6 pc Needle File Set

9-41594 Screwdriver, Blade 1/8 in. × 4 in. 9-9487 Utility Knife

9-41581 Screwdriver, Blade 3/16 in. × 4 in. 9-45341 Pliers Vice Grip 10 inch

9-39451 20' Steel Tape, locking Spring load 9-3001 Xacto Pen Knife

9-GH807 Ratchet, Offset, Slotted 9-HT62002 Solder Aid, Fork and Hook

68-412 Ratchet, Offset, Phillips 9-4099 Mirror, Round, Telescoping
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9-GH130 Tapered Reamer 9-GH3001 Steel Rule Decimal 6 inch

9-41584 Screwdriver, slotted 1/4 in. × 6 in. 9-GH300ME Steel Rule Metric 6 inch

9-4118 Screwdriver, Phillips #2, Stubby 9-XL9920 Xcelite-hex Blade.050 inch

9-41293 Screwdriver, Phillips #0 9-XL9921 Xcelite-hex Blade 1/16 inch

9-41294 Screwdriver, Phillips #1 9-XL9922 Xcelite-hex Blade 5/16 inch

9-41295 Screwdriver, Phillips #2 9-XL9923 Xcelite-hex Blade 3/32 inch

9-46677 Hex Keys, 20 pc., Metric 9-XL9924 Xcelite-hex Blade 1/8 inch

9-34701 1/4 in. Standard Socket set (19 pc) 9-XL9925 Xcelite-hex Blade 5/32 inch

9-43499 1/2 inch Socket 1/4 inch drive 9-XL9926 Xcelite-hex Blade 3/16 inch

9-4355 Flex Spinner 9-XL99764 Xcelite-hex Blade 7/64

9-43523 Breaker 9-XL99964 Xcelite-hex Blade 9/64

9-43531 6 inch Ext. 9-XLM60 Mini-screwdriver kit

9-65283 Case 8.5 in. × 4.5 in. × 2 in. Deep 9-45072 Pliers 6 inch Diagonal

9-46696 Hex Keys 9-XL100X Wire Stripper/Cutter 5 inch - 
100X

9-39829 Torpedo Level, Magnetic 9-XL87CG Pliers - very fine needle 
nose-87CG

9-38461 Hammer, Ball Peen, 4 oz. 9-WEWDT-07 Weller-Soldering-Replacem
ent Tip(1)

9-4280 Universal Joint 1/4 inch 9-WS175-E Wiss - Surgical Scissors

9-WEW60P3 Weller - Soldering Iron, 3 wire KH174 Hemostat 5 inch Straight 

9-WECT5B6 Weller - Soldering Iron Tip KH175 Hemostat 5 inch curved

9-WEWDP12 Weller - Desoldering Pump 9-Z9480121 Alignment tool (red)

93383 Flashlight Mini-Mag Lite (AAA Bat.)

9-GH408 Tweezers

21576 Brush - Bristle

9-4516 Pliers 4 1/4 inch Diagonal

Table 10-2:  Overview of GE-1 tool kit contents  (Continued)

Tool ID Description Tool ID Description
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GE-2 tool kit

Table 10-3:  Overview of GE-2 tool kit contents 

GE-2 Sears Kit (#99034) 

Tool ID Description Tool ID Description

9-45381 Pliers, Arc Joint 9 1/2 inch 9-44067 Socket 1 1/16 in. for 1/2 in. drive

9-45092 Pliers, Linesman 8 1/2 inch 9-42679 Socket 10MM Hex for 1/2 in. drive 
(2273333) 

9-42882 Punch, Pin 3/32 inch 9-44262 Extension 10 inch for 1/2 in. drive 
(2273405)

9-42884 Punch, Pin 5/32 inch 9-4258 3/8 inch to 1/2 inch Adapter

9-42886 Punch, Pin 1/4 inch 9-34374 3/8 inch Metric Socket Set - 12 PT

9-42973 Cold Chisel 1/2 inch 9-44311 16mm Socket 12 pt.

9-GH77 Center Punch Automatic 9-33485 Metal Socket Tray

9-GH890 File Handle, Adj. 9-33484 Metal Socket Tray

9-31276 File, Round, Bastard 8 inch 9-33484 Metal Socket Tray

9-31277 File, Half Round, Bastard 8 inch 9-52068 Tap and Drill Set

9-31263 File, Flat Mill 8 inch 9-52722 #6 Tap

21045C Close Quarter Saw 9-52723 #8 Tap

9-44604 Wrench, Adj. 10 inch High Speed Drill Set

9-41587 Screwdriver 5/16 inch × 8 inch #36 Drill

9-41586 Screwdriver, Stubby 5/16 inch #29 Drill

9-GH19512 Countersink 1/2 inch 9-44046 3/8 inch Socket Set

9-44741 12 PC Combination Wrench Set



Care and Maintenance

10-10 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

Special tools, supplies and equipment used for maintenance

Table 10-4:  Overview of tool requirements for care and maintenance

Tool / kit Comments

Digital Volt Meter (DVM)

Anti Static Kit Kit includes anti–static mat, wrist strap and cables for 200 to 240V system
3M #2204 Large adjustable wrist strap
3M #2214 Small adjustable wrist strap
3M #3051 conductive ground cord

Anti Static Vacuum Cleaner 120V
230V

Safety Analyzer The safety Analyzer tool should be calibrated and compliant with AAMI/
ESI 1993 or IEC 60601 or AS/NZS 3551.

QIQ Phantom RMI Grayscale Target Model 403GS
NOTE! The use of a Phantom is not required during Care and 
Maintenance. Customer may use it as part of their Quality 
Assurance Program tests.

B/W Printer Cleaning Sheet See printer user manual for requirements

Color Printer Cleaning Sheet See printer user manual for requirements

Disposable Gloves
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System maintenance

Preliminary checks

The preliminary checks take about 15 minutes to perform. Refer 
to the Ultrasound system user documentation whenever 
necessary.

Table 10-5:  System preliminary checks

Step Item Description

1. Ask and Listen Ask the customer if they have any problems or questions about the 
equipment.

2. Paperwork Fill in the top of Ultrasound Inspection Certificate (see Figure 10-5 on 
page 10-33). Record all probes and Ultrasound system options.

3. Power up • Turn the Ultrasound system power on and verify that all fans and 
peripherals turn on. 

• Watch the displays during power up to verify that no warning or error 
messages are displayed.

• Where applicable, confirm that the battery is charged. If no AC Input 
present, use the internal battery.  

4. Probes Verify that the Ultrasound system properly recognizes all probes.

5. Displays Verify proper display on the monitor.

6. FFA (Server) Where applicable, for Warranty and Contract Customers only:
• Verify that InSite is functioning properly. 
• Ensure two-way remote communications.

7. Review Error Logs Where applicable, Error Logs can be reviewed via system diagnostics. 

8. Diagnostics Optional.

9. Presets Backup all Customer Presets to an appropriate media. 

10. Image Archive Back up the Image Archive onto appropriate media. 
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Functional checks

NOTE: See also Chapter 4

The functional checks take about 60 minutes to perform. Refer 
to the Ultrasound system user documentation whenever 
necessary.

System checks

Table 10-6:  System functional checks 

Step Item Description

1. B-Mode Verify basic B-Mode (2D) operation. Check the basic Ultrasound system 
controls that affect this mode of operation.

2. CF-Mode Verify basic CF-Mode (Color Flow Mode) operation. Check the basic 
Ultrasound system controls that affect this mode of operation.

3. Doppler Modes Verify basic Doppler operation (PW and CW if available). Check the basic 
Ultrasound system controls that affect this mode of operation.

4. M-Mode Verify basic M-Mode operation. Check the basic Ultrasound system 
controls that affect this mode of operation.

5. Probe Elements Perform an Element Test on each probe to verify that all the probe 
elements and system channels are functional. 

6. Applicable 
Software Options 

Verify the basic operation of all optional modes such as Contrast. Check 
the basic Ultrasound system controls that affect each options operation.

7. Xmit/Recv 
Elements

Use the Visual Channel Utility on the loop connect to verify that all system 
xmit/recv channels are functional.

8. Operator Panel 
test

Perform the Operator Panel Test Procedure.

9. Keyboard Do the interactive keyboard test.

10. Monitor Verify basic monitor display functions. Refer to Chapter 3 of the Basic 
User Manual.

11. Software Menu 
check

Verify Software Menu display functions. Refer to Chapter 3 of the Basic 
User Manual.

12. Peripherals See: ‘Peripheral checks’ on page 4-66.

13. Measurements In measurement mode, make distance measurement, get result in result 
window. Verify the distance by graduate rule. Distance Accuracy should 
be within ±5%. (Name result from result window Result A, result from 
graduate rule Result B; Distance Accuracy = (Result B-Result A)/Result A)
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Peripheral/option checks

If any peripherals or options are not part of the system 
configuration, the check can be omitted. 

Refer to the User Manual for a list of approved peripherals/
options.

Mains cable inspection 

Table 10-7:  GE approved peripheral/hardware option functional checks

Step Item Description

1. Media Verify media drive(s) read/write properlty. Clean if necessary.

2. B/W Printer Verify hardcopy output of the B/W video page printer. Clean heads and covers if 
necessary.

3. Color Printer Verify hardcopy output of the Color video page printer. Clean heads and covers if 
necessary.

4. DICOM Verify that DICOM is functioning properly. Send an image to a DICOM device.

5. ECG Verify basic operation with customer

6. Footswitch Verify that the footswitch is functioning as programed. Clean as necessary. 

7. DVD Verify that the DVD is functioning properly. Clean heads and covers if necessary.

Table 10-8:  Mains Cable Inspection, As Appropriate

Step Item Description

1. Unplug Cord Disconnect the mains cable from the wall and Ultrasound system.

2. Inspect Inspect it and its connectors for damage of any kinds.

3. Verify Verify that the LINE, NEUTRAL and GROUND wires are properly attached 
to the terminals, and that no strands may cause a short circuit.

4. Verify Inlet connector retainer is functional.
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Cleaning

For general cleaning of the system, we recommended to use 
non-abrasive soap and water solution.

Table 10-9:  General Cleaning

Step Item Description

1. Console Remove the battery. Use a fluid detergent in warm water on a soft, damp cloth 
to carefully wipe the entire system. Be careful not to get the cloth too wet so 
that moisture does not enter the console.

2. Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).

3. Monitor Use a soft, non-abrasive folder cloth. Gently wipe the monitor face. DO NOT 
use a glass cleaner that has a hydrocarbon base (such as Benzene, Methy 
Alcohol or Methy Ethyl Ketone) on monitor with the filter (anti-glare shield).

Table 10-10:  Compatible Chemicals for Cleaning

System
Cabinet

Operator
Control
Panel

Main
display

Touch
Screen

Probe
Holder

Cleaning agents

PDI Easy Screen Cleaning Wipe X X X X X

Wet Wipes X X X X X

70% isopropyl alcohol X X X X X

Disinfectants [1]

PDI Sani-Cloth Plus X X X X X

Protex X X X X X

Tristel Wipes X X X X X

Sono Ultrasound Wipes X X X X X

Clorox wipes X X X X X

CaviWipes X X X X X

PDI Super Sani-Cloth Plus X X X X X

PDI Easy Screen Cleaning Wipe X X X X X

[1]: Effective Disinfection is always a balance between safe inactivation of infectious agents and undesirable 
side effects. Due to the generally uneven and irregular surface of Ultrasound consoles, a comprehensive 
surface disinfection process cannot be recommended by the manufacturer.
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Physical inspection

NOTE: These features may not be present on all Ultrasound systems.  

Table 10-11:  Physical checks 

Step Item Description

1. Labeling Verify that all Ultrasound system labeling is present and in readable 
condition.

2. Scratches & Dents Inspect the exterior for dents, scratches or cracks.

3. Input Power Refer to: ‘Mains cable inspection’ on page 10-13.

4. Cables & 
Connectors

Check all internal cable harnesses and connectors for wear and secure 
connector seating. Pay special attention to footswitch assembly and probe 
strain or bend reliefs.

5. Shielding & 
Covers

Check to ensure that all EMI shielding, internal covers, air flow panels and 
screws are in place. Missing covers and hardware could cause EMI/RFI 
problems while scanning.

6. Control Panel Inspect keyboard and control panel. Note any damaged or missing items.

7. Control Panel 
Lighting

Check for proper operation of all operator panel and Freeze Key light.

8. Monitor Inspect the monitor Display for scratches and bad pixels.
Verify proper operation of Contrast and Brightness controls. 
Where applicable, confirm that the monitor arm allows:
• swivelling the screen to the left and to the right
• folding the screen to the locked position
• release and adjustment backwards and forwards
• can be adjusted in the up/down positions.
Note: Monitor Arm movement may vary and is not applicable to all 
Ultrasound systems. 

9. External I/O Check all connectors for damage.

10. Power and 
System Status 
Indicators

Check for proper operation of all Power and System Status Indicators.

11. Battery Where applicable, check that the battery is not damaged, does not leak, 
does not emit an odor, and is not deformed or discolored. Observe all 
warnings and cautions for battery handling, recharging, storing, and/or 
disposal,
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Optional Diagnostic Checks

Optionally you can access the diagnostic software as described 
in Chapter 5 or 7. View the error logs and run desired 
diagnostics.

View the Log

1. Review the system error log for any problems.
2. Check the temperature log to see if there are any trends that 

could cause problems in the future.
3. Check the Configuration Log; update if needed.
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Probe maintenance

Probe related checks

Basic probe care

The Ultrasound system user manuals and various probe 
handling cards provide a complete description of probe care, 
maintenance, cleaning and disinfection. Ensure that you are 
completely familiar with the proper care of GE probes.

Ultrasound probes can be easily damaged by improper 
handling. See the User Manual and probe care cards for more 
details. Failure to follow these precautions can result in serious 
injury and equipment damage. Failure to properly handle or 
maintain a probe may also void its warranty.

Any evidence of wear indicates the probe cannot be used.

Do a visual check of the probe pins and Ultrasound system 
sockets before plugging in a probe.

The Interoperative probes often have special considerations and 
individual probe user manuals. For Interoperative probes also 
refer to their separate user manuals.

Table 10-12:  System preliminary checks

Step Item Description

1. Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).

2. Probes Thoroughly check the Ultrasound system probe connectors and remove 
dust from inside the connector sockets if necessary. Visually check for 
bent, damaged or missing pins.

3. Probes Verify that the Ultrasound system properly recognizes all probes.
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Basic probe cleaning

To clean the probe:

1. Disconnect the probe from the ultrasound console and 
remove all coupling gel from the probe by wiping with a soft 
cloth and rinsing with flowing water.

2. Wash the probe with mild soap in lukewarm water. Scrub the 
probe as needed using a soft sponge, gauze, or cloth to 
remove all visible residue from the probe surface. Prolonged 
soaking or scrubbing with a soft bristle brush (such as a 
toothbrush) may be necessary if material has dried onto the 
probe surface.

3. Rinse the probe with enough clean potable water to remove 
all visible soap residue.

4. Air dry or dry with a soft cloth.

CAUTION Do not submerge the probe above the probe as the strain relief 
is not sealed. Do not allow fluid into or onto the connector of 
the probe.

CAUTION Take extra care when handling the lens face of the Ultrasound 
transducer. The lens face is especially sensitive and can easily 
be damaged by rough handling. NEVER use excessive force 
when cleaning the lens face.

WARNING To help protect yourself from blood borne diseases, wear 
approved disposable gloves. These are made of nitrile derived 
from vegetable starch to prevent allergic latex reactions.

CAUTION Failure to follow the prescribed cleaning or disinfection 
procedures will void the probe’s warranty. 

DO NOT soak or wipe the lens with any product not listed in the 
User Manual. Doing so could result in irreparable damage to 
the probe. 

Follow care instructions that came with the probe.

CAUTION Disinfect a defective probe before you return it. Be sure to tag 
the probe as being disinfected.
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Disinfecting probes

Ultrasound probes can be disinfected using liquid chemical 
germicides. The level of disinfection is directly related to the 
duration of contact with the germicide. Increased contact time 
produces a higher level of disinfection.

Refer to User Manual for detail on disinfecting probes.

CAUTION Review the probe care card that is packed with each probe. 
The following website contains the most current and up-to-date 
recommendations:

http://www.gehealthcare.com/usen/ultrasound/products/
probe_care.html
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Electrical safety tests

Safety test overview

The electrical safety tests in this section are based on and 
conform to IEC 60601-1 Medical Equipment Safety Standards. 
They are intended for the electrical safety evaluation of 
cord-connected, electrically operated, patient care equipment. If 
additional information is needed, refer to the IEC 60601-1 
documents

WARNING THE USER MUST ENSURE THAT THE SAFETY 
INSPECTIONS ARE PERFORMED AT LEAST EVERY 
12 MONTHS ACCORDING TO HISTORICAL DATA. 
ONLY TRAINED PERSONS ARE ALLOWED TO 
PERFORM THE SAFETY INSPECTIONS MENTIONED 
ABOVE.

DANGER TO MINIMIZE RISK OF ELECTRICAL SHOCK, ONLY 
TRAINED PERSONS ARE ALLOWED TO PERFORM THE 
ELECTRICAL SAFETY INSPECTIONS AND TESTS.

DANGER TO AVOID ELECTRICAL SHOCK, THE ULTRASOUND 
SYSTEM UNDER TEST MUST NOT BE CONNECTED TO 
OTHER ELECTRICAL EQUIPMENT. REMOVE ALL 
INTERCONNECTING CABLES AND WIRES. THE 
ULTRASOUND SYSTEM UNDER TEST MUST NOT BE 
CONTACTED BY USERS OR PATIENTS WHILE 
PERFORMING THESE TESTS.

CAUTION Possible risk of infection. Do not handle soiled or contaminated 
probes and other components that have been in patient 
contact. Follow appropriate cleaning and disinfecting 
procedures before handling the equipment.
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Safety test overview(continued)

Prior to initiating any electrical test, the Ultrasound system must 
be visually inspected. Perform the following visual checks:

• Check for missing or loose enclosure covers that could 
allow access to internal live parts.

• Examine the mains cord, mains plug and appliance inlet for 
damaged insulation and adequacy of strain relief and cable 
clamps.

• Locate and examine all associated transducers. Inspect the 
cables and strain relief at each end. Inspect the transducer 
enclosure and lens for cracks, holes and similar defects.

Test the system, peripherals and probes for leakage current. 
Excessive leakage current can cause injury or death in sensitive 
patients. High leakage current can also indicate degradation of 
insulation and a potential for electrical failure. Do not use probes 
or equipment having excessive leakage current.

To minimize the risk that a probe may shock someone the 
customer should:

• Not use a probe that is cracked or damaged in any way.
• Check probe leakage current:

• Based on your facilities QA program for surface probes.
• Based on your facilities QA program for endocavitary 

probes.
• whenever probe damage is suspected.
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Leakage current limits

The following limits are summarized for IEC 60601-1 Medical 
Equipment Safety Standards. These limits are GEMS standards 
and in some cases are lower than the above standards listed.

WARNING Energy Control and Power Lockout for Versana BalanceTM/
Versana BalanceTM Vet.

When servicing parts of the Ultrasound system where there is 
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures. 
2. Turn off the breaker.
3. Unplug the Ultrasound system.
4. Maintain control of the Ultrasound system power plug.
5. Wait for at least 30 seconds for capacitors to discharge as 

there are no test points to verify isolation.   
6. Remove/disconnect the battery, if present. 

Ultrasound System components may be energized. 

CAUTION Compare all safety-test results with safety-test results of 
previously performed safety tests (e.g. last year etc). In case of 
unexplainable abrupt changes of safety-test results consult 
experienced authorized service personnel or GE for further 
analysis. 

Table 10-13:  Chassis Leakage Current Limits - Accessible Metal Surface

Country
Normal 

Condition
Open 

Ground
Reverse 
Polarity

Open 
Neutral

All (Except USA & Canada) 0.1 mA 0.5 mA 0.5 mA 0.5 mA

USA & Canada 0.1 mA 0.3 mA 0.3 mA 0.3 mA

Table 10-14:  Type BF Applied Part Leakage Current Limits - Probes Surface

Country
Normal 

Condition
Open 

Ground
Reverse 
Polarity

Open 
Neutral

*Mains 
Applied

All 0.1 mA 0.5 mA 0.5 mA 0.5 mA 5.0 mA
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Leakage current limits(continued)

NOTE: *Mains Applied refers to the sink leakage test where mains 
(supply) voltage is applied to the part to determine the amount of 
current that will pass (or sink) to ground if a patient contacted 
mains voltage.

The following tests are performed at the factory and should be 
performed at the site. These tests are: chassis leakage current, 
and probe leakage current. All measurements are made with an 
electrical safety analyzer which should be calibrated and 
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

Table 10-15:  Type CF Applied Part Leakage Current Limits - ECG Connections

Country
Normal 

Condition
Open 

Ground
Reverse 
Polarity

Open 
Neutral

*Mains 
Applied

All 0.1 mA 0.5 mA 0.5 mA 0.5 mA 5.0 mA

Table 10-16:  Equipment Type and Test Definitions 

Applied 
Parts 
(AP)

Parts or accessories that contact the patient to 
perform their function. For ultrasound equipment, 
this includes transducers and ECG leads.

Type BF Body Floating or 
non-conductive ultrasound 
probes which are marked 
with the 'man in box' BF 
symbol. this includes all 
transducers.

Type CF Cardiac Floating or 
non-conductive 
intraoperative probes for 
direct cardiac contact and 
isolated ECG connections 
so marked with the 'heart in 
box' CF symbol.

Sink 
Leakage

The current resulting from the application of mains 
voltage to the applied part. This test is required 
test for Type CF applied parts.
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Outlet test - wiring arrangement

Test all outlets in the area for proper grounding and wiring 
arrangement by plugging in the neon outlet tester and noting the 
combination of lights that are illuminated. Any problems found 
should be reported to the hospital immediately and the 
receptacle should not be used.

 Figure 10-1. Typical alternate outlet tester

NOTE: No outlet tester can detect the condition where the Neutral 
(grounded supply) conductor and the Grounding (protective 
earth) conductor are reversed. If later tests indicate high leakage 
currents, this should be suspected as a possible cause and the 
outlet wiring should be visually inspected.

CORRECT WIRING OPEN GROUND WIRE

REVERSED POLARITY OPEN NEUTRAL WIRE

HOT AND GROUND 
REVERSED

OPEN HOT WIRE
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Grounding continuity

Measure the resistance from the third pin of the attachment plug 
to the exposed metal parts of the case. The ground wire 
resistance should be less than 0.2 ohms. Reference the 
procedure in the IEC60601-1.

Figure 10-2. Ground continuity test

1. GROUND PIN
2. OHMMETER
3. Versana BalanceTM/Versana BalanceTM Vet
4. ACCESSIBLE METAL PART:

• MONITOR HOUSING
• PEAR PANEL CONNECTOR
• ANY CASTER/WHEEL SUPPORT

DANGER ELECTRIC SHOCK HAZARD. THE PATIENT MUST NOT BE 
CONTACTED TO THE EQUIPMENT DURING THIS TEST.
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Chassis leakage current test

Generic procedure

The test verifies the isolation of the power line from the chassis. 
The testing meter is connected from accessible metal parts of 
the case to ground. Measurements should be made with the unit 
ON and OFF, with the power line polarity Normal and Reversed. 
Record the highest reading of current.

 Figure 10-3. Set Up for Chassis Source Leakage Current, IEC 601-1 Clause 19 - 
Continuos Leakage Currents and Patient, Auxiliary Currents

When using the Microguard or a similar test instrument, its 
power plug may be inserted into the wall outlet and the 
equipment under test is plugged into the receptacle on the panel 
of the meter. This places the meter in the grounding conductor 
and the current flowing from the case to ground will be indicated 
in any of the current ranges. The maximum allowable limit for 
chassis source leakage is shown in Table 10-13 on page 10-22.

DANGER ELECTRIC SHOCK HAZARD. WHEN THE METER'S 
GROUND SWITCH IS OPEN, DON'T TOUCH THE 
ULTRASOUND SYSTEM!.

CAUTION Equipment damage possibility. Never switch the Polarity and 
the status of Neutral when the Ultrasound system is powered 
ON. Be sure to turn the Ultrasound system power OFF before 
switching them using the POLARITY switch and/or the 
NEUTRAL switch. Otherwise, the Ultrasound system may be 
damaged.
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Data Sheet for enclosure Source Leakage Current

The test passes when all readings measure less than the value 
shown in Table 10-13 on page 10-22. Record all data on the PM 
Inspection Certificate.

Table 10-17:  Typical Data Sheet for enclosure Source Leakage Current

Unit 
Power

Tester 
Polarity 
Switch

Tester 
Neutral 

or 
Ground 
Switch

Test 1 
Speaker 
Cover

Test 2 Real 
Panel Metal 

Parts
Optional 

Test 3 
Optional 

Test 4

Enter Name of tested peripheral here:

ON NORM OPEN

ON NORM CLOSED

ON REV OPEN

ON REV CLOSED

OFF NORM OPEN

OFF NORM CLOSED

OFF REV OPEN

OFF REV CLOSED
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Probe leakage current test

Definition

This test measures the current that would flow to ground from 
any of the probes through a patient who is being scanned and 
becomes grounded by touching some other grounded surface.

NOTE: Some leakage current is expected on each probe, depending on 
its design. Small variations in probe leakage currents are normal 
from probe to probe. Other variations will result from differences 
in line voltage and test lead placement. It is abnormal if no 
leakage current is measured. If no leakage current is detected, 
check the configuration of the test equipment.

Tools

For needed tools, see: ‘Tools required’ on page 10-7.

DANGER
 

DO NOT USE THE PROBE IF THE INSULATING MATERIAL 
HAS BEEN PUNCTURED OR OTHERWISE COMPROMISED.

INTEGRITY OF THE INSULATION MATERIAL AND PATIENT 
SAFETY CAN BE VERIFIED BY SAFETY TESTING 
ACCORDING TO IEC60601-1.

CAUTION Equipment damage possibility. Never switch the Polarity and 
the status of Neutral when the Ultrasound system is powered 
ON. Be sure to turn the Ultrasound system power OFF before 
switching them using the POLARITY switch and/or the 
NEUTRAL switch. Otherwise, the Ultrasound system may be 
damaged.
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Generic procedure on probe leakage current

Measurements should be made with the ground open and 
closed, with power line polarity normal and reversed, and with 
the unit Off and On. For each combination, the probe must be 
active to find the worst case condition.

 Figure 10-4. Set up for probe leakage current

NOTE: Each probe will have some amount of leakage current, 
dependent on its design. Small variations in probe leakage 
currents are normal from probe to probe. Other variations will 
result from differences in line voltage and test lead placement.

Meter Procedure Using Probe Adapter

Follow the Safety Analyzer tool instruction to test each 
transducer for leakage current.

The electrical Safety Analyzer tool should be calibrated and 
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

POWER
OUTLET

H   (BLACK)
POLARITY REVERSING SWITCH

MOMENTARY
SWITCH

N   (WHITE)

G   (GREEN)

LEAKAGE TEST
METER

CONSOLE

PROBE

DANGER TO AVOID PROBE DAMAGE AND POSSIBLE ELECTRIC 
SHOCK, DO NOT IMMERSE PROBES INTO ANY LIQUID 
BEYOND THE LEVEL INDICATED IN THE PROBE USERS 
MANUAL. DO NOT TOUCH THE PROBE, CONDUCTIVE 
LIQUID OR ANY PART OF THE UNIT UNDER TEST WHILE 
DOING THE TEST.



Care and Maintenance

10-30 Versana BalanceTM/Versana BalanceTM Vet – Basic Service Manual
5866796-100 English Rev.12

No Meter Procedure Using Probe Adapter

Follow the Safety Analyzer tool instruction to test each 
transducer for leakage current.

The electrical Safety Analyzer tool should be calibrated and 
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

Data Sheet for Transducer Source Leakage Current

The test passes when all readings measure less than the values 
shown in Table 10-14 on page 10-22. Record all data on the PM 
Inspection Certificate.

CAUTION Equipment damage possibility. Never switch the Polarity and 
the status of Neutral when the Ultrasound system is powered 
ON. Be sure to turn the Ultrasound system power OFF before 
switching them using the POLARITY switch and/or the 
NEUTRAL switch. Otherwise, the Ultrasound system may be 
damaged.

Table 10-18:  Typical Data Sheet For Transducer Source Leakage Current

Transducer Tested:

 Unit Power
Tester Power Polarity 

Switch
Tester GROUND or 
NUETRAL Switch Measurement

ON NORM OPEN

ON NORM CLOSED

ON REV OPEN

ON REV CLOSED

OFF NORM OPEN

OFF NORM CLOSED

OFF REV OPEN

OFF REV CLOSED
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When there's too much leakage

current …

AC/DC Fails

Where applicable, check the AC/DC adapter and its cable. 
Replace a new one if any portion is defective.

Chassis Fails

Check the ground on the power cord and plug for continuity. 
Ensure the ground is not broken, frayed, or intermittent. Replace 
any defective part.

Where applicable, tighten all grounds. Ensure star washers are 
under all ground studs.

Inspect wiring for bad crimps, poor connections, or damage.

Test the wall outlet; verify it is grounded and is free of other 
wiring abnormalities. Notify the user or owner to correct any 
deviations. As a work around, check the other outlets to see if 
they could be used instead.

NOTE: No outlet tester can detect the condition where the white neutral 
wire and the green grounding wire are reversed. If later tests 
indicate high leakage currents, this should be suspected as a 
possible cause and the outlet wiring should be visually 
inspected.
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Probe Fails

Test the probe in another connector to isolate if the fault lies with 
the probe or the Ultrasound system. Or Change another probe 
to confirm if the fail is caused by console.

NOTE: Each probe will have some amount of leakage, dependent on its 
design. Small variations in probe leakage currents are normal 
from probe to probe. Other variations will result from differences 
in line voltage and test lead placement. The maximum allowable 
leakage current for body surface contact probe differs from 
inter-cavity probe. Be sure to enter the correct probe type in the 
appropriate space on the check list.

If excessive leakage current is slot dependent, inspect the 
system connector for bent pins, poor connections, and ground 
continuity.

If the problem remains with the probe, replace the probe.

Peripheral Fails

Tighten all grounds. Ensure star washers are under all ground 
studs.

Inspect wiring for bad crimps, poor connections, or damage.

Still Fails

If all else fails, begin isolation by removing the probes, external 
peripherals, then the on board ones, one at a time while 
monitoring the leakage current measurement.

New Unit

If the leakage current measurement tests fail on a new 
Ultrasound system and if situation can not be corrected, submit 
a Safety Failure Report to document the Ultrasound system 
problem. Remove Ultrasound system from operation.
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Inspection Paperwork

Ultrasound Inspection Forms

 Figure 10-5. Ultrasound Inspection Certificate

* Scan Format: Phased Array, Linear Array, Curved Array, 
Mechanical Array or Other

ULTRASOUND INSPECTION CERTIFICATE  

* Scan Format: Phased Array, Linear Array,  Curved Array, Mechanical Array or Other

rebmuN hctapsiD:DI metsyS:emaN remotsuC  / Date Performed: Warranty/C ontract/HBS

System Type :etaD erutcafunaM:rebmuN laireS:rebmuN ledoM

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:1 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:2 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:3 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:4 eborP

:rebmuN laireS:rebmuN ledoM:*tamroF nacS:ycneuqerF:5 eborP
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Ultrasound Inspection Forms(continued)

 Figure 10-6. Functional Checks

 Figure 10-7. Electrical Safety

FUNCTIONAL CHECKS  SPECTION AND CLEANING 

COMMENTS: 
_________________________ ____________________________ _________________________
_________________________ ____________________________ _________________________
_________________________ ____________________________ _________________________
_________________________ ____________________________ _________________________

Functional Check (if applicable)
OK? or 

N/A
Physical Inspection and Cleaning 

(if applicable) Inspect Clean

elosnoCnoitcnuF edoM-B

DCLnoitcnuF sedoM relppoD

O/I lanretxEnoitcnuF edoM-FC

srotcennoC dna selbaCnoitcnuF edoM-M

Applicable Software Opti larehpireP devorppA EGsno s (DVD-RW, Printer)

ilebaLsnoitpO erawdraH elbacilppA ng (see User Manual for Labeling)

Control Panel

LCD

Measurement Accuracy

GE Approved Peripherals

PHYSICAL IN

ELECTRICAL SAFETY

Final Check. All system covers are in place. System scans with all probes as expected.

Accepted by: ______________________________________________________________________

Electrical Test Performed
Max Value 

Allowed
Value 

Measured OK? Comments

Outlet (correct ground &wiring config.)

Type BF Applied Part Leakage Current 
Limits- Probe

enclosure Source Leakage Current - 
Chassis Leakage Current Limits

Peripheral 1 Leakage Current

Peripheral 2 Leakage Current

PROBES

Probe Number 
(from previous page)

Max Value 
Allowed

Max Value 
Measured OK? Comments

Probe 1:

Probe 2:

Probe 3:
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Electrical Safety Tests Log

Table 10-19:  Electrical safety tests log 

Electrical test performed Max 
value 
allowed

Value 
measured

OK? Comments

Outlet (correct ground and wiring 
config.)

System ground continuity

Chassis source leakage current - 
probe

Chassis source leakage current - 
wheel

Chassis source leakage current - 
monitor

Patient lead source leakage (lead 
to ground)

Patient lead source leakage (lead 
to lead)

Patient lead source leakage 
(isolation)

Peripheral 1 leakage current

Peripheral 1 ground continuity

Peripheral 2 leakage current

Peripheral 2 ground continuity

Peripheral 3 leakage current

Peripheral 3 ground continuity
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Table 10-20:  Electrical safety tests (probes) log 

Probe
Max value allowed Max value 

measured
OK? Comments
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removing, 4-32
authorized representative in EU, 1-29
average setup time, 3-3

B
before installation (site preparations), 2-1
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operator controls, 4-35
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compatibility
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completing the setup, 3-19
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configuration, 3-26
connect
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probe, 3-25
USB flash card, 3-25

connections
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Connectivity
Buttons, 3-97

console environmental requirements, 2-3
console requirements, 2-3
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contents in this manual, 1-3
conventions used in book, 1-7
cooling, 2-5
copyrights, i-18
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verification, 3-18
customer provided prerequisite, 8-10

D
damage

in transportation, 3-11
damage in transport, i-16
dangerous procedure warnings, 1-22
data network setup requirements, 2-18
desirable features, 2-14
DICOM network function, 2-18
DICOM setup requirements, 2-19
display PDF files

from manual CD-ROM
print PDF files

from manual CD-ROM, 4-28

E
electrical requirements, 2-6

EMI limitations
EMI limitations, 2-8

general requirements, 2-6
site circuit breaker

site circuit breaker, 2-7
site power outlets

site power outlets, 2-7
specific requirements for the unit, 2-6
unit power plug

unit power plug, 2-7
electrical safety, 1-20
electrical safety tests, 10-20
electrical specification, 3-21
electromagnetic interference

abatement, 2-9
prevention, 2-9

electrostatic discharge prevention, 1-26
EMC, 1-25

compliance, 1-25
what is EMC?, 1-25
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EMI, 1-25
abatement, 2-9
prevention, 2-9
protection, 3-18

environmental dangers, 2-20
environmental specifications for the unit, 2-4
errors, i-17
ESD, 1-25
ESD prevention, 1-26
ethernet

connect, 3-25
examine packages, 3-8
external I/O

connections, 3-25

F
facility needs, 2-11

desirable features, 2-14
DICOM network function, 2-18
DICOM setup requirements, 2-19
InSite requirements, 2-18
network setup requirements, 2-18
purchaser responsibilities, 2-12
recommended floor plan suggestion, 2-16
required facility needs, 2-13
suggested floor plan

scanner and EchoPAC in same room, 2-17
flash card

connect, 3-25
floor plan suggestion

recommended, 2-16
scanner and EchoPAC in same room, 2-17

functional checks, 10-12
mains cable inspection, 10-13
system checks, 10-12

G
GE Healthcare leakage current limits, 10-22
general console requirements, 2-3
generic procedure on probe leakage current, 10-29
grounding continuity, 10-25

H
hardware/software compatibility, 9-4
hardware-software

compatibility, 5-3
hot or cold

if the unit is very cold or hot, 2-3
how often should maintenance tasks be performed?, 
10-5
human safety, 1-14

I
icons, 1-7
icons indicating a special procedure to be used, 1-10

if the unit is very cold or hot, 2-3
important precautions, i-3
InSite

network requirements, 2-18
installation

see "system setup", 3-1
installation warnings

see "setup warnings", 3-3
introduction (chapter 1), 1-1

L
labels

transportation box label, 3-11
legal notes, i-18
lighting, 2-5
list of abbrevations, 9-3
loading software, 8-10
lockout/tagout (LOTO) requirements, 1-23
LOTO

lockout/tagout requirements, 1-23

M
mains cable inspection, 10-13
maintenance

physical inspection, 10-15
preliminary checks, 10-11
system maintenance, 10-11

maintenance task schedule, 10-5
manufacturer, 1-28
mass

with monitor and peripherals, 3-20
mechanical safety, 1-17
model designations, 1-7
models covered by this manual, 1-5

N
network setup requirements, 2-18

O
omission and errors, i-17
operational and storage temperature for probes, 2-10
Operator controls, 4-35

P
packing materials

recycling information, 3-17
paperwork

after setup, 3-112
PDF files

display and print, 4-28
periodic maintenance inspection (PM), PM (periodic 
maintenance inspection), 10-4
phone numbers

customer assistance, 1-28
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Power On, 3-25
precautions

certified electrical contractor statement, i-16
damage in transport, i-16
important precautions, i-3
service safety considerations, i-17
translation policy, i-3

prepeare for setup, 3-18
prerequisite

provided by customer, 8-10
print keys

assigning to a device or dataflow, 3-97
probe

connect, 3-25
probe cleaning, 10-18
probe leakage current test, 10-28
probe maintenance, 10-17

basic probe care, 10-17
basic probe cleaning, 10-18
probe related checks, 10-17

probe related checks, 10-17
probes environmental requirements, 2-10

operational and storage temperature for probes, 
2-10

product icons, 1-11
product locator installation card, 3-113
products covered by this manual, 1-5
proprietary to GE Healthcare, i-18
Purchaser responsibilities, 2-12

R
rear panel

connections, 3-25
receiving and unpacking, 3-6
receiving the product, 3-8
recycling information

packing materials, 3-17
removable media

verifying, 3-100
required facility needs, 2-13
requirements, 2-3
requirements verification, 3-20
returning/shipping probes and repair parts, 1-24
revision history, i-1

S
safety

human, 1-14
safety precaution messages, 1-8
safety test overview, 10-20
service safety considerations, i-17

setup
completion, 3-19
preparations, 3-18
reminders, 3-3

setup time, 3-3
setup warnings, 3-3
shipping/returning probes and repair parts, 1-24
shock and tilt indicators

position, 3-9
shock indicator, 3-7
site preparations, 2-1

time and manpower requirements, 2-10
software loading, 8-10
software/hardware compatibility, 9-4
software-hardware

compatibility, 5-3
specifications, 3-20

electrical specifications, 3-21
physical dimensions, 3-20

standard GE tool kit, 10-7
standard hazard icons, 1-9
statement

certified electrical contractor statement, i-16
system

specifications, 3-20
system checks, 10-12
system maintenance, 10-11

physical inspection, 10-15
preliminary checks, 10-11

system manufacturer, 1-28
system requirements verification, 3-20
system setup, 3-1

T
tilt and shock indicators

position, 3-9
tilt indicator, 3-7
time and manpower requirements

site preparations, 2-10
tools required, 10-7

special tools, supplies and equipment, 10-10
standard GE tool kit, 10-7

trademarks, i-18
translation policy, i-3
transport

damage, i-16
transportation

shock indicator, 3-7
tilt indicator, 3-7

transportation box label, 3-11
typical users of the service manual, 1-4

U
unpacking, 3-6
USB

flash card
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connect, 3-25

V
verification

system requirements, 3-20
verify customer order, 3-18
verifying

removable media, 3-100
voltage settings, 3-21

W
warnings, 10-3

dangerous procedures, 1-22
receiving and unpacking, 3-6

what is EMC?, 1-25
when there’s too much leakage current, 10-31

chassis fails, 10-31
new unit, 10-32
peripheral fails, 10-32
probe fails, 10-32
still fails, 10-32
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